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Introduction

1 Introduction

Aid4Mail is a fast and accurate email search and conversion application for use in digital

forensics, eDiscovery, mail migration and archiving. Its proprietary engine quickly processes

large volumes of email data while preserving crucial metadata and content.

Aid4Mail supports over 40 different email programs and mail formats (see the full list) in

addition to most popular webmail services. It can run on a virtual machine (VM) and can

access mail files from any local storage device including external drives, CD/DVD media,

USB devices, attached networks and remote accounts. In most cases it can process files and

folders that are disconnected (unmounted) from their email program.

Read more about Aid4Mail

· What’s new in Aid4Mail 5?

· Aid4Mail editions

· Trial mode

· System requirements

· Supported formats

Once you’re ready to use Aid4Mail

· Getting started with Aid4Mail

· Converting mail

· Choosing the right format

· Searching and filtering

· Optimizing performance

· Activating your Aid4Mail license

A description of every setting

· User interface

· Command-line interface (CLI)
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Detailed information on more complex topics

· Adding header metadata

· Processing archival formats

· Multiple sessions

· Duplicating sessions

· Bates numbering

· Templates

· Python scripts

· Customizing Aid4Mail

Looking for more help?

· Glossary

· Known issues

· Technical support

About the company

· Company information

Legal

· Trademarks and copyright

· End User License Agreement (EULA)

For more information about Aid4Mail and how it can facilitate your email-related tasks,

please visit www.aid4mail.com. 

https://www.aid4mail.com/redir/aid4mail-v5
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2 What's new in Aid4Mail 5?

Aid4Mail 5 has been reworked from the ground up with many improvements and new

features including:

· Completely new user interface
A simple and intuitive user interface makes it easy to set up your mail processing tasks.

· Faster than ever
Aid4Mail 5 is up to six times faster than the previous version without sacrificing accuracy!

And version 4 was already one of the fastest email converters on the market. Speed gains

obviously depend on your selected mail format and settings.

· Multiple sessions
Set up and run multiple sessions directly in the main interface. You no longer need to run

the Console version of Aid4Mail or the Console Launcher to do this. Multiple concurrent

sessions are available in Aid4Mail Enterprise and Investigator. In Aid4Mail Converter you

can set up multiple sessions but they can only run one at a time.

· More mail formats
Aid4Mail has always supported an impressive number of mail formats—over 40 in total

in addition to most web and IMAP services. Aid4Mail 5 maintains most of these except

for some outdated and obsolete formats. It also adds some important new formats like

OST and OLM, as well as HTML, XML, TSV and SeaMonkey. In Aid4Mail 5, all Outlook file

formats can be processed with or without Outlook installed. And Mimecast, Proofpoint

and Google Vault archives can now be processed directly and reorganized per account if

necessary.

· Convert between any combination of formats, including PST to PST
There are no restrictions on source and target format combinations, even between

Outlook formats. PST to PST is now possible. You can even share the same source or

target PST file between multiple concurrent sessions. The same applies to many other

formats too.

· Improved search and filter feature 

A simple-to-use but very powerful search and filter feature:

o Enter search terms into a simple search field like those used by most search engines,

o Simple syntax that will be familiar to Gmail and Outlook users,

o A search assistant to help you build your search terms,

o A multitude of search operators to focus your search*,

o Search inside attachments and files they contain*,
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o Construct complex search terms with Boolean operators,

o Use wildcards and regular expressions to refine your search terms,

o Proximity searching,

o Write your own filters with Python scripts*,

o Bundled with ready-made search terms and filter scripts*.

* Aid4Mail Converter is limited to searching and filtering folders. Aid4Mail Enterprise and

Investigator extend this capability to individual emails, attachments and files they

contain, and the use of Python filter scripts.

· Python scripting
Use the popular Python programming language to create powerful scripts to search and

customize the output created by Aid4Mail. Available in Aid4Mail Enterprise and

Investigator.

· Filename templates
Completely customize the email filenames created by Aid4Mail.

· Folder structure templates
Define exactly how you want your target mailboxes to be structured.

· Email header configuration
Specify the header fields to display in archival mail formats like PDF and HTML.

· Column and content configuration
Define which columns appear in CSV and TSV files and the content for XML files.

· Better statistics
Greatly improved feedback of Aid4Mail’s progress through your mail. Includes real-time

statistics of emails analyzed, completed and filtered, and any errors that occurred.

· Sophisticated incremental processing
It's now even easier to continue a prior conversion where you left off or to capture new

mail received since last time. Aid4Mail 5's incremental processing is up to 100x faster

than in version 4! It's also easier to use: Turn incremental processing on or off using a

simple checkbox. No need to deal with the log file directly, it’s all done for you,

intelligently and simply.

· Projects
Separate your work into projects that can contain any number of Aid4Mail sessions.

Switch between different projects or cases quickly and easily with no loss of work.
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We're constantly improving Aid4Mail with new features and functionality. With our

subscription licenses, you always have access to the latest version and regular updates.
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Aid4Mail editions

3 Aid4Mail editions

Commercial editions

There are three commercial editions of Aid4Mail:

· Aid4Mail Converter

· Aid4Mail Investigator

· Aid4Mail Enterprise

For a detailed feature comparison, please see the comparison chart on our website. You

can also download a copy of the End User License Agreement (EULA).

Aid4Mail Converter
Specialized in converting mail from one format to another, Aid4Mail Converter is

extremely fast and accurate, ensuring that converted mail is identical to the original. It's an

ideal solution for preparing mail for ingestion into archiving, eDiscovery and forensic tools

and can process unlimited mail stores (in-house or from external sources).

Aid4Mail Converter supports over 40 email programs and mail formats. These include

Outlook formats (with or without Outlook installed), non proprietary formats like EML and

mbox, many popular email applications like Thunderbird, and useful export formats like

PDF, HTML, CSV and XML. It offers secure IMAP access to cloud-based services (webmail)

and can access Gmail and Outlook 365 accounts through their native APIs, the most secure

and efficient method.

A remote authentication tool is included that can be downloaded by any third party under

investigation, or whose mail account you are processing on their behalf. It enables the

account owner to grant Aid4Mail secure, temporary access to a cloud-based email service

or IMAP account without providing their full login credentials and without having a copy of

Aid4Mail.

Other Aid4Mail Converter features include:

· Reliably download large IMAP accounts through effective error recovery protocol.

· Secure access to Gmail, Office 365, Outlook.com and IMAP through OAuth 2.

· Accurately restore the folder structure, including Google Takeout files.

· Export emails as searchable PDFs with linked attachments.

· Convert to HTML and display emails in a browser with the included viewer.

· Plain text, CSV, TSV and XML target formats.

· Extract email attachments.

· Flexible template-based folder and file naming with support for Bates numbering.

https://www.aid4mail.com/redir/feature-comparison-v5
https://www.aid4mail.com/redir/eula
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· Support for long file names exceeding 255 characters.

· Detailed progress information, conversion statistics and logs.

· Works seamlessly with both 32-bit and 64-bit Outlook.

· Modern user interface with full Unicode support.

Aid4Mail Investigator
The same powerful conversion engine as Aid4Mail Converter with the addition of advanced

features for forensic and eDiscovery professionals.

Aid4Mail Investigator's powerful search and filter features allow you to use the same search

operators as Gmail and Office 365. You can search any part of an email including deeply

embedded content, attachments and files contained within attachments. For example, text

in a PDF file that’s contained within a ZIP archive, attached to an email that is itself the

attachment of another email, can be found! You can even search for file metadata like EXIF

and IPTC information contained in pictures. 

Built-in filters allow you to cull redundant and irrelevant emails before review: You can skip

duplicates and target personal mail, excluding emails from mailing lists, bulk mail and

notifications. Forensic professionals also have the ability to search unurged mail.

Native filtering for Gmail, Office 365 and IMAP accounts is also supported. These filters are

sent directly to the mail server software to carry out a pre-acquisition search server-side.

This can significantly increase performance because Aid4Mail will only download and

process emails that match the search results rather than the whole account.

Aid4Mail Investigator's support for Python filter scripts gives you even more control. Extract

and search text from images using Python OCR modules or use Python image analysis to

detect nudity in photos. You can also use Python scripts to modify email content, for

example obfuscating sensitive information.

Concurrent processing enables you to run multiple Aid4Mail sessions simultaneously. These

can be totally independent conversions or share the same source, target or both. For

example, you can merge emails from multiple sources into a single PST file or split a single

source file into multiple target files. Alternatively, apply multiple search criteria to a single

mail store, saving the results in different folders within the same PST, all at the same time.

Other features:

· Reorganize emails by account.

· Configurable Bates number and Bates stamp.

· Add missing metadata to target emails.

· Access public and shared folders and delegate accounts.

· Use word proximity operators, wildcards, and regular expressions in your searches.
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· Customize target folder and file names using Python scripts.

Aid4Mail Enterprise
The ultimate Aid4Mail. It contains every feature in Aid4Mail Investigator and Converter plus

a command-line interface (CLI) and additional mail formats for large-scale archival and

migration projects.

Archival source formats:

· Google Vault (zipped MBOX files)

· Mimecast (zipped EML SJF files)

· Proofpoint (zipped EML files)

Cloud-based target formats:

· Office 365 and MS Exchange (via MAPI)

· Gmail (via Google APIs or IMAP)

· Dovecot, Courier, Zimbra, … (via IMAP)

The command-line interface (CLI) enables you to seamlessly integrate Aid4Mail Enterprise

into your work flow. Run it from scripts or batch files to automate email processing, or

create your own user interface to customize the features available to end users.

With flexible, multi-user licensing options, Aid4Mail Enterprise is well suited to large-scale

email processing in medium to large organizations. The license is tied to a computer,

server, or USB drive rather than a seat, making it available to any number of users in your

company. You can run it from a server or networked computer or from a shareable USB

flash drive or SSD. This makes it an ideal portable solution in the field or the lab.

Trial mode

A full-featured trial mode is available in each Aid4Mail edition. When Aid4Mail is used in

trial mode, it works on a modified copy of your mail. Rest assured that Aid4Mail will not

alter your actual mail so you can safely run as many tests as you need. Please refer to the

Trial mode topic for details.

Free edition

A free edition, Aid4Mail Converter Light, is available on our website. It has the same feature

set as Aid4Mail Converter but is limited to processing EML and mbox mail formats only.

https://www.aid4mail.com/redir/download
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4 Trial mode

A full-featured trial mode is available for each Aid4Mail edition. 

In trial mode, Aid4Mail will create a modified copy of your mail. Rest assured that

Aid4Mail will not alter your actual mail so you can safely run as many tests as you need. 

In trial mode, Aid4Mail makes three modifications to emails during conversion:

1. Subject lines are truncated to 20 characters and the following text is added: [Created

with trial version of Aid4Mail] 

2. The From email address is replaced with: trial-mode@aid4mail.com

3. Attachments, and sometimes embedded contents, are removed from emails that exceed

1 MB (Aid4Mail Enterprise and Investigator) or 10 MB (Aid4Mail Converter).

Note that search filters used in trial mode will be applied to the modified copies of your

emails, not to the originals. In some cases this may produce unexpected results. For

example, searching for From:jane@aid4mail.com will not find any emails in trial mode

because the From addresses have all been changed to trial-mode@aid4mail.com.

Data produced by Aid4Mail during trial mode is for evaluation purposes only and

must be deleted once you finish testing the software. 

When you purchase a license and activate Aid4Mail, you will be able to process your mail

without the modifications and limitations of trial mode.
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5 System requirements

Minimum Hardware Requirements

· Pentium (or compatible) processor

· 2 GB of RAM

· 50 MB of disk space to install Aid4Mail plus additional space for your target mail.

An Internet connection is required for online license activation, validation and re-activation.

Offline activation is available for certain licenses.

Operating Systems

Fully supported:

· Windows 10

· Windows 8.1

· Windows 8

· Windows Server 2019

· Windows Server 2016

· Windows Server 2012

Supported if .NET 4.5 has been installed:

· Windows 7 (with Service Pack 1)

· Windows Vista (with Service Pack 2)

· Windows Server 2008 (with Service Pack 2, or R2 with Service Pack 1)

Partially supported when used with Wine:

· macOS / OS X / Mac OS X (10.6 or later)

· Linux

Note:

· Both 64 and 32-bit versions (where available) of the above operating systems are

supported.

· Apple computers running macOS 10.15 Catalina, or a later version, are not able to run 32-

bit applications. If you are using one of these, you should select the Prioritize memory

access (64-bit engine) option under Optimization in Aid4Mail's Advanced options.

· Outlook/Exchange source and target formats are not available when running Aid4Mail on

non-Windows operating systems.
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Python scripts

To use Python scripts in Aid4Mail, you will need Python 3 or a later version installed on the

same computer. Please refer to the Python installation section of the Python scripts topic

for details.
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6 Supported formats

Mail formats

Source mail formats
Only in Aid4Mail Enterprise:

· Google Vault (zipped mbox files)

· Mimecast (zipped EML SJF files)

· Proofpoint (password-protected zipped EML files)

In all commercial editions:

· Gmail (via Google API)

· Outlook 365 (via Graph API)

· Outlook profile

· Outlook PST file (via MAPI or independently of Outlook)

· Outlook OST file

· Outlook OLM file

· Outlook MSG files (via MAPI or independently of Outlook)

· IMAP (including Gmail, Outlook.com, Yahoo! Mail, AOL, …)

· EML files

· Mbox files

· Thunderbird

· SeaMonkey

· Maildir

· Google Takeout

· Apple Mail EMLX files

· More to come...

Target mail formats
Only in Aid4Mail Enterprise:

· Gmail (via Google API)

· IMAP (including Gmail, Outlook.com, Yahoo! Mail, AOL, …)

· Outlook profile

In all commercial editions:

· Outlook PST file  (via MAPI or independently of Outlook)

· Outlook MSG files  (via MAPI or independently of Outlook)

· EML files
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· Mbox files (generic mailbox)

· Thunderbird

· SeaMonkey

· PDF

· HTML

· Plain text

· CSV

· TSV

· XML

· More to come...

Attachment/file types that can be searched (only in Aid4Mail Enterprise and

Investigator)

Microsoft Office
· docx

· xlsx

· pptx

· docm

· xlsm

· pptm

OpenDocument (OpenOffice, LibreOffice)
· odt

· ods

· odp

· ott

· ots

· otp

Other document formats
· rtf

· pdf

MIME (email)
· eml

· mht

· mhtml

XML
· xml

· xsd

· xsl

· xslt

· manifest

· abw

· fodt

· fods

· fodp
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Web
· asp

· cfm

· dhtml

· hta

· htm

· html

· htt

· php

· php3

· php4

· php5

· php6

· php7

· phtml

· shtml

· xhtml

IFilter plugins
· doc

· xls

· ppt

· dot

· pot

· pps

· xlt

Plain text
· asm

· bat

· c

· cc

· cfg

· clb

· cmd

· cod

· cpp

· cs

· csproj

· css

· csv

· curl

· cxx

· def

· diff

· dpr

· dsp

· dsw

· h

· hpp

· hxx

· htaccess

· i

· ics

· idl

· inc

· inf

· ini

· inl

· java

· js

· json

· latex

· log

· lst

· lua

· mak

· mk

· odl

· otl

· pas

· pl

· ps

· py

· rc

· rc2

· rct

· reg

· res

· rexx

· rgs

· s

· sol

· sql

· sqlite

· tab

· tcsh

· tex

· text

· tlh

· tli

· tsv

· txt

· url

· user

· utf8

· utxt

· vb

· vbproj

· vbs

· vcf

· vcs

· zsh

Compressed archives
· 7z

· bz2

· bzip2

· cab

· dar

· gz

· gzip

· lzma

· rar

· tar

· tbz2

· tgz

· tlz

· Z

· zip
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7 Getting started with Aid4Mail

When you first open Aid4Mail, you are presented with the Start screen.

Start screen

On the start screen there are three boxes with the following titles:

· License activation

· Trial license

· Free edition

Each box contains one or more options as shown in the following screenshot and explained

below:

Start screen
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License activation
If you have already purchased an Aid4Mail license, and received an activation code or key

file by email, select Activate. Then follow the instructions in the Activating your Aid4Mail

license topic.

Trial license
If you’d like to test Aid4Mail before purchasing, select the Aid4Mail edition you’d like to

try:

· Enterprise

· Investigator

· Converter

For more information about the different editions of Aid4Mail, please see the comparison

chart on our website.

In trial mode, Aid4Mail works on a modified copy of your mail. Rest assured that Aid4Mail

will not alter your actual mail so you can safely run as many tests as you need. Please refer

to the Trial mode topic for details.

Free edition
Select Converter Light to use our free edition. Converter Light is 100% free to use but is

limited to converting between EML and mbox mail formats.

What’s next?

Once you have activated your Aid4Mail license or chosen a trial or free edition, the main

user interface will open with the Settings displayed. It looks like this:

https://www.aid4mail.com/redir/feature-comparison-v5
https://www.aid4mail.com/redir/feature-comparison-v5
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Main screen (Aid4Mail Enterprise)

Next, learn how to convert mail.
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8 Converting mail

Converting mail with Aid4Mail is very simple. Here are the steps:

1. Select the Settings tab to display the Settings screen:

Select the Settings tab

2. Change the Session name to something more descriptive:

Change the session name to something more descriptive

3. Ensure that the Source and Target sections are open as shown below. When you first run

Aid4Mail, the Source and Target sections are open by default and the Filter section is

closed.
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Settings screen with the Source and Target sections expanded.

To open a section, select its heading text or the “+” symbol to the left of it. Once open,

the “+” symbol changes to a “-” symbol. Selecting it again closes the section.
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Click on the “+” symbol to open a section. Click on the “-” section to close a section.

4. In the Source section, select a source mail Format from the list. This is the email format

you are converting from. Once selected, additional options related to your chosen

format will be displayed. For example, if you select EML as your source format then the

Location field will appear. If you select Gmail as your source format then the Email

address field will be displayed instead. If you select Outlook profile then the Profile and

Store fields will appear, and so on.
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Select EML as your source format and the Location field becomes available.

Select Gmail as your source format and the Email address field becomes available.
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Select Outlook profile as your source format and the Profile and Store fields become

available.

5. Still in the Source section, complete either Location, Email address, IMAP account, PST

file, or both Profile and Store, depending on your chosen source format. These are the

only mandatory source settings and must be filled in before Aid4Mail can process your

mail. 

6. Fill in any remaining source settings settings you require. They are optional, with default

values, so you can safely ignore them if you are unsure of what to choose.

7. In the Target section, select a target mail Format from the list. This is the email format

you are converting to. Once selected, additional options related to your chosen format

will become available.

8. In the Target section, complete either Location, Email address, IMAP account, PST file, or

both Profile and Store, depending on your chosen target format. These are the only

mandatory target settings and must be filled in before Aid4Mail can process your mail.
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Notice that the Run button will now become available in the button bar on the left.

Once the mandatory source and target fields are complete, the Run button becomes

available.

9. Fill in any remaining target settings settings you require. They are optional, with default

values, so you can safely ignore them if you are unsure of what to choose.

10.If you require Aid4Mail to filter your mail during the conversion process, open (if

necessary) and complete the optional Filter section.

11.Once you have finished adjusting the settings, select Run and Aid4Mail will start

processing your mail:
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Select Run
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The Progress screen will automatically open and display statistics:

Progress screen
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9 Choosing the right format

For most mail formats, it's clear which source and target formats to choose in Aid4Mail

because there's only one relevant option available for each. For example, if you're

migrating from Thunderbird to PDF, selecting Thunderbird as your source format and PDF

as the target format is the only way to do it.

However, some mail formats can be accessed in multiple ways and it isn't always clear

which one to choose. This section is intended to clarify the options available, listing their

advantages and disadvantages, and help you choose the best option.

The following mail formats are covered:

· Gmail

· Outlook 365

· PST and MSG
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9.1 Choosing the right format: Gmail

Gmail accounts can be processed by Aid4Mail in four different ways, using the following

source or target format options:

· Gmail (via Google API)

· IMAP

· Google Vault

· Google Takeout

To help you choose the most appropriate option for your requirements, the advantages

and disadvantages of each are discussed below.

Gmail (via Google API)

Available as a source format in all Aid4Mail editions and as a target format in Aid4Mail

Enterprise. 

When you use Gmail (via Google API) as your source or target format, Aid4Mail will connect

directly to your Gmail account using Google APIs. The connection is made through OAuth

2.0 and is secure. If this is your source format, Aid4Mail will download emails that match

your search criteria or native filter and migrate them. If it's your target format, Aid4Mail will

upload emails to your Gmail account. 

This is the recommended option if you want Aid4Mail to collect Gmail from the server or if

Gmail is your target format.

The following table presents the advantages and disadvantages of using the Gmail (via

Google API) option:
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Advantages Disadvantages

· Secure connection using OAuth 2.0.

· Native filtering can be used to

significantly reduce the amount of mail

downloaded and processed by

Aid4Mail.

· Emails with multiple labels will only be

downloaded once each, speeding up

the collection process.

· Slow processing due to the remote

connection. This is dependent on your

internet connection and available

bandwidth but can be mitigated by

clever use of native filtering.

· Subject to Google's bandwidth

limitations. These are less limited than

with IMAP access.

· Requires Google API credentials to be

set up.

IMAP

Available as a source format in all Aid4Mail editions and as a target format in Aid4Mail

Enterprise.

When you use IMAP as your source or target format, Aid4Mail will connect directly to your

Gmail account using the IMAP protocol. The connection can be made either through secure

OAuth 2.0 or, simply but less securely, using your Gmail credentials and app-specific

password. If this is your source format, Aid4Mail will download emails that match your

search criteria and migrate them. If it's your target format, Aid4Mail will upload emails to

your Gmail account.

There's really only one scenario where the IMAP option would be preferable to Gmail (via

Google API): That is when you don't want to set up Google API credentials and you don't

mind a less secure connection to the server.

The following table presents the advantages and disadvantages of using the IMAP option:

https://www.aid4mail.com/redir/gmail-limits
https://www.aid4mail.com/redir/gmail-limits
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Advantages Disadvantages

· Secure connection using OAuth 2.0 is

available.

· Does not require Google API

credentials to be set up but only if a

less secure connection is used.

· Native filtering cannot be used to

reduce the amount of mail collected.

· Gmail labels will automatically be

converted to folders by the IMAP

protocol. This means that emails with

multiple labels will be duplicated,

increasing the volume of mail to be

collected.

· Multiple settings must be configured in

Gmail to allow IMAP access.

· Slow processing due to the remote

connection. This is dependent on your

internet connection and available

bandwidth.

· Subject to Google's bandwidth

limitations. These are more limited

than with Google API access.

· Requires Google API credentials to be

set up if a secure OAuth 2.0 connection

is used. 

· Connection is less secure if OAuth 2.0 is

not used.

Google Vault

Available as a source format in Aid4Mail Enterprise.

The Google Vault option requires a two-step process: First, in Google Vault, create an

archive and download it to your computer. Then process the archive with Aid4Mail. 

If you need to process multiple accounts or large volumes of mail, this is the recommended

option. 

https://www.aid4mail.com/redir/gmail-imap-kb
https://www.aid4mail.com/redir/gmail-imap-kb
https://www.aid4mail.com/redir/gmail-limits
https://www.aid4mail.com/redir/gmail-limits
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For a detailed walk-through of processing Google Vault files with Aid4Mail, see the video

demo on our website. Don't forget to include the .xml, .csv and .md5 files along with the

.zip file(s) as shown in the video.

The following table presents the advantages and disadvantages of using the Google Vault

option:

Advantages Disadvantages

· Processing with Aid4Mail is fast

because the mail is stored locally.

Downloading of the Google Vault

archive is obviously still dependent on

your internet connection.

· Not subject to Google's bandwidth

limitations.

· You can use Gmail's filters to only

include relevant emails in the Google

Vault archive. This will speed up the

downloading of the archive and

Aid4Mail's processing of it.

· Emails with multiple labels will not be

duplicated in the archive. This reduces

the need for deduplication in Aid4Mail,

increasing processing speed.

· Two-step process: You have to create

the Google Vault archive before

Aid4Mail can process it.

· Email metadata is stored in a separate

.xml file that must be placed in the

same folder as the .zip file(s) as shown

in the video demo.

· Google Vault is only available with a

Google Workspace subscription.

Google Takeout

Available as a source format in all Aid4Mail editions.

The Google Takeout option requires a two-step process: First, in Gmail, create a Google

Takeout archive and download it to your computer. Then process the archive with

Aid4Mail. 

If you have large volumes of mail to process, and don't have Aid4Mail Enterprise or access

to Google Vault, this is the recommended option.

https://www.aid4mail.com/redir/google-vault-kb
https://www.aid4mail.com/redir/google-vault-kb
https://www.aid4mail.com/redir/google-vault-kb
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The following table presents the advantages and disadvantages of using the Google

Takeout option:

Advantages Disadvantages

· Processing with Aid4Mail is fast

because the mail is stored locally.

Downloading of the Google Takeout

archive is obviously still dependent on

your internet connection.

· Not subject to Google's bandwidth

limitations.

· Emails with multiple labels will not be

duplicated in the archive. This reduces

the need for deduplication in Aid4Mail,

increasing processing speed.

· Unlike Google Vault, email metadata is

stored directly in the mailboxes so

there's no additional files to download.

· Google Takeout is available to all

Gmail users.

· Two-step process: You have to create

the Google Takeout archive before

Aid4Mail can process it.

· Unlike Google Vault, you cannot use

Gmail's filters to selectively include

mail. You can select which labels are

included. Nevertheless, the ability to

reduce the size of the collection is

more limited. This usually results in a

larger download and slower processing

with Aid4Mail.
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9.2 Choosing the right format: Outlook 365

Outlook 365 can be processed by Aid4Mail in three different ways, using the following

source or target format options:

· Outlook 365 (via Graph API)

· IMAP

· Outlook profile

To help you choose the most appropriate option for your requirements, the advantages

and disadvantages of each are discussed below.

Outlook 365

Available as a source format in all Aid4Mail editions.

When you use Outlook 365 (via Graph API) as your source, Aid4Mail will connect directly to

your Office 365 account using Microsoft's Graph API. The connection is made through

OAuth 2.0 and is secure. Aid4Mail will download emails that match your search criteria or

native filter and migrate them.

This is the recommended option if you want Aid4Mail to collect Outlook mail from the

server and don't have Outlook installed.

The following table presents the advantages and disadvantages of using the Outlook 365

(via Graph API) option:

Advantages Disadvantages

· Secure connection using OAuth 2.0.

· Native filtering can be used to

significantly reduce the amount of mail

downloaded and processed by

Aid4Mail.

· Does not require Outlook to be

installed.

· Not available as a target format. This is

a limitation of the Graph API.

· Slow processing due to the remote

connection. This is dependent on your

internet connection and available

bandwidth but can be mitigated by

clever use of native filtering.

· Subject to Office 365 user throttling.

https://www.aid4mail.com/redir/outlook-throttling
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IMAP

Available as a source format in all Aid4Mail editions and as a target format in Aid4Mail

Enterprise.

When you use IMAP as your source or target format, Aid4Mail will connect directly to your

Office 365 account using the IMAP protocol. The connection can be made either through

secure OAuth 2.0 or, simply but less securely, using your Outlook username and password. If

this is your source format, Aid4Mail will download emails that match your search criteria

and migrate them. If it's your target format, Aid4Mail will upload emails to your Office 365

account.

This is the recommended option if you want to migrate mail to Outlook 365 but don't have

Outlook installed. We also recommend you use the more secure OAuth 2.0 method of

authentication.

The following table presents the advantages and disadvantages of using the IMAP option:

Advantages Disadvantages

· Available as source and target formats

in Aid4Mail Enterprise.

· Secure connection using OAuth 2.0 is

available.

· Does not require Outlook to be

installed.

· Native filtering cannot be used to

reduce the amount of mail collected.

· Slow processing due to the remote

connection. This is dependent on your

internet connection and available

bandwidth.

· Subject to Office 365 user throttling.

· Connection is less secure if OAuth 2.0 is

not used.

Outlook profile

Available as a source format in all Aid4Mail editions and as a target format in Aid4Mail

Enterprise.

https://www.aid4mail.com/redir/outlook-throttling
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When you use Outlook profile as your source or target format, Aid4Mail will connect directly

to your Office 365 account and/or cached Outlook files using Outlook's underlying

technology, MAPI. This means that Outlook will do the work of accessing or creating emails

and other items (calendars, tasks, notes, etc.) as instructed by Aid4Mail. MAPI's methods are

further optimized by our own in-house technology, developed over 20+ years of email

processing!

This is the recommended option for accessing Outlook 365 mail, as source or target, if you

have Outlook installed.

The following table presents the advantages and disadvantages of using the Outlook profile

option:
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Advantages Disadvantages

· Available as source and target formats

in Aid4Mail Enterprise.

· Uses Outlook's own engine (MAPI) for

processing, ensuring the highest quality

results.

· Further optimized by our in-house

technology, developed over 20+ years.

· Non-email items (calendars, tasks,

notes, etc.) can be processed (but only

if both source and target are formats

that use MAPI).

· Additional metadata can be included.

· Not subject to Office 365 user

throttling.

· Processes cached emails when it's

determined that they're up to date,

avoiding server access.

· Does not require authentication of your

email account credentials.

· Native filtering cannot be used to

reduce the amount of mail collected.

· When cached emails are not up to

date, server access is necessary. This

results in slow processing due to the

remote connection. It's dependent on

your internet connection and available

bandwidth.

· Requires Outlook to be installed on the

same machine as Aid4Mail.
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9.3 Choosing the right format: PST and MSG

PST and MSG files can be processed by Aid4Mail in two different ways. In both cases, PST

file or MSG files is selected as the source or target format. The difference depends on

whether the Process using Outlook option is turned on or off.

To help you choose the most appropriate configuration for your requirements, the

advantages and disadvantages of each are discussed below.

Process using Outlook: On

Available when PST file or MSG files is selected as a source or target format in all Aid4Mail

editions.

When Process using Outlook is turned on, Aid4Mail will access PST or MSG files using

Outlook's underlying technology, MAPI. This means that Outlook will do the work of

accessing or creating emails and other items (calendars, tasks, notes, etc.) as instructed by

Aid4Mail. MAPI's methods are further optimized by our own in-house technology,

developed over 20+ years of email processing!

This is the recommended method of processing PST and MSG files when Outlook is

installed.

The following table presents the advantages and disadvantages of turning Process using

Outlook on:
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Advantages Disadvantages

· Processing is very fast.

· All metadata is processed.

· Uses Outlook's own engine (MAPI) for

processing, ensuring the highest quality

results.

· Further optimized by our own in-house

technology, developed over 20+ years.

· More hidden data is available when

Include hidden folders is turned on in

Aid4Mail Enterprise and Investigator.

· Requires Outlook to be installed on the

same machine as Aid4Mail.

· Outlook modifies source PST files every

time it accesses them. However, we

have developed a work-around

whereby Aid4Mail creates a temporary

copy of the file, leaving the original

unaltered. Please refer to the Protect

from changes by Outlook option for

further details.

Process using Outlook: Off

Available when PST file or MSG files is selected as a source or target format in all Aid4Mail

editions.

When Process using Outlook is turned off, Aid4Mail will access PST and MSG files using a

stand-alone engine.

This is the recommended method of processing PST and MSG files when Outlook is not

installed.

The following table presents the advantages and disadvantages of turning Process using

Outlook off:
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Advantages Disadvantages

· Does not require Outlook to be

installed.

· PST files are not altered when accessed.

· Processing is significantly slower.

· Some metadata, notably status

information (Read, Replied, Forwarded,

etc.), will not be included.

· Less hidden data is available when

Include hidden folders is turned on in

Aid4Mail Enterprise and Investigator.



45

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

10 Searching and filtering

Aid4Mail’s powerful search and filter features allow you to include or exclude emails, non-

email items or whole folders from your target mailbox based on specific search criteria.

Note that, in trial mode, Aid4Mail works on modified copies of your mail which may, in

turn, impact your filter results. For more details see the Trial mode topic.

Filter types

All Aid4Mail editions can search and filter folders. Aid4Mail Enterprise and Investigator

extend search and filter capabilities to individual emails (and non-email items), their

attachments and even files contained within attachments. They can also perform native

searches and enable you to write your own filters with Python filter scripts.

Filter order

Aid4Mail applies filters in they order they appear in the Filter section of the Settings screen:

First the folder or native filter, next the item filter and finally any Python filter script that is

set. For details, please refer to the Filter order topic.

Search terms

Aid4Mail filters consist of one or more search terms (except Python filter scripts which use

a different syntax). During processing, items that match your search terms will be included

in your target mail. Those that don’t will be excluded. 

Search terms must adhere to specific rules and can include:

· Wildcards

· Punctuation

· Regular expressions

· Search operators

· Boolean operators

For more information, please refer to the Search terms topic.
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Tutorial: Search and filter basics

Learn the basics of searching and filtering in Aid4Mail by working through a simple,

practical example in the Tutorial: Search and filter basics topic.

Proximity searching

A proximity search finds words or characters that are located close to one another.

Proximity searches can be very powerful, using context to enable precise filtering. For

details, see the Proximity searching topic.

Deduplication

Deduplication is the process of eliminating identical copies of emails (or non-email items),

ensuring there is only one of each in your target mail. Aid4Mail makes deduplication very

easy through a simple search term, NOT Type:Duplicate. Please refer to the Deduplication

topic for more information.

Searching unpurged mail

Unpurged mail refers to hidden copies of emails that have been deleted or moved to

another location. Aid4Mail Enterprise and Investigator allow you to search for, process and

even restore unpurged mail. For details, please refer to Searching unpurged mail.

Searching personal mail

Aid4Mail classifies an email as personal if it meets all three of the following conditions:

1. It is sent from an individual person,

2. It shows no evidence of being part of a campaign, message list or mailing list,

3. It shows no evidence of being a bulk email, advertisement, notification or journaled

email.

Aid4Mail Enterprise and Investigator allow you to include or exclude personal mail using

the Type:Personal operator. For further details, see Searching personal mail.
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Native filtering

Certain mail servers allow a pre-acquisition search to be carried out server-side (only

supported by Aid4Mail Enterprise and Investigator). There are many benefits to this,

especially when combined with an item filter that uses Aid4Mail's own, often more

powerful, search capabilities. Unfortunately, each mail service provider can have its own

syntax. The Native filters topic provides more information.

Python filter scripts

Create your own custom filters using Python scripts (only in Aid4Mail Enterprise and

Investigator). For detailed information, please refer to the Python scripts topic and its 

Python filter scripts sub-topic.
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10.1 Filter order

Aid4Mail applies filters in they order they appear in the Filter section of the Settings

screen: 

1. Folder or native filter

The folder or native filter (you can have either a folder filter or a native filter but not

both) is the first to be applied, before any mail has been read. When your source mail is

in the cloud, the filter is applied before any mail has even been collected. This can

significantly reduce the amount of emails Aid4Mail needs to process and greatly

improves performance.

2. Item filter

The item filter is the next to be applied. This happens during mail processing, after

Aid4Mail has read a source email but before it is saved to the target format.

3. Python filter script

If a Python filter script has been set, it will run immediately after the item filter but still

before the email is saved to the target format.

Folder/native filters, item filters and python scripts are all optional. If a filter or script has

not been set, that step in the process will simply be skipped.

The whole processing sequence is as follows:

Source format is accessed.

Folder or native filter is applied.

Source email is collected (one at a time).

Item filter is applied.

Python filter script is run.
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Email is saved to the target format.

Taking advantage of the filter order described above can significantly improve Aid4Mail's

performance. Likewise, the order of search terms within a filter is important to consider too.

For guidance, please refer to the Optimize your filters section of the Optimizing

performance topic.



50

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

10.2 Search terms

Aid4Mail filters consist of one or more search terms (except Python filter scripts which use a

different syntax).

A search term is a word or phrase to be searched for in folders, email messages or non-

email items (contacts, calendars, etc).  During processing, items that match your search

terms will be included in your target mail. Those that don’t will be excluded.

Search terms must adhere to specific rules. They can be refined by wildcards, punctuation

and regular expressions, and targeted with search operators. In addition, search terms can

be combined using Boolean operators.

Search term rules

There are general rules that apply to all search terms as well as specific rules for folder

search terms and item search terms. For details, please refer to the Search term rules topic.

Wildcards

A wildcard is a special token that stands in for one or more characters, HTML entities or

whole words. Some wildcards operate within a single word. Others span a sentence or

paragraph, or a specified number of words, to offer proximity searching. Please refer to the

Wildcards topic for details.

Punctuation

Quotes, parentheses, brackets and braces have special meaning in Aid4Mail’s filter syntax.

Please refer to the Punctuation topic for details.

Regular expressions

A regular expression (also known as regex) is an extremely powerful search pattern (with a

cryptic syntax) that enables searches that would not otherwise be possible. Aid4Mail

supports Perl Compatible Regular Expressions (PCRE) as search terms. Please refer to the

Regular expressions topic for details.

https://www.aid4mail.com/redir/pcre
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Search operators

Search operators allow you to narrow down a search by specifying exactly which items

should be included in the target mailbox. Aid4Mail supports most Gmail, Google Vault and

Microsoft Office search operators and many more. Please refer to the Search operators

topic for details.

Boolean operators

Boolean operators, also known as logical operators, allow you to negate search terms or

combine them to build sophisticated filters. Please refer to the Boolean operators topic for

details.

Example

An example of search terms that use case, punctuation, wildcards, a search operator and a

Boolean operator would be:

"Smith's Shelter" (cat* OR dog*) foldername:inbox

These search terms would find any emails in the Inbox that contain the exact phrase Smith’s

Shelter (case sensitivity depends on Smart case detection for item search terms), as long as

they also contain one or more words (case-insensitive) starting with cat or dog. So an Inbox

email containing this sentence would be found: At Smith’s Shelter, we never put cats in the

doghouse!

For a more detailed example, please refer to the Tutorial: Search and filter basics topic.
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10.2.1 Rules

General rules for all search terms

1. You can have any number of search terms.

2. Multiple search terms must be separated by spaces. For example: apple banana pear.

3. A line return is treated as a single space. This means that all search terms are on the

same line (although the line may wrap and appear as multiple lines when displayed,

depending on the number of search terms and the size of Aid4Mail's window). Note that

when you use the Enter key in one Aid4Mail's search boxes (Folder search terms, Native

search terms or Item search terms), a space will automatically be inserted instead of a

line return.

4. Search terms and Boolean operators must also be separated by spaces unless you’re

using the symbol versions of these operators (+, |, ^, or -). For example: cat AND dog

requires spaces but cat+dog does not.

5. When there is no Boolean operator between two search terms, the AND operator will be

used implicitly. For example, cat dog is the same as cat AND dog. Both will search for

all items that contain both words cat and dog.

6. Only whole words that match a search term are found. Matches with partial words are

not included (unless wildcards are used). For example, if your search term is cat,

Aid4Mail will search for all items that contain the whole word cat. It will not find cats,

wildcat or scatt or any other words that begin with, contain or end with cat. To search

for those you would need to use wildcards. 

7. Typographic quotes and apostrophes (“ ” and ‘ ’) will be treated the same as straight

ones (" " and ' '). This means that you can simply use straight quotes and apostrophes in

your search terms and these will also match the corresponding typographic characters.

Additional rules for folder search terms

1. Folder searches are always case-insensitive. For example, searching for Inbox will give

the same results as searching for inbox.

2. When no search operator is applied to a folder search term, the FolderName operator is

automatically applied. So the folder search term inbox is identical to

FolderName:Inbox. 
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3. Folder search operators are the only search operators that can be applied to folder

search terms.

Additional rules for item search terms

Note that item search terms are only available in Aid4Mail Enterprise and Investigator.

1. Case sensitivity in item searches depends on whether Smart case detection for item

search terms is on or off. By default it's off and searches are case-insensitive. If it's on then

searches for terms that contain one or more uppercase characters are case-sensitive,

and searches for terms that contain only lowercase characters are case-insensitive. 

Example: A case-sensitive search for the search term cat will not find Cat or CAT. It will

only find the exact match, cat. When the search is case-insensitive, any of those words

would match.

Note that search terms enclosed in braces have their own case sensitivity rules and are

not affected by Smart case detection for item search terms.

2. When no search operator is applied to an item search term, Aid4Mail will search both

the message header and message body of each email (or non-email item) for that term.

It may also search attachments, files contained within attachments and file metadata,

depending on the attachment options you have selected. This only applies to search

terms that don’t have search operators applied.

3. Any search operator can be applied to an item search term. However it is usually more

efficient to avoid folder search operators in an item search, unless there’s a specific

reason for using them. This is because item searches are carried out while emails (and

non-email items) are being read, whereas folder searches happen beforehand and so

can avoid large quantities of emails being read unnecessarily. Please refer to the Filter

order topic for additional information, and the Optimize your filters section of the

Optimizing performance topic for tips.
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10.2.2 Wildcards

A wildcard is a special token that stands in for one or more characters, HTML entities or

whole words. Some wildcards operate within a single word. Others span a sentence or

paragraph, or a specified number of words, to offer proximity searching.

Wildcards are divided into three categories:

· Character wildcards

· HTML entity wildcards

· Word wildcards

This topic also discusses:

· Character wildcards vs word wildcards

· Chaining wildcards
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10.2.2.1 Character wildcards

Wildcards that represent individual characters.

Wildcard Description

~ Matches zero or one character in a single word.

Example: jo~

Matches:

· Jo

· job

· jot

Does not match:

· John

· Jody

· joint

? Matches exactly one character in a single word.

Example: jo?

Matches:

· job

· jot

Does not match:

· Jo

· John

· Jody

· joint

* Matches zero or more characters in a single word.

Example: ca*t

Matches:

· cat

· cart

· carrot

· can't

Does not match:

· cats

· catch

~* Matches zero or more characters in the same sentence. 

Example: click~*link

Matches:

· click link

· click on link

Does not match:

· click on links
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Wildcard Description

· clicking on link

· Click on this link

· Click here for more. Alternatively

use this link.

· Click here for more.

Alternatively use this link.

** Matches zero or more characters in the same paragraph.

Example: click**link

Matches:

· click link

· click on link

· clicking on link

· Click on this link

· Click here for more. Alternatively

use this link.

Does not match:

· click on links

· Click here for more.

Alternatively use this link.
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10.2.2.2 HTML entity wildcards

Wildcards that represent individual characters or HTML entities. Note that HTML entities

will only be present in text to be searched when you use the Raw search operator.

Wildcard Description

& Matches exactly one character or HTML entities in a single word.

Example: Raw:na&ve

Matches:

· naive

· naïve

· na&iuml;ve

· na&#239;ve.

Does not match:

· naivete

· naïveté

· na&iuml;vet&eacute;

· na&#239;vet&#233;

Note that the &iuml; and &#239; entities both represent the ï

character. The &eacute; and &#233; entities both represent the é

character.

# Matches zero or more characters or HTML entities in a single word.

Example: Raw:na#

Matches:

· naive

· naïve

· na&iuml;ve

· na&#239;ve.

· naivete

· naïveté

· na&iuml;vet&eacute;

· na&#239;vet&#233;

Note that the &iuml; and &#239; entities both represent the ï

character. The &eacute; and &#233; entities both represent the é

character.
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10.2.2.3 Word wildcards

Wildcards that represent whole words.

Wildcard Description

<n> Matches up to n words, where n is any number between 0 and 99. The

words do not have to be in the same sentence or paragraph.

Example: robin<2>hood

Matches up to 2 words:

· Robin Hood

· Robin wears his hood

Does not match:

· Robin's old green hood

· Robin was stealthy. His hood

partially masked his face. 

· Robin was stealthy. 

His hood partially masked his

face.

· A hood covered the face of Robin.

Example: robin<3>hood

Matches up to 3 words:

· Robin Hood

· Robin wears his hood

· Robin was stealthy. His hood

partially masked his face. 

· Robin was stealthy. 

His hood partially masked his

face.

Does not match:

· Robin's old green hood

· A hood covered the face of Robin.

This wildcard enables traditional proximity searching while respecting

word order. In this respect, it is similar to Google's AROUND operator

(when used with quotes) and Outlook's ONEAR operator. For further

information, please refer to Proximity searching within a specified

distance.

<.> Matches zero or more words in the same sentence.

Example: robin<.>hood

Matches:

· Robin Hood

Does not match:

· Robin's old green hood

https://support.google.com/mail/answer/7190?hl=en
https://docs.microsoft.com/en-us/microsoft-365/compliance/keyword-queries-and-search-conditions?view=o365-worldwide#emailproperties
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Wildcard Description

· Robin wears his hood · Robin was stealthy. His hood

partially masked his face. 

· Robin was stealthy. 

His hood partially masked his

face.

· A hood covered the face of Robin.

This wildcard enables proximity searching with respect to the

grammatical context of the search terms. For further information,

please refer to Proximity searching within a sentence.

<*> Matches zero or more words in the same paragraph.

Example: robin<*>hood

Matches:

· Robin Hood

· Robin wears his hood

· Robin was stealthy. His hood

partially masked his face. 

Does not match:

· Robin's old green hood

· Robin was stealthy. 

His hood partially masked his

face.

· A hood covered the face of Robin.

This wildcard enables proximity searching with respect to the

grammatical context of the search terms. For further information,

please refer to Proximity searching within a paragraph.
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10.2.2.4 Character vs word wildcards

Certain character wildcards and word wildcards may initially appear to be very similar: The

~* character wildcard and <.> word wildcard both span sentences, and the ** character

wildcard and <*> word wildcard both span paragraphs. However, there are subtle

differences in their behavior. To demonstrate, consider how they would perform in the

following examples.

Example 1

robin~*hood and robin**hood use character wildcards and would both match:

Robin's old green hood. 

However, using word wildcards instead, robin<.>hood and robin<*>hood would not find

a match. This is because the 's in Robin's is accepted as two individual characters by the

character wildcards but is rejected by the word wildcards for not being a whole word.

Example 2

joseph**smith and joseph<*>smith would match both of these sentences:

· Joseph Smith

· Joseph walked to town. He is the most athletic member of the Smith family. 

However only joseph**smith would match:

· Josephine went to the Aerosmith concert. 

This is because the ine in Josephine and the Aero in Aerosmith are acceptable as sequences

of individual characters but not as whole words.
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10.2.2.5 Chaining wildcards

Multiple wildcards can be used within the same search term. 

Example 1

The following example combines two * wildcards in the same search term to match any

variation at the end of words:

"robin* hood*" 

This search term would find any of the following:

· Robin Hood

· Robin's hood

· Robin's hoods

· Robin Hood's

Example 2

The following example combines multiple character wildcards in the same search term: 

robin~*hood**bow~*arrow

It will find any text with robin and hood in the same sentence, hood and bow in the same

paragraph, and bow and arrow in the same sentence, all in the order specified. It would find

all three of these texts:

· Robin Hood took his bow and arrow.

· Robin Hood was the finest archer. He handled a bow and arrow better than anyone.

· Robin's hoodie had a bow and arrow logo.

However it would not find the following because Robin and hood are not in the same

sentence:

· Robin looked everywhere. He eventually found his hood, bow and arrow under a bush.

More examples

For more examples, please refer to Chaining proximity searches.
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10.2.3 Punctuation

Quotes, parentheses, brackets and braces have special meaning in Aid4Mail’s filter syntax.

The following list details the punctuation available in Aid4Mail:

Punctuation Description

"" Enclose search terms in quotes to search for an exact phrase that

includes a space. Wildcards can be used as long as an * character

wildcard is present.

Examples:

thanksgiving Mom "pecan pie"

Matches At Thanksgiving, Mom makes great pecan pie

"good dog*"

Matches good dogs and good doggies but not good little dog.

() Enclose search terms in parentheses to group operations. Nested

parentheses are permitted.

In some cases, parentheses are not required due to the order of

precedence of Boolean operators although their presence often

increases clarity.

Examples:
vacation AND (Bahamas OR Seychelles)
from:(john@aid4mail.com OR mary@aid4mail.com)
apple XOR (orange AND (lemon OR lime))

[] Search terms enclosed in square brackets must be exact. They are

case-sensitive and cannot use wildcards.

Example:
[Uncle Sam]

{} Braces allow you to specify a single search term, or a list of search

terms separated by | (vertical bar) operators, along with optional

modifiers. When a list is specified, emails containing any or all of the

search terms will be included.

Example 1:
{wolf|dingo|hyena|"african wild dog"}

The following optional modifiers can be applied to the search

term(s):
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Punctuation Description

C = Case-sensitive

F = Whole field

I = Case-insensitive

L = Literal

P = Partial words

R = Regular expression

W = Wildcards

The modifiers can be applied individually, or combined, by placing

one or more of them in square brackets, followed by an equal sign,

before the search terms as shown in the following examples.

Example 2:
{[C]=wolf|dingo|hyena|"african wild dog"}

Example 3:
{[IP]=Harry}

Example 4:
{[R]=(?s)<a.+?href\s*?=\s*?"(.*?)"} 

Example 1 has no modifiers so the search works as usual: case-

insensitive due to the lowercase characters. Wildcards can be used as

long as an * character wildcard is present.

Example 2 uses [C] as the modifier meaning the search for each term

in the list is case-sensitive. 

Example 3 uses [IP] as modifiers so the search is case-insensitive and

partial word matches are included. 

Example 4 uses the [R] modifier to tell Aid4Mail that the search term

is a Regular Expression.

Two additional modifiers, Exact and WordList, are available but

cannot be combined with those listed previously and so are not

placed inside square brackets.

The Exact modifier uses a faster search algorithm and is ideal for

searching for text that has no possible variants like User IDs or MD5

hash codes. For example:
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Punctuation Description

Uid:{Exact=397670}
Uid:{Exact=397670|397671}
MD5:{Exact=7b7e8488d0b11ff6dd30064fa5ff79c1}

It can also be used to search a list of exact terms in an external file:

Uid:{Exact=C:\Temp\UidList.txt}
List:{Exact="C:\Temp\Mailing List.txt"}

The WordList modifier allows you to put any search terms in an

external file. For example:

{WordList=C:\Temp\SearchTerms.txt}
Subject:{WordList=C:\Temp\Subjects.txt}

The external file should contain one search term per line. By default,

Aid4Mail will search for any of these terms, i.e. an OR operator will

automatically be applied to the search terms. You can explicitly tell

Aid4Mail to apply an OR operator or an AND operator as follows:

{WordList[OR]=C:\Temp\SearchTerms.txt}
{WordList[AND]=C:\Temp\SearchTerms.txt}

If you have a legacy word list file from Aid4Mail 4, that uses '+' and '-'

characters at the start of each line, you can tell Aid4Mail 5 to process

this too using WordList[Mixed] as follows:

{WordList[Mixed]=C:\Temp\SearchTerms.txt}
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10.2.4 Regular expressions

Definition

A regular expression (also known as regex) is an extremely powerful search pattern (with a

cryptic syntax) that enables searches that would not otherwise be possible. Aid4Mail’s

supports Perl Compatible Regular Expressions (PCRE) as search terms. 

Regular expression syntax is beyond the scope of this manual. However, the PCRE website

contains a syntax reference as well as information on pattern matching.

Using regular expressions in Aid4Mail search terms

You can tell Aid4Mail that your search term is a regular expression by enclosing it in braces

and using the [R] modifier, as explained in the Punctuation topic:

{[R]=SearchTerm} 

For example, imagine you want to find a sentence containing the words cat and dog, in that

order, located near each other but not necessarily next to each other in the sentence. For

this example, let’s say “near each other” is being within 10 words of each other. So the cat

loves the dog should be found but the cat chases the mouse and is then scared away by the

dog should not be found. Neither should the dog loves the cat be found because the order

of cat and dog is reversed. 

This is an example of proximity searching and can be done much more simply using the

<n> wildcard. However, to illustrate this example, let's use a regular expression instead. 

The regular expression to perform this search is:

\bcat\W+(?:\w+\W+){0,10}?dog\b

To specify the regular expression as a search term in Aid4Mail, enclose it in braces and use

the [R] modifier:

{[R]=\bcat\W+(?:\w+\W+){0,10}?dog\b}

Aid4Mail will now know that this search term is a regular expression and treat it

accordingly.

https://www.aid4mail.com/redir/pcre
https://www.aid4mail.com/redir/regex-syntax
https://www.aid4mail.com/redir/regex-patterns
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10.2.5 Search operators

Search operators allow you to narrow down a search by specifying exactly which items

should be included in the target mailbox. Aid4Mail supports most Gmail, Google Vault and

Microsoft Office search operators and many more. They are grouped in the following

categories:

· Folder search operators

· Sender/Recipient search operators

· Date/Time search operators

· Email section search operators

· Email attribute search operators

· Email ID search operators

Using search operators

Search operators make your search terms more specific. For example, the search term cat

will search for the word cat anywhere in the message header or body of the email.

However, if you only want to search for emails that have cat in the message subject, you

can specify Subject:cat.

Note that search operators are case-insensitive so it doesn't matter if you write Subject,

subject or SUBJECT. They all do the same thing. In this document, we use the first option.

In most cases a colon is used to separate the search operator from the word(s) being

searched, as in the example above. However, sometimes comparison operators provide

more clarity or additional functionality.

Comparison operators

Comparison operators are used by certain search operators to compare one value with

another. For example, the Size operator can be used to compare an email message’s size

with a given value. The message is then included in, or excluded from, the target mail

depending on the results of the comparison. For example, Size<=25M will include email

messages whose size is no more than 25 MB. Messages larger than 25 MB will be excluded.

To improve clarity, the equality comparison operator can be used instead of a colon to

separate the search operator from its parameter. For example, Size=25M is the same as

Size:25M but, arguably, easier to read.
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Similarly, the inequality comparison operator can be used instead of negating a whole

search term with the NOT Boolean operator or minus (-) Boolean operator. For example,

Size<>25M is the same as NOT Size=25M. In fact all of the following are identical:

Size<>25M
NOT Size=25M
NOT Size:25M
-Size=25M
-Size:25M

The following comparison operators can be used in Aid4Mail:

Operator Description

= Equal to.

<> Not equal to.

> Greater than.

< Less than.

>= At least (greater than or equal to).

<= At most (less than or equal to).
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10.2.5.1 Folder search operators

Search operator Searches for

FolderName Messages in a certain folder.

Example: FolderName:vacation

You can also specify a subfolder by using a backslash character.

Example: FolderName:vacation\2019

Label Same as FolderName, using Gmail / Google Vault syntax.

In Messages in a specific type of folder. 

Options:
In:Inbox
In:Sent
In:Drafts
In:Outbox
In:Spam
In:Trash

In:Starred
In:Important
In:Archive
In:Calendar
In:Contacts

In:Journal
In:Notes
In:Tasks
In:Chats
In:RssFeeds

Note that these options represent folder categories rather than

folder names. So using In:Inbox will also search for the following

alternative or localized folder names:

· boîte de réception

· in

· posteingang

· εισερχόµ εν α

· вхо дящ ие

·    

· …and many more

The same also applies to the other options. For a full list of all the

variations supported, please refer to the file FolderNames.dat in the

Data subfolder of your Aid4Mail program folder. Note that you can

edit this file to add (or remove) your own folder names.

However this means that In: cannot be used to search for custom

folders as it can with Gmail. To search for a custom folder use

FolderName instead.

You can list multiple folder types to search using the | (vertical bar)

operator:
In:Inbox|Sent|Drafts
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Search operator Searches for

Category Messages in a certain category. 

Options:
Category:Social
Category:Promotions
Category:Updates
Category:Forums
Category:Blue
Category:Green
Category:Orange
Category:Purple
Category:Red
Category:Yellow

You can list multiple categories to search using the | (vertical bar)

operator:
Category:Social|Promotions|Updates|Forums
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10.2.5.2 Sender/Recipient search operators

Search operator Searches for

From Email sender in the message header From field.

Example: From:john@aid4mail.com

To Email recipient in the message header To field.

Example: To:mary@aid4mail.com

CC Email recipient in the message header CC field.

Example: CC:jane@aid4mail.com

Bcc Email recipient in the message header BCC field.

Example: Bcc:tom@aid4mail.com

ReplyTo Email sender in the message header Reply-To field.

Example: ReplyTo:john@aid4mail.com

Sender Email sender in the message header From, Sender or Reply-To

fields.

Example: Sender:Sally

Recipients Email recipient in the message header To, CC or BCC fields.

Example: Recipients:Fookes

Participants Email sender or recipient in the message header From, To, CC or

BCC fields.

Example: Participants:Fookes

DeliveredTo Messages delivered to a given email address, from the message

header Delivered-To field.

Example: DeliveredTo:john@aid4mail.com

List A mailing list the message was sent from or to.

Example: List:info@aid4mail.com

ListID Same as List, using Google Vault syntax.
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10.2.5.3 Date/Time search operators

Email messages contain multiple dates. The sent and received dates are often the most

useful. However many, but not all, messages contain additional dates representing when

the message was stored, modified or deleted.

Date/Time format

Dates in Aid4Mail use a subset of the International date format. When dates are used with

search operators, quotes must be used if the date includes a time due to the presence of

the space character. For example:

YYYY
YYYY-MM
YYYY-MM-DD
"YYYY-MM-DD hh"
"YYYY-MM-DD hh:mm"
"YYYY-MM-DD hh:mm:ss"

Note that when the hour (hh) is specified it must use the 24-hour clock. 

If an invalid date is specified (for example 8018-18-80) then Aid4Mail will ignore it.

However, if you want to search for emails with invalid dates, use zero or the word Bad as

the date value.

Examples:
2018 The year 2018
2018-03 March 2018
2018-03-10 March 10, 2018
"2018-03-10 19" March 10, 2018 at 7pm
"2018-03-10 19:25:" March 10, 2018 at 7:25pm
"2018-03-10 19:25:30" March 10, 2018 at 7:25pm and 30 seconds
0 Invalid date
Bad Invalid date

Operators

Search operator Searches for

Sent Messages sent relative to a certain date, specified using comparison

operators (>, <, =, <>, >=, <=). 
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Search operator Searches for

If there is no Sent date, Aid4Mail will use the Received, Modified or

Stored date instead (in that order, whichever is found first). This

makes Sent the most trustworthy date operator to use.

Examples:
Sent>2018-02
Sent<"2018-03-10 19:30"
Sent=0

Received Messages received relative to a certain date, specified using

comparison operators (>, <, =, <>, >=, <=).

Note that outbound mail will not contain a Received date.

Examples:
Received=2017-01-31
Received<="2010-04-03 12:15"
Received=0

Stored Messages stored on disk relative to a certain date, specified using

comparison operators (>, <, =, <>, >=, <=).

Examples:
Stored<2015
Stored<>2018-01-01
Stored=0

Modified Messages modified relative to a certain date, specified using

comparison operators (>, <, =, <>, >=, <=).

Examples:
Modified>=2018-01-01
Modified<"2015-03-03 10:00"
Modified=0

Deleted Messages deleted relative to a certain date, specified using

comparison operators (>, <, =, <>, >=, <=).

Examples:
Deleted=2018-05-05
Deleted<>2018-05-04
Deleted=0

OlderThan Messages older than a given amount of time, relative to today and

specified using d, m or y for day, month or year.
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Search operator Searches for

Examples:
OlderThan:6m

NewerThan Messages newer than a given amount of time, relative to today and

specified using d, m or y for day, month or year.

Examples:
NewerThan:7d

SentBefore Messages sent before a given date. This is the same as using Sent

with the < operator.

Example:
SentBefore:"2018-03-10 19:30"

SentAfter Messages sent after a given date. This is the same as using Sent with

the > operator.

Example:
SentAfter:2018-02

ReceivedBefore Messages received before a given date. This is the same as using

Received with the < operator.

Example:
ReceivedBefore:"2016-09-09 09:30:00"

ReceivedAfter Messages received after a given date. This is the same as using

Received with the > operator.

Example:
ReceivedAfter:2017

Sent_Before Same as SentBefore, using Google Vault syntax.

Before Same as SentBefore, using Gmail syntax.

Older Same as SentBefore, using Gmail syntax.

Sent_After Same as SentAfter, using Google Vault syntax.

After Same as SentAfter, using Gmail syntax. 

Newer Same as SentAfter, using Gmail syntax.

Received_Before Same as ReceivedBefore, using Google Vault syntax.
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Search operator Searches for

Received_After Same as ReceivedAfter, using Google Vault syntax.

Older_Than Same as OlderThan, using Gmail / Google Vault syntax.

Newer_Than Same as NewerThan, using Gmail / Google Vault syntax.

Which date operator should I use?

If you're not sure which date operator to use, then use Sent. This is for two reasons:

1. The Sent date is the most likely to contain a value. Unless the message is a draft, it will

have a Sent date whereas Received dates are missing in all outbound mail.

2. If the Sent date is missing then Aid4Mail will automatically use the Received, Modified

or Stored date instead (in that order, whichever is found first).

This makes Sent the most trustworthy date operator. It's the one we recommend unless you

have specific reasons for using another date operator.

Note that email clients are not consistent in displaying dates. The Date field in the email

header is usually the Sent date. However, some email programs choose to display one of

the other dates instead which can be confusing.
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10.2.5.4 Email section search operators

Search operator Searches for

Header Words in any part of the message header. This is the same as using

Header[All].

Example: Header:john@aid4mail.com

Header[Field] Words in a specific field of the message header.

Example: Header[x-mailer]:"Apple Mail"

You can also use All as a parameter to search all fields in the header:

Example: Header[All]:helpdesk@aid4mail.com

References References to other emails in the same thread as this one.

Example: References:<41F653C3.3234.14AD858@localhost>

Subject Words in the message subject line. 

Example: Subject:(vacation bahamas)

Text Text in any part of the message body. HTML tags in the text are

stripped before searching with this operator so, for example,

<em>small</em> dog becomes small dog in the text to search.

Example: Text:(apples OR oranges)

Raw Content in any part of the email in its raw MIME format. This is useful

if you want to search for specific content types or words within

known HTML tags.

Examples: 
Raw:"Content-Type: multipart/mixed"
Raw:<del>red</del>

FileText Text in an attachment, or in a file inside an attachment (for example

a Word file inside a ZIP attachment). It also includes text in EXIF,

IPTC and XMP metadata in JPEG, TIFF and PSD images but excludes

all other metadata.

This operator is only available in Aid4Mail Enterprise and

Investigator and is not affected by the attachment options in the

Filter settings. Most common file types are supported.

Examples:
FileText:(apples OR oranges)
FileText:"artist:*doisneau"
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Search operator Searches for

If you know what type of document contains the search terms, you

can speed up the search by specifying the document type in square

brackets following the operator name. 

Examples:
FileText[Pdf]:(apples OR oranges)
FileText[Image]:"artist:*doisneau"

The following document types are supported:
Audio
Database
Document
Email
Excel
Image

Jpeg
Multimedia
Pdf
Powerpoint
Presentation
SourceCode

Spreadsheet
Tiff
Video
Website
Word

Several document types can be specified in a list using the | (vertical

bar) operator:
FileText[Pdf|Word|Excel]:(apples|oranges)

Document types can be excluded by starting the list with the -

(minus) operator. All document types will then be searched except

those in the list. For example:
FileText[-Multimedia|Database]:(apples|oranges)

The more you narrow down the document type in your search script,

the faster Aid4Mail will run.

FileMetadata Metadata in attachments, and in files contained inside attachments,

from a wide range of file formats. Note that collecting metadata

requires considerable system resources and can impact Aid4Mail’s

performance.

This operator is only available Aid4Mail Enterprise and Investigator

and is not affected by the attachment options in the Filter settings.

Example:
FileMetadata:Fookes

If you know the type of document containing the search terms, you

can speed up the search by specifying the document type in square

brackets after the operator name. 



77

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

Search operator Searches for

Example:
FileMetadata[Pdf]:Fookes

The following document types are supported:
Audio
Database
Document
Email
Excel
Image

Jpeg
Multimedia
Pdf
Powerpoint
Presentation
SourceCode

Spreadsheet
Tiff
Video
Website
Word

Several document types can be specified in a list using the | (vertical

bar) operator:
FileMetadata[Pdf|Word|Excel]:Fookes

Document types can be excluded by starting the list with the -

(minus) operator. All document types will then be searched except

those in the list. For example:
FileMetadata[-Multimedia|Database]:Fookes

The more you narrow down the document type in your search script, the faster Aid4Mail will run.

AttachmentNames Messages that contain attachments with a given filename or

extension. Does not include files contained inside attachments.

Examples:
AttachmentNames:JanuaryReport.pdf
AttachmentNames:pdf

FileNames Messages that contain files with a given filename or extension.

Includes both attachments and any files contained within them.

Examples:
FileNames:JanuaryReport.pdf
FileNames:pdf

FileName Same as AttachmentNames, using Gmail / Google Vault / MS Office

syntax.
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10.2.5.5 Email attribute search operators

Search operator Searches for

Importance The importance of an email message, if specified.

Options:
Importance:Highest
Importance:High
Importance:Medium
Importance:Low
Importance:Lowest

You can list multiple alternatives to search using the | (vertical bar)

operator:
Importance:Highest|High

Type Messages that are of a certain type. 

Options:
Type:Calendar
Type:Chat
Type:Contact
Type:Deleted
Type:Draft
Type:Duplicate
Type:Encrypted
Type:Filtered
Type:Forwarded
Type:Important
Type:Journal

Type:Journaled
Type:List
Type:News
Type:Note
Type:Notification
Type:Notify
Type:Offline
Type:Partial
Type:Personal
Type:Read
Type:Received

Type:Redirected
Type:Replied
Type:Sent
Type:Spam
Type:Starred
Type:Task
Type:Unpurged
Type:Unread
Type:Unsent

You can list multiple types to search using the | (vertical bar)

operator:
Type:Deleted|Unpurged

The Glossary contains definitions for the following types:

· Duplicate

· Encrypted

· Journal

· Journaled

· Offline

· Partial

· Personal

· Unpurged

Content Messages that include an attached or embedded file of a certain

type. 



79

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

Search operator Searches for

Options:
Content:Archive
Content:Attachment
Content:Audio
Content:Database
Content:Document
Content:Email

Content:Excel
Content:Image
Content:Jpeg
Content:Multimedia
Content:Pdf
Content:Powerpoint

Content:Presentation
Content:SourceCode
Content:Spreadsheet
Content:Video
Content:Word

You can search for multiple options using the | (vertical bar) operator:
Content:Pdf|Word

Size Messages with a certain size, specified using comparison operators

(>, <, =, <>, >=, <=). Size units are specified using B, K, M, or G (for bytes,

KB, MB and GB, respectively). 

Examples:
Size<=25M
Size>25B

Larger Messages that are larger than a certain size. This is the same as using

Size with the > operator. Size units are specified using B, K, M, or G (for

bytes, KB, MB and GB, respectively). 

Example:

Larger:100B (same as Size>100B)

Smaller Messages that are smaller than a certain size. This is the same as

using Size with the < operator. Size units are specified using B, K, M, or

G (for bytes, KB, MB and GB, respectively). 

Example:

Smaller:20M (same as Size<20M)

Is Same as Type, using Gmail / Google Vault syntax. 

IsRead Same as Type:Read, using MS Office syntax.

Options:

IsRead:True (same as Type:Read)

IsRead:False (same as NOT Type:Read)

Has Same as Content: but using Gmail / Google Vault syntax. 

HasAttachment Same as Content:Attachment, using MS Office syntax.
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Search operator Searches for

Options:

HasAttachment:True (same as Content:Attachment)

HasAttachment:False (same as NOT Content:Attachment)
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10.2.5.6 Email ID search operators

Search operator Searches for

MessageId Unique message ID as specified in the RFC 822 standard. If the

application that created and sent the message did not add a

message ID, it is sometimes added by servers that the message

passes through. However, some messages don’t contain any

message ID at all.

Example: 
MessageId:<000000000000615e100583c436d4@google.com>

Uid Message with a specific Unique ID from an IMAP server. 

You can specify a single UID to search for, or a file that contains a

list of UIDs (use the Exact modifier for faster processing of the list).

Examples:
Uid:397670
Uid:397670|397671
Uid:{exact=C:\Temp\UID.txt}

Md5 Messages with specific MD5 signatures. An MD5 signature is a

unique identifier created from an email message ID or, if that

doesn’t exist, from various fields in the message header. An MD5

signature can be created for any email. 

You can specify a single MD5 signature to search for, or a file that

contains a list of MD5 signatures (use the Exact modifier for faster

processing of the list).

Examples: 
Md5:7b7e8488d0b11ff6dd30064fa5ff79c1
Md5:{exact=C:\Temp\MD5.txt}

Rfc822MsgId Same as MessageId, with Gmail / Google Vault syntax.

https://www.aid4mail.com/redir/rfc2822
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10.2.6 Boolean operators

Boolean operators, also known as logical operators, allow you to negate search terms or

combine them to build sophisticated filters.

Boolean

operator

Description

AND Searches for messages that include both the term before and the term

after the operator. Must be separated from other terms and operators

by a space.

Examples:
vacation AND bahamas

Finds messages that contain both the word vacation and the word

bahamas.

from:john@aid4mail.com AND to:mary@aid4mail.com

Finds messages sent from John to Mary.

OR Searches for messages that include either the term before or the term

after the operator, or both. Must be separated from other terms and

operators by a space.

Examples:

vacation OR bahamas 

Finds messages that contain either the word vacation or the word

bahamas or both.

from:john@aid4mail.com OR to:mary@aid4mail.com

Finds messages sent from John, or messages sent to Mary, including

messages sent from John to Mary.

XOR Searches for messages that include either the term before or the term

after the operator, but not both. Must be separated from other terms

and operators by a space.

Examples:

vacation XOR bahamas 

Finds messages that contain either the word vacation or the word

bahamas but rejects those that contain both words.

from:john@aid4mail.com XOR to:mary@aid4mail.com

Finds messages sent from John, or messages sent to Mary, but rejects

messages sent from John to Mary.
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Boolean

operator

Description

NOT Searches for messages that do not include the term after the

operator. Must be separated from other terms and operators by a

space.

Examples:

NOT vacation 

Finds messages that do not contain the word vacation.

(NOT from:john@aid4mail.com) AND to:mary@aid4mail.com

Finds messages that were sent to Mary except those sent by John.

+ Same meaning as AND but does not use a space to separate it from

other terms or operators. 

Example: vacation+bahamas

| Same meaning as OR but does not use a space to separate it from

other terms or operators. 

Example: vacation|bahamas

^ Same meaning as XOR but does not use a space to separate it from

other terms or operators. 

Example: vacation^bahamas

- Same meaning as NOT but does not use a space to separate it from

other terms or operators. 

Example: -vacation

Boolean operators do not have to be capitalized. So vacation and bahamas is the same

as vacation AND bahamas. However, capitalizing Boolean operators increases readability

and is recommended in most cases.

If no Boolean operator is specified between search terms, the AND operator will be used.

So vacation bahamas is the same as vacation AND bahamas. 

Parentheses are useful to group operations. For example:
vacation AND (bahamas OR seychelles)
from:(john@aid4mail.com OR mary@aid4mail.com)
apple XOR (orange AND (lemon OR lime))
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Order of precedence

The order of precedence of Boolean operators is:

() > NOT > AND > XOR > OR

That is, Parenthesis are processed before NOT operators, which take precedence over AND

operators, which in turn take precedence over XOR. OR operators are processed last. Note

that this is different to the order of precedence in Gmail.
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10.3 Tutorial: Search and filter basics

The example below walks you through the basics of searching and filtering with Aid4Mail.

It uses Aid4Mail Investigator which, along with Aid4Mail Enterprise, has access to all of the

search and filter capabilities (Aid4Mail Converter is limited to searching and filtering

folders). 

If you don’t have a license for Aid4Mail Investigator, you can still follow this example by

running Aid4Mail Investigator in trial mode. The trial is totally free and will not affect any

other Aid4Mail license you may have. To do this, select File > Change edition > Aid4Mail

Investigator Trial from the main menu. Once you’ve finished testing Aid4Mail Investigator,

you can use the same menu option to change the edition back again.

Note that in trial mode, Aid4Mail works on modified copies of your mail which may impact

your filter results. For more details see the Trial mode topic.

Example requirements

Let’s say you only want to process emails sent to john@aid4mail.com in the first quarter of

2018, that include either the keywords vacation or Bahamas (or both) and the phrase travel

agent, and are still in the Inbox folder. Breaking this down into its constituent parts, the

targeted emails must match the following criteria:

1. Sent to john@aid4mail.com.

2. Sent in first quarter of 2018.

3. Include the word vacation or Bahamas or both. 

4. Include the phrase travel agent.

5. Are still in the Inbox folder.

The ordering of filters is important so, first, you need to know what is being searched for at

the folder level and what is at the item (email) level. Looking through the requirements,

number 5 is the only folder search and the rest are all item searches.

Folder search

There's a couple of ways to approach a folder search: You can either select the required

folder(s) in the folder tree or use folder search terms.

mailto:john@aid4mail.com
mailto:john@aid4mail.com
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Select folders in the folder tree
In the Folder or native filter section of the Filter settings, choose the Select in folder tree

option. Aid4Mail will display your folder tree with everything selected. Click the topmost

folder to deselect all folders. Then select only the Inbox folder.

Select in folder tree

Use folder search terms
You can accomplish the same thing using Folder search terms. Select this option and then

in the search box write inbox as shown below:

Folder search terms

The search term you just created tells Aid4Mail to only include emails that are in the Inbox

folder. All other folders will be excluded.
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Folder searches are case-insensitive so it doesn’t matter if you write inbox or Inbox. And

when a folder search term has no search operator applied to it, the foldername operator is

automatically applied. So the search term inbox is identical to foldername:inbox.

If you had written NOT inbox instead, or more concisely -inbox, then all folders except

the Inbox would have been included in your target mail. The Inbox would have been

excluded because the Boolean NOT operator inverts the result. 

You can also search for custom folders. For example, if John had a folder called Vacation,

you could have searched for it in the same way: vacation. Or you could add it to the initial

search by writing inbox OR vacation, or more concisely inbox|vacation. The Boolean

OR operator between the search terms will result in a match of either one of them or both.

Note that inbox AND vacation would not be appropriate as it would only include emails

that exist in both folders.

For simple examples like this it’s easy to write your search terms directly in the search field.

For more complex terms you can use the search assistant to construct them. However, once

you become familiar with the various search operators and Boolean operators, you’ll

probably find it quicker to continue writing your search terms directly.

Item search

In the Item search terms field, enter the following:

To:john@aid4mail.com SentAfter:2017 SentBefore:2018-05 (vacation OR
bahamas) "travel agent"

Item search terms

Again, you can write the search terms directly or use the search assistant.

Any space between search terms, where no Boolean operator is specified, uses an AND

operator by default. So this search is equivalent to:

mailto:john@aid4mail
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To:john@aid4mail.com AND SentAfter:2017 AND SentBefore:2018-05 AND
(vacation OR bahamas) AND "travel agent"

Let’s go through the search terms one by one.

To:john@aid4mail.com
This tells Aid4Mail to only include emails sent to the address john@aid4mail.com. 

Note that search operators are case-insensitive. So writing To or to makes no difference.

If you wanted to include Mary’s emails too, you would write To:(john@aid4mail.com OR

mary@aid4mail.com) or, alternatively, To:john@aid4mail.com|mary@aid4mail.com. 

If you wanted to search for mail sent to anyone at the company, you would use a wildcard.

For example, using the * character wildcard to make the search term To:*@aid4mail.com,

would find emails sent to any address within the aid4mail.com domain.

SentAfter:2017
Aid4Mail will only include emails sent after the date specified. In this example, only the

year has been specified. The month could have been added too, SentAfter:2017-12, and

the day, SentAfter:2017-12-31, but they aren’t required in this case. 

Note that the date is specified in the International date format: YYYY-MM-DD.

SentBefore:2018-05
This time specifying the month is necessary to get the correct results.

(vacation OR bahamas)
This is a case where the Boolean operator must be explicitly specified. If there had just

been a space between the two keywords, (vacation bahamas), an AND operator would

automatically be applied, (vacation AND bahamas), which is not what is wanted. The

requirements state that emails containing either of those words (or both) are to be

included so the OR is necessary.

Note that the two keywords are written lowercase. Case only makes a difference when

Smart case detection for item search terms is turned on. It’s off by default, making the

search case-insensitive, but let’s assume that for this example it’s on. Then using uppercase

letters in a keyword makes the search for that word case-sensitive. So if the keyword had

been written as Bahamas, only that exact word would be found. Any variation, such as

BAHAMAS or bahamas, would be excluded from the results. Specifying the keyword in

mailto:john@aid4mail
mailto:john@aid4mail.com
mailto:john@aid4mail.com
mailto:john@aid4mail.com
mailto:mary@aid4mail.com
mailto:john@aid4mail.com|mary@aid4mail.com
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lowercase makes the search case-insensitive, so bahamas, Bahamas, BAHAMAS, bAhAmAs or

any other variation in case would be included in the results. Turning Smart case detection

for item search terms off also makes the search case-insensitive, and for all search terms.

Parentheses are required here due to the order of precedence of Boolean operators

whereby AND operators take precedence over OR operators. As parentheses take

precedence over all Boolean operators, their presence ensures that (vacation OR

bahamas) will be treated as a group.

"travel agent"
The quotes here tell Aid4Mail to look for an exact phrase. So only these two words

together will be found, in this order, as they’re written. Emails with the phrase travel and

transport agent, for example, would be excluded. Case sensitivity again depends on Smart

case detection for item search terms.

If the quotes were removed, the search term would become travel agent which is the same

as travel AND agent (because a space with no operator automatically becomes an AND

operator). This would then include emails containing travel and transport agent and even

agent for travel. In fact it would include any email that contains both of the words, no

matter their order, location in the email or proximity to each other, which is not what is

wanted in this example.

Conclusion

Hopefully this has given you an overview of Aid4Mail’s powerful search and filter

capabilities. There’s much more you can do that has not been covered here, like proximity

searching, deduplicating and searching unpurged mail. For more information on all the

available search operators and other syntactic details, please refer to the Search terms

topic. And if you are interested in searching and filtering with Python scripts, which are

extremely powerful but more advanced, please refer to the Python scripts topic. 
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10.4 Proximity searching

A proximity search finds words or characters that are located close to one another.

Proximity searches can be very powerful, using context to enable precise searching and

filtering.

Most proximity search engines are limited to finding words within a specified distance of

one another, where distance is the number of intermediate words. Aid4Mail can do this too

but goes further, beyond traditional proximity searching. It enables you to search within the

grammatical structures that naturally exist in most text—sentences and paragraphs—

regardless of the number of intermediary words. 

This topic covers all three categories of proximity searching supported by Aid4Mail:

· Proximity searching within a sentence

· Proximity searching within a paragraph

· Proximity searching within a specified distance

It also addresses two subjects that affect all proximity searches:

· Word order in proximity searches

· Chaining proximity searches
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10.4.1 Proximity searching within a sentence

Aid4Mail provides proximity searching within a sentence through the ~* character wildcard

and the <.> word wildcard.

Matching characters within a sentence

The ~* character wildcard will match zero or more characters, including white space

characters, as long as the search term is found within a single sentence. In other words, as

long as no period (full stop) or tab character has been encountered. 

For example, searching for jim~*sand will find both of these sentences:

1. Jim played in the sand.

2. Jimmy was sinking in quicksand.

It will not find the following because the search term spans more than one sentence in both

cases:

3. Jim played all day. He had the most fun in the sand.

4. Jimmy didn't read the sign. He was sinking in quicksand.

Matching words within a sentence

The <.> word wildcard will match zero or more whole words, rather than individual

characters, within a single sentence. This gives slightly different results. Searching for

jim<.>sand will find:

1. Jim played in the sand.

However it will not find:

2. Jimmy was sinking in quicksand.

3. Jim played all day. He had the most fun in the sand.

4. Jimmy didn't read the sign. He was sinking in quicksand.

Sentence 2 will not be found because the my at the end of Jimmy, and the quick at the

beginning of quicksand, are not whole words and so are not matched by the <.> wildcard. 

Sentences 3 and 4 will not be found because the search term spans more than one

sentence in both cases.



92

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

Matching both characters and words within a sentence

In order to find sentence 2 in the examples above using the <.> word wildcard, you could

add additional character wildcards to match the partial words. 

For example, the * character wildcard matches zero or more characters within the same

word. Adding a * character wildcard at the end of jim would match the my at the end of

Jimmy. Adding another * character wildcard before sand would match the quick at the start

of quicksand. The <.> wildcard would continue to match the intermediate words between

Jimmy and quicksand. The search term would then become jim*<.>*sand and would 

produce identical results to jim~*sand, both finding sentence 2.

Table cells are treated as sentences

When searching text in tables, Aid4Mail treats table cells as if they were sentences and

rows as paragraphs. 
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10.4.2 Proximity searching within a paragraph

Aid4Mail provides proximity searching within a paragraph through the ** character

wildcard and the <*> word wildcard.

Matching characters within a paragraph

The ** character wildcard will match zero or more characters, including white space

characters, as long as the search term is found within a single paragraph. In other words, as

long as no new line has been encountered.

For example, searching for jim**sand will find all of these texts:

1. Jim played in the sand.

2. Jimmy was sinking in quicksand.

3. Jim played all day. He had the most fun in the sand.

4. Jimmy didn't read the sign. He was sinking in quicksand.

However it will not find the following as the search term spans more than one paragraph.

In other words, one (or more) of the intermediary characters is a new line:

5. Jim played all day at the beach.

The next day he returned to the sand dunes to search for shells.

Matching words within a paragraph

The <*> word wildcard will match zero or more whole words, rather than individual

characters, within a single paragraph. This gives slightly different results. Searching for

jim<*>sand will find:

1. Jim played in the sand.

3. Jim played all day. He had the most fun in the sand.

However it will not find:

2. Jimmy was sinking in quicksand.

4. Jimmy didn't read the sign. He was sinking in quicksand.

5. Jim played all day at the beach.

The next day he returned to the sand dunes to search for shells.
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Sentences 2 and 4 will not be found because the my at the end of Jimmy, and the quick at

the beginning of quicksand, are not whole words and so are not matched by the <*>

wildcard. 

Sentence 5 will not be found because the search term spans more than one paragraph.

Matching both characters and words within a paragraph

In order to find sentences 2 and 4 in the examples above using the <*> word wildcard, you

could add additional character wildcards to match the partial words. 

For example, the * character wildcard matches zero or more characters within the same

word. Adding a * character wildcard at the end of jim would match the my at the end of

Jimmy. Adding another * character wildcard before sand would match the quick at the start

of quicksand. The <*> word wildcard would continue to match the intermediate words

between Jimmy and quicksand. The search term would then become jim*<*>*sand and

would  produce identical results to jim**sand, both finding sentences 2 and 4.

Table rows are treated as paragraphs

When searching text in tables, Aid4Mail treats table cells as if they were sentences and

rows as paragraphs. 
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10.4.3 Proximity searching within a specified distance

Aid4Mail provides proximity searching within a specified distance through the <n>

wildcard. Distance is measured as the number of intermediate words (n).

Specifying distance between words

The <n> wildcard matches a specified maximum number of intermediate words. Replace

the letter n with a value between 0 and 99 corresponding to the number of whole words to

match. For example, the following search term will match up to 12 words between cat and

dog:

cat<12>dog

This search term will find all of the following:

· cat, dog

· cat and dog

· I love my cat and my dog.

· A cat chases mice and other small creatures. It will only go after a dog if threatened.

· A cat chases mice and other small creatures. 

It will only go after a dog if threatened.

Notice that the words cat and dog don't have to be in the same sentence. They don't even

have to be in the same paragraph. As long as they appear in the text in the order specified,

and within 13 words of each other (i.e. 12 intermediary words), they will be found.

Word variation

The search term cat<12>dog will not find the following:

I have two cats and four dogs.

This is because cat in the search term will not match cats (plural) in the text. Likewise, dog

will not match dogs. In addition, the <n> wildcard only matches whole words and so will

not match the s on the end of cats. 

Additional character wildcards at the end of cat and dog are necessary to match plurals.

We could use the ~ wildcard if we only want to cater for one additional character (the s at

the end of the words). However, let's use the * wildcard as it gives more flexibility and will

match more than one additional character. This allows the matching of doggy and doggies,

for example. The search terms have now become:
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cat*<12>dog*

These search terms will now match every example text, above, as well as all of the

following:

· Are you a cat or dog person?

· Are cats or dogs your favorite?

· My cats are very dog-like.

· This is her Royal Catness. She rules over the doggies.
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10.4.4 Word order in proximity searches

Word order is important

The order of words in a proximity search term is important. For example, the search term

jim<5>sand will find the following sentence:

Jim played in the sand.

However it will not find:

Sand is where Jim likes to play.

This is because the order of the words, Sand and Jim, in the second sentence does not

match the order specified in the search term. To find the second sentence the search term

would need to be reversed: sand<5>jim. In this respect, the <n> wildcard is similar to

Google's AROUND operator (when used with quotes) and Outlook's ONEAR operator. 

The same applies to all proximity search terms. In the following list, the first two search

terms use proximity searching within a sentence, the next two use proximity searching

within a paragraph, and the last one uses proximity searching within a specified distance.

All will find the first sentence, above, but not the second:

jim~*sand
jim<.>sand
jim**sand
jim<*>sand
jim<5>sand

Their inverses will find the second sentence but not the first:

sand~*jim
sand<.>jim
sand**jim
sand<*>jim
sand<5>jim

Ignoring word order

What if you don't care about word order? To find jim and sand in the same sentence,

irrespective of their order, you'd need to specify both the original search term and its

inverse, separated by an Boolean OR operator:

jim<5>sand OR sand<5>jim

https://www.aid4mail.com/redir/gmail-operators
https://www.aid4mail.com/redir/outlook-operators
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Likewise for all the proximity search terms:

jim~*sand OR sand~*jim
jim<.>sand OR sand<.>jim
jim**sand OR sand**jim
jim<*>sand OR sand<*>jim
jim<5>sand OR sand<5>jim

All of the above search terms will now find both sentences:

Jim played in the sand.

Sand is where Jim likes to play.
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10.4.5 Chaining proximity searches

As with all wildcards, you can specify more than one in the same search term. 

Example 1

cat<8>dog<8>horse

The above search term will match text that has dog within 9 words of cat (8 intermediary

words) and also horse within 9 words of dog. All three words must be present and in the

order specified. An example match would be:

I own a cat called Fluffy and a dog called Rex but my favorite pet is my horse, Blossom.

Example 2
Different categories of proximity wildcards can even be mixed in the same search term:

jim<.>sand<*>sea

The above  search term will find text with jim and sand in the same sentence, and sand and

sea in the same paragraph, in that order. An example match would be:

Jim played all day in the sand. He only came in when the sea got too cold.
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10.5 Deduplication

Definitions

Duplicates are emails that are identical to each other as determined by the rules below.

Deduplication is the process of eliminating duplicate emails, ensuring there is only one of

each in your target mail. 

How do duplicates occur?

There are a variety of situations that could result in duplicate emails. For example:

· When an email client downloads mail from a POP mail server, and is set to leave mail on

the server, the next time it fetches the mail it will be duplicated.

· Duplicates can result from copy/paste actions in a mailbox or in a folder of individual

messages files (like EML or MSG files).

· Many mail clients organize email in folders but connect to mail services, like Gmail, that

use the concept of labels rather than folders. As a single email can have multiple labels

attached to it, after downloading it may be copied to multiple folders in the mail client. 

How to deduplicate in Aid4Mail

Skip duplicates in the Filter settings
If skipping duplicates and/or unpurged mail are the only item filters you require, the

simplest way to do this is through the Skip items section of the Filter settings. However, if

you require additional search terms, you'll need to skip duplicates using a search term.

Skip duplicates using a search term
Aid4Mail makes deduplication very easy through a simple search term that uses the Type

search operator:

NOT Type:Duplicate

 The same search term can be written more concisely as:

-Type:Duplicate
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Both these search terms are identical in functionality and will eliminate all duplicates from

your target mailbox. You only need to use one of them, placing it in the the Item search

term field in Aid4Mail. You can either write it in the field directly or use the Assistant to

insert it for you (once the assistant is open, Select > Common search terms > Skip

duplicates). 

Understanding the deduplication search term
The Type operator finds emails that are of a certain type so Type:Duplicate finds

duplicates. However, as is, this search term would result in your target mail consisting only

of duplicate emails, the opposite of deduplication! 

To eliminate duplicates, the search term needs to be negated using the Boolean NOT

operator or its more concise version, the minus (-) operator. This results in either NOT

Type:Duplicate or -Type:Duplicate. Both are identical in functionality.

Deduplication scope

By default, Aid4Mail only identifies duplicates that are in the same source folder. However

you can widen the scope to detect duplicates wherever they are located. This is done

through Duplicates detection scope in the Filter section of the Options screen. 

How does Aid4Mail determine duplicates?

To determine if two emails are identical, Aid4Mail compares charactersitics of their

headers. The exact method used depends on the Generate hash value from option, under

the Session section of the Options screen.

· If Generate hash value from is set to Original SMTP header then the headers of both

emails must match in their entirety for them to be considered duplicates.

· If Generate hash value from is set to Message-ID header field, only the Message-ID fields

need to match for the emails to qualify as duplicates. In cases where the Message-ID is

empty or missing, as is often the case in outbound messages, Aid4Mail compares the

From, Date and Subject header fields instead.
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10.6 Searching unpurged mail

What is unpurged mail?

Unpurged mail refers to hidden copies of emails that have been deleted or moved to

another location.

When you delete an email, or move it from one folder to another in your email client, the

process is more complex than it initially seems. A copy of the message is placed in the

destination folder but the original message is not deleted immediately. Instead it is

flagged as DELETED and hidden from display. It is only deleted permanently when the

folder containing it is purged (or compacted or expunged, depending on the terminology

used).

The reason for this behavior is to optimize the delete and move processes by not having to

reorganize a mailbox every time. As mailboxes can become very large, and emails can

usually be moved around or deleted without limitation, this provides a considerable time-

saving. However, it also means that mailboxes can contain considerable amounts of

unpurged mail.

How does Aid4Mail treat unpurged mail?

Generally, unpurged mail is not wanted. After all, it's remnants of emails that have been

deleted or moved. However, it can be of interest to those doing investigative work and

used as evidence in legal situations. For this reason, it is handled differently by the various

Aid4Mail editions. 

· Aid4Mail Enterprise and Investigator automatically process unpurged mail and restore it

by removing the DELETED status flag. However, you can still skip, or even target it

specifically, using one of the methods described below. Note that unpurged mail is not

accessible in PST files or Outlook profile message stores.

· Aid4Mail Converter automatically skips unpurged mail. 

If unpurged mail is to be skipped, whether intentionally or automatically, we recommend

you purge/compact/expunge your source mailboxes or accounts before running Aid4Mail.

This potentially reduces the amount of mail Aid4Mail has to process and speeds up your

migration.
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Skip or target unpurged mail in Aid4Mail Enterprise/Investigator

Skip unpurged mail in the Filter settings
If skipping unpurged mail and/or duplicates are the only item filters you require, the

simplest way to do this is through the Skip items section of the Filter settings. However, if

you require additional search terms, you'll need to skip unpurged mail using a search term.

Include only unpurged mail using a search term
What if you want your target mail to consist only of unpurged mail? Aid4Mail Enterprise

and Investigator make this easy through a simple search term that uses the Type search

operator:

Type:Unpurged

This search term should be placed in the Item search term field in Aid4Mail. You can either

write it in the field directly or use the Assistant to insert it for you (once the assistant is

open, Select > Common search terms > Include only unpurged mail). 

This will not work in Aid4Mail Converter because unpurged mail is automatically skipped,

as explained in the previous paragraph.

Skip unpurged mail using a search term
In Aid4Mail Enterprise and Investigator, it is still possible to skip all unpurged mail. As this

task is the opposite of including only unpurged mail, simply negate the search term above

using using the Boolean NOT operator:

NOT Type:Unpurged

Alternatively, use its more concise version, the minus (-) operator:

-Type:Unpurged

Both these search terms are identical in functionality and will eliminate all unpurged mail

from your target mailbox. You only need to use one of them, placing it in the the Item

search term field in Aid4Mail. You can either write it in the field directly or use the Assistant

to insert it for you (once the assistant is open, Select > Common search terms > Skip

unpurged mail). 

In Aid4Mail Converter, this process is not necessary as it skips unpurged mail automatically,

as mentioned previously. You don't have to do anything to enable this.
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10.7 Searching personal mail

What is personal mail?

Aid4Mail classifies an email as personal if it meets all three of the following conditions:

1. It is sent from an individual person,

2. It shows no evidence of being part of a campaign, message list or mailing list,

3. It shows no evidence of being a bulk email, advertisement, notification or journaled

email.

For technical details, see How does Aid4Mail determine an email is personal?, below.

Including only personal mail

Aid4Mail Enterprise and Investigator enable you to target personal mail through a simple

search term that uses the Type search operator:

Type:Personal

This search term should be placed in the Item search term field in Aid4Mail. You can either

write it in the field directly or use the Assistant to insert it for you (once the assistant is

open, Select > Email attributes > Type and then select is and Personal from the drop down

lists).

Skipping personal mail

Similarly, you can filter out any personal mail in Aid4Mail Enterprise and Investigator. As

this task is the opposite of including only personal mail, simply negate the search term

above using using the Boolean NOT operator:

NOT Type:Personal

Alternatively, use its more concise version, the minus (-) operator:

-Type:Personal

Both these search terms are identical in functionality and will eliminate all personal mail

from your target mailbox. You only need to use one of them, placing it in the the Item

search term field in Aid4Mail. You can either write it in the field directly or use the Assistant

to insert it for you (once the assistant is open, Select > Email attributes > Type and then

select is not and Personal from the drop down lists).



105

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

How does Aid4Mail determine an email is personal?

Aid4Mail designates an email to be personal if, after scanning its header, all of the

following are all true:

· The Type of the email is not:

o Journaled

o List

o News

o Notification.

· The email is not sent from an impersonal address (for example: postmaster@, mailer-

daemon@, noreply@, no-reply@, etc.)

· The email header does not contain any of following fields:

o Precedence

o X-Campaign

o X-Report-Abuse

· If the email header contains the Auto-Submitted field, its value is not no.

· If the email header contains the Return-Path field, its value is not <>.

· The email header does not contain any of the fields listed in file SMTP-Impersonal.dat

(located in your Data folder). These fields are:

o Bounces-to

o TenantHeader

o X-AMAZON-MAIL-RELAY-TYPE

o X-Bounce

o X-BounceId

o X-Complaints-To

o X-CSA-Complaints

o X-DynectEmail-Msg-Key

o X-elqPod

o X-elqSiteID

o X-EMID

o X-EMV-MemberId

o X-EnvId

o X-ICPINFO

o x-job

o X-LyrisMailingID

o X-MA-Reference
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o X-Mailgun-Sid

o X-Mandrill-User

o X-MarketoID

o X-Match

o X-MC-User

o X-PHP-Originating-Script

o X-PHP-Script

o X-PM-Message-Id

o X-rext

o X-Roving-ID

o X-SFDC-User

o X-SG-EID

o X-SMFBL

o X-SMTPCOM-Tracking-Number

o X-XN-UUID

Note:

1. The lists above are not exhaustive as some of the techniques we use are confidential.

2. The content of file SMTP-Impersonal.dat is a regular expression. As with all files in the

Data folder, you can edit it. This enables you to customize, to a certain extent, how

Aid4Mail determines personal email.
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10.8 Word lists

When a filter requires a lot of search terms, it can be convenient to store them as a list in an

external file. This makes it easier to reuse them later or share them between multiple

sessions. 

WordList modifier

In a folder search term or item search term, use the WordList modifier inside braces to tell

Aid4Mail where to find the file. For example:

{WordList=C:\Temp\Search terms.txt}

This can be a stand-alone search term, as above, or part of a more complex search term:

Subject:{WordList=C:\Temp\Subjects.txt}

It can also be combined with other search terms:

car AND {WordList=C:\Temp\CarModels.txt}

Including those containing other word lists:

{wordlist=C:\Temp\Include.txt} AND NOT {wordlist=C:\Temp\Exclude.txt}

The last example will finds emails that contain any of the search terms listed in file

Include.txt and don't contain any in Exclude.txt.

By default, Aid4Mail will search for any of the search terms in a word list file, i.e. an OR

operator will automatically be applied between the search terms in the file. You can

explicitly tell Aid4Mail to apply an OR operator or an AND operator as follows:

{WordList[OR]=C:\Temp\SearchTerms.txt}

{WordList[AND]=C:\Temp\SearchTerms.txt}

If you have a legacy word list file from Aid4Mail 4, that uses '+' and '-' characters at the

start of each line, you can tell Aid4Mail 5 to process this too using WordList[Mixed] as

follows:

{WordList[Mixed]=C:\Temp\SearchTerms.txt}
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Word list file

Content
A word list file should contain one search term per line. For example:

cat
dog
pet store
fox<.>hen
fred@aid4mail.com
*@aid4mail.com

Aid4Mail will process each search term in the order it appears in the file. The longer the list,

the longer it will take Aid4Mail to filter each email. 

If you're using WordList[OR], or simply WordList, you can improve performance by

placing the most common search terms at the beginning of the list. If you're using

WordList[AND], the most common terms should be placed at the end of the list.

Note that:

· Case sensitivity rules are unchanged. This means that word lists are case-insensitive when

used in folder searches. In item searches, case sensitivity depends on the the Smart case

detection for item search terms option in the Filter section of the Options screen.

· Wildcards (including proximity search wildcards) and regular expressions can be used in

word list search terms, depending on the search term type used.

· Punctuation, search operators and Boolean operators are not supported in word list

search terms.

Search term type
For each line in the word list, you can specify whether it's a normal, wildcard or regular-

expression search term. To do this, prefix the search term with either N=, W= or R=,

respectively. If no prefix is used then it's treated as a wildcard search term if it contains any

wildcard characters (* ? # & ~<>), otherwise it's treated as a normal search term.

For example:

N=cat*
W=cat*
R=cat(.*)
cat*



109

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Searching and filtering

The first line, above, is a normal search term. This means that the asterisk is treated as a

regular character and not as a wildcard or part of a regular expression. This search term will

find the literal word cat* but that's all.

The second line is a wildcard search term. The asterisk character is treated as a * wildcard

that matches zero or more characters. This search term will match the words cat, cats,

catnip, cathartic, etc.

The third line a regular-expression search term. It's actually identical in functionality to the

second line but is specified as a regular expression. (Normally you wouldn't want multiple

search terms with the same functionality so this is just for demonstration purposes.)

The fourth line has no prefix but contains the * wildcard so it is treated as a wildcard search

term, identical to the second line. (Again, normally you wouldn't want multiple, identical

search terms.) If it had not contained a wildcard, it would have been treated as a normal

search term.

Note that the syntax for specifying the search term's type in a word list, as described here,

is a little different to the syntax used directly in a folder search term or item search term

which requires braces and a modifier.
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10.9 Native filtering

Aid4Mail supports the use of native search terms that are sent directly to the mail server

software to carry out a pre-acquisition search server-side. This can significantly increase

performance because Aid4Mail will only download and process emails that match the

search results rather than the whole account. As native search terms can relate not just to

folders but to individual items too, a well-crafted native filter will minimize the number of

individual items that Aid4Mail has to process and maximize performance. 

Note, however, that Aid4Mail's item filter can search deeper than the native filter of most

mail servers and so can find data that they may miss. For example, words in documents that

are nested inside ZIP archive attachments. In such cases, using both native search terms and

item search terms together is the optimal approach. 

Unfortunately each mail service provider can have its own syntax. A brief overview of the

most common, Gmail, Office 365 and IMAP, follows.

Gmail

Gmail's native filter syntax is exactly the same as that used in the Gmail web and mobile

applications. It is similar to Aid4Mail's syntax and to Office 365's KQL. 

Please refer to the Gmail and KQL syntax overview for basic information. For a more

complete reference, visit the Gmail search operators page on the Google website.

Office 365

Office 365 supports two different protocols: KQL and OData. 

KQL
KQL (Keyword Query Language) is the simpler of the two with a syntax similar to both

Aid4Mail and Gmail.

Please refer to the Gmail and KQL syntax overview for basic information. For a more

complete reference, visit the KQL search operators page on Microsoft's website.

OData
OData syntax as used by Office 365 is beyond the scope of this document. However, full

details can be found at the OData protocol page on the OASIS (Organization for the

Advancement of Structured Information Standards) website.

https://www.aid4mail.com/redir/gmail-operators
https://www.aid4mail.com/redir/kql
https://www.aid4mail.com/redir/odata
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To use an OData expression in Aid4Mail, simply prefix it with filter=. This tells Aid4Mail to

interpret the line as an OData expression rather than a KQL expression. For example:

filter=from/emailAddress/address eq 'jane@aid4mail.com'

IMAP

Every IMAP server can potentially have its own proprietary syntax. However there is a

common core that is generally supported by most IMAP servers, containing a standard and

extended syntax. Please refer to the following pages on the Internet Engineering Task Force

(IETF) website for details:

· Standard IMAP search syntax 

· Extended IMAP search syntax

mailto:jane@aid4mail.com
https://www.aid4mail.com/redir/imap-standard
https://www.aid4mail.com/redir/imap-extended
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10.9.1 Gmail and KQL syntax overview

Note that this section is provided only as a light introduction. For detailed information,

please consult the documentation for each mail service in the links below:

· Gmail search operators

· KQL search operators

Search terms

Gmail's native filter syntax and Office 365's KQL are very similar to Aid4Mail's search terms.

They can all be used without search operators to search every part of an email. For

example, to find emails containing the word education you would simply write this in

Aid4Mail's Native search terms field:

education

To find emails with both the words education and conference you would write:

education conference

Note that:

· All search terms must be written in one line.

· Gmail and KQL syntaxes are both case-insensitive. 

Boolean operators

Both Gmail and KQL support the Boolean operators AND, OR and NOT, using the same

syntax as Aid4Mail's Boolean operators. For example, to find emails with both the words

education and conference (as in the example above) you could explicitly use the AND

operator:

education AND conference

As in Aid4Mail's syntax, when no Boolean operator is specified, the AND operator is

automatically used.

To find emails containing either education or conference or both, you would use the OR

operator:

education OR conference

https://www.aid4mail.com/redir/gmail-operators
https://www.aid4mail.com/redir/kql
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To find emails containing education but not conference, you would write:

education AND NOT conference

Note that when using multiple Boolean operators without parentheses, both Aid4Mail and

KQL give precedence to AND operators over OR operators. Gmail does the opposite,

giving OR precedence over AND. Take the following search terms for example:

education AND conference OR test

Aid4Mail and KQL will interpret them as:

(education AND conference) OR test

Gmail will interpret them as:

education AND (conference OR test)

The use of parentheses is recommended to avoid such confusion.

Wildcards

Gmail will find substrings within a larger word. For example, the search term cat will find

the words Cathy and Meercat.

This is not the case for KQL which, like Aid4Mail, requires wildcards to do this. However,

unlike Aid4Mail that supports a variety of wildcards placed anywhere in the search term,

KQL only supports the asterisk (*) wilcard and only at the end of a search term. This means

that in KQL, cat* will find Cathy but *cat will not find Meercat.

Search operators

You can refine your native filter with search operators, many of which are the same as

Aid4Mail's search operators. 

For example, to find emails sent from John to Sally with the word salary in the subject line,

using either Gmail's native syntax or Office 365's KQL, you would write:

from:john to:sally subject:salary
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However, there are differences between Gmail and KQL search operators. For example, to

refine the above search to only include emails sent after June 2019, there would be a

difference in syntax between the two:

from:john to:sally subject:salary after:06/30/2019 (Gmail)

from:john to:sally subject:salary sent>06/30/2019 (KQL)

Note too the difference in the date formatting, both of which are different from the

International date format (2019-06-30) that Aid4Mail uses.

Gmail has many more search operators than KQL and so offers greater flexibility. For

detailed information on the operators available and how they should be used, please refer

to their respective documentation:

· Gmail search operators

· KQL search operators

https://www.aid4mail.com/redir/gmail-operators
https://www.aid4mail.com/redir/kql


115

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Optimizing performance

11 Optimizing performance

Here are some tips for optimizing Aid4Mail’s performance.

Speed up on-premise processing

1. Use a machine with a fast processor and at least four cores. For example, Intel i7, i9 or

better (or their AMD equivalents).

2. Use a dedicated GPU. 

3. Use a fast SSD or RAM drive, at least for cache and temporary files. Avoid NAS drives as

they can significantly diminish processing speed.

4. If your source or target is an Outlook profile, PST, MSG or Exchange, make sure you have

the latest Outlook updates installed.

5. Reboot your computer and close any unnecessary programs, including mail

applications.

6. Disable any anti-virus, file monitoring or file indexing tools that may operate on the

source and target folders.

7. Disable Outlook plugins if you are processing Outlook mailboxes.

8. Disable Windows sleep, hibernation and automatic updates.

Speed up remote processing (for IMAP and cloud-based services)

1. Connect locally using an Ethernet cable rather than Wi-Fi.

2. Ensure your network drivers are up-to-date.

3. Choose a time of day that ensures the highest possible Internet speed.

4. Close any programs or tasks that may reduce the available Internet bandwidth

(streaming services, software updates, offsite file backups, etc).
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5. Avoid migrating mail directly from one remote location to another to reduce the risk of

bottlenecks. Instead, migrate from the remote source location to a local mbox file. Then

migrate the mbox to the remote target location.

Optimize your Aid4Mail settings

1. Whenever possible, prioritize Aid4Mail's 32-bit processing engine over its 64-bit engine.

In general, 32-bit applications are faster than their 64-bit counterparts except for tasks

that involve advanced mathematical modeling. 

2. Unless required, turn off incremental processing and its recording of emails.

3. Use a folder filter to skip any folders you don’t need, or a native filter if supported by

your source mail service.

4. Use an item filter to skip emails based on their header content, message body text and

attachments, in that order.

5. Unless required, avoid searching files contained within attachments.

6. Unless required, avoid searching file metadata.

7. Set the highest reasonable image size limit for metadata searches.

8. Unless required, avoid using Python scripts as they may significantly impact

performance.

Optimize your filters

1. Use a folder filter to exclude folders before individual emails are processed, or a native

filter if supported by your source mail service. Please refer to the Filter order topic for

additional information.

2. Be attentive to the order of search terms:

a. If you have two search terms separated by an AND operator, if the first term is not

found then Aid4Mail doesn’t need to search for the second term. For example, if

you’re searching for cat AND dog, and cat is not found then Aid4Mail doesn’t need
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to search for dog. To optimize performance when you’re using an AND operator, put

the search term that’s least likely to be found on the left side of the statement.

b. If you have two search terms separated by an OR operator, if the first term is found

then Aid4Mail doesn’t need to search for the second term. For example, if you’re

searching for ham OR cheese, and ham has been found then Aid4Mail doesn’t need

to search for cheese. To optimize performance when you’re using an OR operator, put

the search term that’s most likely to be found on the left side of the statement.

c. If you have search terms to eliminate duplicates (NOT Is:Duplicate) or to eliminate

unpurged mail (NOT Is:Unpurged), place them before any other search terms. As

Aid4Mail searches for each term in the order it appears, this will greatly reduce the

number of emails processed.

d. Place search terms that scan attachments or metadata, notably those that use the

FileText or FileMetadata operators, after other search terms. Then scanning of these

potentially large files is done last and on the smallest number of emails.

3. Use the search term Is:Personal to eliminate bulk and automated mail, newsletters

and mailing lists, bounced emails and any other non-personal items from your target

mail. Please refer to the Searching personal mail topic for details.
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12 Activating your Aid4Mail license

Once you have purchased Aid4Mail, you will be sent an activation code or key file by email.

This section provides step-by-step instructions on how to:

· Activating with an activation code

· Activating with a key file
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12.1 Activating with an activation code

1. Open the Activate license screen. This can be done in 3 different ways:

a. When you run Aid4Mail for the first time, you will see the Start screen. Select Activate

under the License Activation heading as shown below:

"Activate" button on the Start screen

The Activate license screen will then appear: 
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Activate license screen when opened from the Start screen

b. When you run Aid4Mail and have previously been using a trial license or the

Converter Light edition, you will be presented with the following screen. Select

Choose another license:
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"Choose another license" button

The Start screen will then appear and you can follow the instructions in a. above,

selecting Activate under License Activation.

c. If Aid4Mail is already running, you can open the Activate license screen by selecting

File > Activate license from the menu.

File > Activate license
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When opened from here, the Activate license screen looks different but contains the

same fields:

Activate license screen when opened from the File menu

2. On the Activate license screen, enter the activation code you were sent by email into the

Activation code field.

3. Create a new password and enter it in the Password field. If you are re-activating

Aid4Mail, note that the password you create must be different to all the passwords you

have previously used with this activation code.

4. Select Activate.

Once you have activated Aid4Mail, you shouldn’t have to do it again until your license

expires. Aid4Mail will remember your activation details and, next time, will open with the

Settings screen displayed.
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12.2 Activating with a key file

1. Upon receiving your Aid4Mail key file, save it to your computer's hard drive in any

location.

2. In Aid4Mail, from select File > Import license key from the main menu:

File > Import license key

3. In the Open file dialog, browse for and select the key file from step 1 and then select

Open. The key file will be installed automatically.

Once you have activated Aid4Mail, you shouldn’t have to do it again until your license

expires. Aid4Mail will remember your activation details and, next time, will open with the

Settings screen displayed.
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13 User interface

Aid4Mail’s main user interface is comprised of 5 main elements that can be seen in the

screenshot below:

· Menu

· Button bar

· Session list

· Session information

· Task bar

When you run Aid4Mail for the first time, the session list is closed by default. It can be

opened and closed by selecting View > Show/Hide session list from the menu or

Show/Hide session list in the task bar.

This section also contains information on user interface components that are not

immediately visible but available in certain situations:

· Project settings

· Options

· Activate license

· Aid4Mail Authenticator

· Aid4Mail Remote Authenticator

· IMAP Configuration Editor

· Keyboard shortcuts
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Aid4Mail user interface
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13.1 Menu

Aid4Mail’s main menu is found at the top-left of the window:

Menu

The menu contains 5 items:

· File menu

· View menu

· Session menu

· Settings menu

· Tools menu

· Help menu
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13.1.1 File menu

New project
Create a new project with one new session. The new session will have default values except

for the following fields which will be blank:

· Source Format 

· Source Location or Email address or IMAP account (depending on the selected source

format)

· Target Format 

· Target Location or Email address or IMAP account (depending on the selected source

format)

Open project
Open an existing project using the Windows Open dialog. Browse to your chosen project

file (with extension .project.ini) in the dialog and then select Open.

Recent projects
Open a recent project by selecting it in the list or select Clear list to empty it.

Change Aid4Mail edition
Try a different Aid4Mail edition by selecting it from the submenu. The selected edition will

run in trial mode unless you have purchased a license and activated that edition, or you

selected the free version with limited features (Aid4Mail Converter Light). 

Activate license
Open the Activate license screen for activating Aid4Mail with an activation code. Please

follow the instructions in Activating with an activation code.

Import license key
Open the Windows Open dialog to allow you to select a license key file. Please follow the

instructions in Activating with a key file.

Exit
Exit the application.
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13.1.2 View menu

Show/Hide session list
Show or hide the session list. When the session list is visible, additional options appear in

the button bar and session menu. Please refer to the Multiple sessions topic for details.

Navigate backward
Navigate backwards through recently viewed screens.

Navigate forward
Navigate forwards through recently viewed screens.

Zoom out
Progressively zoom out the user interface until it reaches 100%.

Zoom in
Progressively zoom in the user interface to a maximum of 150%.
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13.1.3 Session menu

Add
Only available when the session list is open.

Add a new session with default values except for the following fields which are blank:

· Source Format 

· Source Location or Email address or IMAP account (depending on the selected source

format)

· Target Format 

· Target Location or Email address or IMAP account (depending on the selected source

format)

Duplicate
Only available when the session list is open.

Create a new session with identical settings (except for the session name) to the currently

selected session. The new session will be created directly below the one it's duplicating in

the session list and will become the new selected session. 

With certain source formats, you can use wildcards in the source file or folder name to

create multiple duplicate sessions at the same time. For more information, please refer to

the Duplicating sessions topic.

Delete
Only available when the session list is open.

Delete the currently selected session from the project. If there’s only one session then it

cannot be deleted, only Reset.

Reset
Reset the currently selected session’s settings (except for Session name) to their default

values.

Run
Run the currently selected session. If the session is paused then selecting Run will resume

processing from that point. Otherwise processing will start at the beginning.
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Pause
Pause the currently selected session. Processing will be temporarily halted but can be

resumed again, from the same point, by selecting Run.

Stop
Stop the currently selected session. Processing cannot be resumed after a stop. Selecting

Run after a session has been stopped will start processing from the beginning again.

Run all
Only available in Aid4Mail Enterprise and Investigator when the session list is open.

Run all the sessions in the project.

Pause all
Only available in Aid4Mail Enterprise and Investigator when the session list is open.

Pause all sessions in the project.

Stop all
Only available in Aid4Mail Enterprise and Investigator when the session list is open.

Stop all the sessions in the project.

Select
Select a session in the session list. The options are:

· Previous

Select the previous session in the list (unless the first session is selected).

· Next

Select the next session in the list (unless the last session is selected).

· By index

Select a session by entering its index in the session list into the dialog.

Move
Only available when the session list is open.
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Move the currently selected session to a different position in the session list. This will

change its index in the list and the indices of any other sessions affected by the move.

However, the names of the sessions will not be affected. 

The options for this menu command are:

· Up

Move the currently selected session up the list by one position (unless it's already the first

session).

· Down

Move the currently selected session down the list by one position (unless it's already the

last session).

· To top

Move the currently selected session to the top of the list (unless it's already the first

session).

· To bottom

Move the currently selected session to the bottom of the list (unless it's already the last

session).
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13.1.4 Settings menu

Options
Open the Options screen.

Project
Open the Project settings screen.

Proxy
Open the HTTP or IMAP proxy settings screen.
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13.1.5 Tools menu

Clear cache
Delete temporary cache files created by Aid4Mail:

· Index data

Index files created by Aid4Mail to increase efficiency for operations that share the same

source mail.

· Incremental data

A log of every email processed by this session. Used by the Incremental processing

feature.

· All data

Both index data and incremental data.

Fix Registry for MAPI
Updates the Windows registry with Outlook information that may be missing. This is useful

to do if:

· You installed Outlook after installing Aid4Mail.

· You installed Aid4Mail on a USB drive.

· Errors occurred when running Aid4Mail with Outlook profile, PST file or MSG file as the

source or target format (or both).
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13.1.6 Help menu

Check for updates
Check whether a new Aid4Mail update is available.

View help
Open the Aid4Mail Help Manual in a separate window.

Aid4Mail website
Open the Aid4Mail website in your browser.

About Aid4Mail
Open a dialog with information about this Aid4Mail version.

https://www.aid4mail.com/redir/aid4mail-v5
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13.2 Button bar

The Button bar is a blue strip at the left of the Aid4Mail window, containing shortcuts to

commands in the View, Session and Settings menus.

Button bar
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< > Navigation
Select the next or previous session in the session list.

Add
Same functionality as the Add command under the Session menu.

Duplicate
Same functionality as the Duplicate command under the Session menu.

Delete
Same functionality as the Delete command under the Session menu.

Run
Same functionality as the Run command under the Session menu.

Pause
Same functionality as the Pause command under the Session menu.

Stop
Same functionality as the Stop command under the Session menu.

Run all
Same functionality as the Run all command under the Session menu.

Pause all
Same functionality as the Pause all command under the Session menu.

Stop all
Same functionality as the Stop all command under the Session menu.

Project
Same functionality as the Project command under the Settings menu.

Options
Same functionality as the Options command under the Settings menu.
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13.3 Session list

The Session list is an ordered list containing all sessions that have been set up in the current

project, as shown below:

Session list with 3 sessions

Opening and closing the session list

When you run Aid4Mail for the very first time, the session list is closed by default. It can be

opened and closed by selecting View > Show/Hide session list from the menu or

Show/Hide session list in the task bar.

When the session list is open, additional commands appear in the session menu and button

bar, enabling you to add a new session, duplicate an existing one, delete or reset it and

move sessions around. In Aid4Mail Enterprise and Investigator, options to run all, pause all

and stop all sessions also become available.

Selecting a session

Selecting a session in the list makes its session information available for editing. Only one

session can be selected at a time and the selected session will display a blue strip at the

right as shown in the image above.
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What's in a session list entry?

Each entry in the session list contains 3 parts:

The 3 parts of a session list entry

1. Index of the session in the list. This can also be thought of as the row number because

the first session's index will always be 1, the second session's index will always be 2. As

sessions are moved around the session list, their indices will change to maintain

numerical order (but their names will not change).

2. Session information overview containing the session name, source and target formats,

and whether or not a filter has been set.

3. Progress overview containing the session’s status, and progress as a percentage.
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13.4 Session information

This part of the user interface contains the following information about the currently

selected session:

· Settings

· Progress

· Progress Log

· Error Log
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Session information
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13.4.1 Session settings

The session Settings screen consists of the Session name followed by 3 collapsible sections:

1. Source

2. Target

3. Filter

Settings screen before configuration

Session name (required)
The name of the selected session. Initially this will show a default name. We recommend

you change it to something you can easily identify.

Example: John Doe’s email is spread across 3 different source formats which all need to be

converted to PDF. One approach would be to set up 3 different sessions, one for each

format: The first to convert his Outlook mail, the second for his web mail and the third for

his Thunderbird files. Descriptive session names might be:

1. John Doe - Outlook

2. John Doe - Webmail
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3. John Doe - Thunderbird

Note that the session name is also used to name the settings file and log files for this

session and so must not contain any illegal characters.
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13.4.1.1 Session settings: Source

The Source section of the Settings screen contains required and optional settings related to

your chosen source format. The fields displayed depend on the value chosen in the Format

field.

Source settings

Format (required)
The email format that Aid4Mail will be reading and importing from. Please refer to the full

list of supported source formats.

Some mail files correspond to more than one source format. We recommend you always

select the most specific option when faced with a choice. 

For example, Thunderbird mailboxes are also mbox files but with additional status

information in the headers. If you select Thunderbird as your source format, Aid4Mail knows

it must read the status information which would be lost if you select Mbox. 

Similarly, if you your mbox files come from Google Vault, select Google Vault as the source

format to obtain optimal results. Google Vault adds label information to the mbox files

which will be lost if you select Mbox. When you select Google Vault, Aid4Mail knows it must

read the proprietary label information to correctly understand the folder structure.

Process using Outlook
Only available when your source format is PST file or MSG files.
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When turned On, Aid4Mail will use Microsoft Outlook's engine to access your source file(s).

This is the recommended option but requires you to have a copy of Outlook installed on

the same computer as Aid4Mail.

When turned Off, Aid4Mail will access the source file(s) without using Outlook. It does not

require Outlook to be installed on the computer. However, some metadata in the email

header, like status information, may not be accessible.

Please refer to Choosing the right format: PST and MSG for additional information.

Files downloaded from Mimecast server
Only available if your source format is Mimecast.

Mimecast archives are delivered in two different formats:

1. A collection of ZIP files downloaded from a Mimecast FTP server with all accounts

mixed together.

2. Files organized in folders for each account on an external hard drive.

If you obtained your Mimecast export from a Mimecast FTP server (#1 above) then select

this option. It pre-fills many of your target settings to split your Mimecast archives into

multiple EML folders, organized per account. Aid4Mail is possibly the only software on the

market that's able to do this and it's a huge time saver. Once you've run this conversion, you

can then do a second conversion to convert the EML folders to whichever target format you

require.

Location
Only available if your source format is MSG, EML, mbox, Thunderbird, SeaMonkey, Maildir,

Google Takeout, Google Vault, Mimecast or Proofpoint.

The folder or file location on the drive where the source email file(s) are located. You can

write the location directly in the field or use Select to browse for a location. 

If your chosen source format is Thunderbird then you can also use Find to automatically

locate Thunderbird's mail directory.

With certain source formats, you can use wildcards in this field to create multiple duplicate

sessions at the same time. For more information, please refer to the Duplicating sessions

topic.
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Password
Only available if your source format is Proofpoint.

The password for the Proofpoint ZIP archive that's specified in the Location field.

Email address
Only available if your source format is Gmail or Outlook 365.

Select the email address of the source mail account from the list. If it is not yet in the list,

you can use Add to launch Aid4Mail Authenticator and add the account. Alternatively, you

can Import an existing authentication token (that was created using Aid4Mail Remote

Authenticator).

Use login credentials to access another account as a delegate
Only available if your source format is Gmail or Outlook 365.

A delegate is an email account that has been authorized to access another account (the

delegator's account). If the Email address field refers to a delegate account, turn this

option on and enter the email address of the delegator's account it has access to.

Profile
Only available if your source format is Outlook profile.

Select which profile you want Aid4Mail to process. The list will automatically be filled with

all Outlook profiles available on the computer that Aid4Mail is being run on. 

[Default] is the profile that is designated as the default in Outlook. It is the same as one

of the other profiles in the list. Choose this option if you want to process the default profile,

no matter which one it is set to. Otherwise, select a specific profile from the list.

Use Reload to tell Aid4Mail to regenerate the list of profiles provided by Outlook. This is

useful if a profile has been added or removed in Outlook since Aid4Mail was last opened

or, as can occasionally happen, you notice that Outlook has not provided all of its profiles

in the list. 

Store
Only available if your source format is Outlook profile.

Select which message store you want Aid4Mail to process. The list will automatically be

filled with all Outlook stores available for your chosen profile.
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[Default] is the store that is designated as the default in Outlook for your chosen profile.

It is the same as one of the other stores in the list. Choose this option if you want to process

the default store, no matter which one it is set to. Otherwise, select a specific store from the

list.

Use Reload to tell Aid4Mail to regenerate the list of stores provided by Outlook. This is

useful if a store has been added or removed in Outlook since Aid4Mail was last opened or,

as can occasionally happen, you notice that Outlook has not provided all of its stores in the

list. 

PST file
Only available if your source format is PST file.

The location of the PST file on your drive. You can write the location directly in the field or

use Select to browse for a location. If the PST file is password-protected, use the Password

button to enter it.

Note that Aid4Mail can only process one source PST file per session. To process multiple

PST files, you will need to you will need to set up multiple sessions (one for each PST file).

You can use wildcards in the PST file field to create multiple duplicate sessions, one for

each PST, as shown in Duplicate sessions: Example 1.

IMAP account
Only available if your source format is IMAP.

Select an IMAP account from the list, Edit it if necessary or Add a new account to the list.

Edit and Add both launch the IMAP Configuration Editor. You can also Import existing IMAP

settings from an .imap.ini file.

Access email located outside your personal mailbox (e.g. shared mailboxes)
Only available if your source format is IMAP.

Select this option to allow Aid4Mail to access any shared mailboxes (or other mailboxes

outside the direct scope of your personal mailbox) associated with this account.

Remove journaling envelope
A journaled email includes additional metadata along with the email message. When this

option is on, Aid4Mail will remove this additional data from any journaled emails that are

processed.
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Automatically record each email to allow incremental processing
When on, Aid4Mail will keep a log of every email that has been processed. This option is on

by default to allow for data recovery in the event of a failure. However, logging every

email processed has an impact on performance. If you need Aid4Mail to run faster, try

turning this option off.

Incremental processing
Only available if Automatically record email email to allow incremental processing is

turned on. 

When incremental processing is on, Aid4Mail will ignore any emails in the source Location

that were already processed during a previous run of this same session (i.e. emails. that

appear in the log created by the Automatically record email email to allow incremental

processing). This allows you to resume processing where you left off if a session is stopped

or fails for any reason, or for processing large mailboxes in small increments.
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13.4.1.2 Session settings: Target

The Target section of the Settings screen contains optional settings related to your chosen

target format. The fields displayed depend on the value chosen in the Format field.

Target settings

Format (required)
The email format that Aid4Mail will be creating and exporting to. Please refer to the full

list of supported target formats.

Process using Outlook
Only available when your target format is PST file or MSG files.

When turned On, Aid4Mail will use Microsoft Outlook's engine to create your target file(s).

This is the recommended option but requires you to have a copy of Outlook installed on

the same computer as Aid4Mail.
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When turned Off, Aid4Mail will create the target file(s) without using Outlook. It does not

require Outlook to be installed on the computer. However, some metadata in the email

header, like status information, may be missing.

Please refer to Choosing the right format: PST and MSG for additional information.

Email address
Only available in Aid4Mail Enterprise when your target format is Gmail or Outlook 365.

Select the email address of the target mail account from the list. If it is not yet in the list,

you can use the Add to launch Aid4Mail Authenticator and add the account. Alternatively,

you can Import an existing authentication token (that was created using Aid4Mail Remote

Authenticator).

Use login credentials to access another account as a delegate
Only available in Aid4Mail Enterprise when your target format is Gmail or Outlook 365.

A delegate is an email account that has been authorized to access another account (the

delegator's account). If the Email address field refers to a delegate account, turn this

option on and enter the email address of the delegator's account it has access to.

Profile
Only available in Aid4Mail Enterprise when your target format is Outlook profile.

Select a profile to receive your target mail. The list will automatically be filled with all

Outlook profiles available on the computer that Aid4Mail is being run on. 

[Default] is the profile that is designated as the default in Outlook. It is the same as one

of the other profiles in the list. Choose this option if you want to use the default profile, no

matter which one it is set to. Otherwise, select a specific profile from the list.

Store
Only available in Aid4Mail Enterprise when your target format is Outlook profile.

Select which message store you want to receive your target mail. The list will automatically

be filled with all Outlook stores available for your chosen profile.

[Default] is the store that is designated as the default in Outlook for your chosen profile.

It is the same as one of the other stores in the list. Choose this option if you want to use the

default store, no matter which one it is set to. Otherwise, select a specific store from the list.
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PST file
Only available when your target format is PST file.

The location of the PST file on your drive. You can write the location directly in the field or

use Select to browse for a location. If you want the PST file to be password-protected, use

the Password button to enter it.

Location in PST file
Only available when your target format is PST file.

The base folder location inside a PST file where Aid4Mail will create your target emails

and/or non-email items. 

IMAP account
Only available in Aid4Mail Enterprise when your target format is IMAP.

Select an IMAP account from the list, Edit it if necessary or Add a new account to the list.

Edit and Add both launch the IMAP Configuration Editor. You can also Import existing IMAP

settings from an .imap.ini file.

Access email located outside your personal mailbox (e.g. shared mailboxes)
Only available in Aid4Mail Enterprise when your target format is IMAP.

Select this option to allow Aid4Mail to access any shared mailboxes (or other mailboxes

outside the direct scope of your personal mailbox) associated with this account.

Location
The location where Aid4Mail will create your target emails and/or non-email items. 

If your target format is MSG, EML, HTML, PDF or XML, this will be a folder location on your

drive.

If your target format is mbox, Thunderbird, SeaMonkey, Plain text, CSV or TSV, this will be a

folder or file location on your drive.

If your target format is Outlook profile, Gmail or IMAP, will this be a folder location inside

the mail store.
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You can write the location directly in the field or, depending on your target format, use

Select to browse for a drive location. If your chosen target format is Thunderbird then you

can also use Find to automatically locate Thunderbird's mail directory.

Export to a single mbox/mailbox/PDF/text file
Only available when your target format is Mbox files, Thunderbird, Seamonkey, PDF or Plain

text.

When turned On, all emails processed in the session will be placed in the same target file.

When Off, each email will be placed in a separate file.

Folder structure
Determine how Aid4Mail creates the target folder structure. Available options are:

· Same as source folder structure

The target folder structure will be exactly the same as the source folder structure, as

shown in the image below. This option is selected by default.

Folder structure: Same as source folder structure

· Merge all emails into the target folder

All target emails will be placed at the same level in the target Location. This includes

emails that were in subfolders in the source. This means that any folder hierarchy will be

lost although the emails themselves will not be lost.
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Folder structure: Merge all emails into the target folder

· Merge all emails into the top-level folders

All target emails will be placed into the top-level folder(s) of the source folder structure,

under the target Location. This means that part of the folder hierarchy may be lost

although the emails themselves will not be lost.

Folder structure: Merge all emails into the top-level folders

· Use X-Folder metadata

Only available in Aid4Mail Enterprise and Investigator.

The folder structure will be read from the email’s X-Folder header field, if it exists. The X-

Folder field is a proprietary header field that contains an email’s original folder structure

and is added to the email header when Add extra metadata to headers is turned on.
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· Use a template

Define a template that will be applied to the target folder structure.

Folder structure template
Only available when Use a template is selected in the Folder structure drop-down list.

Enter your folder structure template in this field. You can use the Insert button above the

field to insert template tokens. Please refer to the Folder structure templates topic for

details of how to create a template.

File name
Only available when your target format is MSG, EML, PDF, HTML, Plain text or XML. 

Determine how Aid4Mail will name each of your target email files. Available options are:

· Same as source file names

Each target file will have the same name as its corresponding source file.

· Use MD5 signatures

Each target filename will be based on an MD5 signature created from the content of the

email. This has many benefits, notably that it guarantees all names are unique, of equal

length and not too long, and don’t contain any illegal characters. A great option for

saving to external media.

· Use SHA-1 signature

The same as the MD5 option except it uses an SHA-1 signature instead of MD5.

· Use FNV-1a signature

The same as the MD5 option except it uses a 64-bit FNV-1a signature instead of MD5.

· Use email UID value

Every email has a unique ID associated with it. With this option, an email's ID will be used

for the filename.

· Use a template

Define a template that will be used for the target filenames.

Note: For the options that use signatures, the exact method used depends on the Generate

hash value from option, under the Session section of the Options screen.
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File name template
Only available when Use a template is selected in the File name drop-down list. 

Enter your filename template in this field. You can use the Insert button above the field to

insert template tokens. Please refer to the Filename templates topic for details of how to

create a template.

Email header configuration
Only available when your target format is HTML, PDF or Plain text.

Select a configuration file to specify the email header fields to appear in each target email.

Alternatively, create a new configuration file or import an existing one. You can edit any of

them. If you don't select anything, an internal default configuration (called {Default}) will be

used. The default configuration cannot be edited.

New configuration files are saved directly in the Templates/Fields subfolder of your

application data folder. Importing an existing file makes a copy of it in this folder. The

original will not be moved or deleted. 

If you edit an imported configuration file, modifications are only made to the copy. The

original will not be altered. Likewise, if you edit one of Aid4Mail's built-in configuration

files, you are editing a copy that's also stored in the Templates/Fields subfolder of your

application data folder. It won't affect the original that is safely intact in the

Templates/Fields subfolder of your program folder.

The built-in configuration files for HTML and PDF are:

· Append full header

The same as Email with basic header but with the full email header added to the end of

the email. The full header contains all fields present in the source email.

· Email with basic header

A basic email header containing just the essential fields, followed by the email body.

Attachments are extracted and deduplicated to a separate folder.

· Email with reduced header

The full header minus non-standard or unimportant SMTP fields, followed by the email

body. Attachments are extracted and deduplicated to a separate folder.

Column configuration
Only available when your target format is CSV or TSV.
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Select a configuration file to specify the columns to appear in each target CSV/TSV file.

Alternatively, create a new configuration file or import an existing one. You can edit any of

them. If you don't select anything, an internal default configuration (called {Default}) will be

used. The default configuration cannot be edited. 

New configuration files are saved directly in the Templates/Fields subfolder of your

application data folder. Importing an existing file makes a copy of it in this folder. The

original will not be moved or deleted. 

If you edit an imported configuration file, modifications are only made to the copy. The

original will not be altered. Likewise, if you edit one of Aid4Mail's built-in configuration

files, you are editing a copy that's also stored in the Templates/Fields subfolder of your

application data folder. It won't affect the original that is safely intact in the

Templates/Fields subfolder of your program folder.

Content configuration
Only available when your target format is XML.

Select a configuration file to specify the content of each target XML file.  Alternatively,

create a new configuration file or import an existing one. You can edit any of them. If you

don't select anything, an internal default configuration (called {Default}) will be used. The

default configuration cannot be edited. 

New configuration files are saved directly in the Templates/Fields subfolder of your

application data folder. Importing an existing file makes a copy of it in this folder. The

original will not be moved or deleted. 

If you edit an imported configuration file, modifications are only made to the copy. The

original will not be altered. Likewise, if you edit one of Aid4Mail's built-in configuration

files, you are editing a copy that's also stored in the Templates/Fields subfolder of your

application data folder. It won't affect the original that is safely intact in the

Templates/Fields subfolder of your program folder.

Python modifier script
Only available in Aid4Mail Enterprise and Investigator.

Use a Python script to customize the target email content or its folder or filename. You can

select a script from the drop-down list and use Open if you need to view or edit it. You can

also Add a script to the library to make it available in the list. For further information please

refer to the Python modifier scripts topic.
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Limit PST file size
Only available when your target format is PST file.

Select a size from the drop-down list if you want your target mail to be placed in multiple

PST files, each with a fixed file size, instead of one larger PST file. For example, if you have

17 GB of mail and Limit PST file size is set to 5 GB, you will end up with four target PST files:

The first three will each contain 5 GB of mail with the fourth containing the remaining 2 GB.

The first PST file will have the filename that is set in PST file. The remaining files will have

the same name but suffixed with an index. Using the example above, if PST file is set to

Target.pst then Aid4Mail would produce the following four files:

· Target.pst (5 GB)

· Target[001].pst (5 GB)

· Target[002].pst (5 GB)

· Target[003].pst (2 GB)

Note that:

· The PST files may slightly exceed the selected size limit. This is because Outlook uses a

data cache, adding data to the PST file after Aid4Mail has finished exporting to it. If your

size limit must not be exceeded under any circumstances, it is recommended to select a

smaller value.

· The Based on registry option uses the PST file size limit defined in the Windows registry. If

no value is defined, it will use the maximum PST size recommended by Microsoft for the

version of Outlook being used:

o 50 GB for Outlook 2019, 2016, 2013 and 2010

o 20 GB for Outlook 2007 and 2003

o 2 GB for earlier versions

For more information, please refer to How to configure the size limit for both (.pst) and

(.ost) files in Outlook on Microsoft's website. 

· When multiple sessions share the same target PST file, and the Limit PST file size option is

used, Aid4Mail will only run one session at a time regardless of the value set in Maximum

sessions running concurrently. This is because each session is independent and can only

control a PST file's size when it is the only session accessing it.

· The default value for the Limit PST file size option is No limit.

https://www.aid4mail.com/redir/pst-size-limit
https://www.aid4mail.com/redir/pst-size-limit
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Create HTML index file
Only available when your target Format is HTML.

When on, Aid4Mail will create an index for your target HTML files. The index acts as a web

viewer, containing a list of all target emails created by the session. The list can be sorted

and filtered by keywords to locate specific messages. Any email selected in the list will be

displayed in the lower half of the page, allowing you to view and examine it.

The index file, index.html, is located in the target location. Simply double-click it to open it

in your web browser.

Append messages to target mailbox if it already exists
Only available when your target format is PST file, mbox, Thunderbird, SeaMonkey, HTML,

Plain text, CSV, TSV or XML. 

When this option is turned on and Aid4Mail encounters a file that already exists at the

target location, it will add the target emails to the end of the existing file. When this option

is turned off, Aid4Mail will make a back-up copy of any existing file and create a new file at

the target location for the target emails.

Add extra metadata to headers
When on, Aid4Mail will add additional metadata to each email’s message header. When

off, no additional metadata is added. For details, please refer to the Adding header

metadata topic.
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13.4.1.3 Session settings: Filter

The Filter section of the Settings screen contains options for searching and filtering folders,

emails and non-email items. 

Aid4Mail Converter is limited to searching and filtering folders. Aid4Mail Enterprise and

Investigator extend this capability to individual emails, non-email items and attachments

(and any files they contain). They also support both server-side and local searches as well

as wildcards, regular expressions and Python scripts. Please refer to the substantial

Searching and filtering topic, and its numerous sub-topics, for further detailed information.

Filter settings
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Note that, in trial mode, Aid4Mail works on modified copies of your mail which may, in

turn, impact your filter results. For more details see the Trial mode topic.

Filters are applied in the order they appear on this screen. 

1. Folder or native filter (or simply Folder filter if no native option is available).

2. Item filter.

3. Python script.

Folder or native filter

The folder filter and, if available, native filter are executed before any emails (or non-email

items) have been read by Aid4Mail. This allows you to cull down the data that Aid4Mail

will process and significantly increase performance. You cannot have both a folder filter

and a native filter so can only use one of the following options:

· Process all folders

· Select in folder tree

· Folder search terms

· Native search terms

Note that only certain cloud-based mail services have the ability to perform a native

search. If your selected mail source format is not one of these then the Native search terms

option will not be displayed and the heading for this section will simply be Folder filter.

Include hidden folders
Only available in Aid4Mail Enterprise and Investigator when your source format is PST file,

OST file or Outlook profile.

In some Outlook mail stores, the visible folder tree is only a subset of a larger structure.

There are a number of hidden folders that may be of interest in forensic examinations. They

can contain deleted data, previous versions of email drafts and other potentially useful

information. Turning this option on includes these hidden folders. Turning it off excludes

them.

Note that this option can also be affected by the Process using Outlook option. When the

latter is on, there are usually more hidden folders made available than when it's off. 

Process all folders
No folder filter or native filter. All folders will be processed.
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Select in folder tree
From the folder tree, select the folders that you want to process. Aid4Mail will only read

items in the selected folders. Items in non-selected folders will automatically be excluded.

Note that selecting a parent folder selects all the folders underneath it. Likewise for

deselection. You can override this behavior by pressing the Ctrl key while selecting folders.

Selecting/deselecting a folder with no children only affects that folder.

Above this field, are options to Reload the folder tree and Export it to a text file.

Folder search terms
Only available in Aid4Mail Enterprise and Investigator.

Specify search terms to determine which folders to include or exclude. Aid4Mail will only

read items in the folders that result from the search. Items in other folders will

automatically be excluded. Whenever possible, Aid4Mail will apply the folder filter server-

side (like a native filter) to further optimize the process.

As an example, if you know that the only emails you need to find are in the Vacation folder,

you can specify vacation as your folder search term and only that folder will be processed

by Aid4Mail. All other folders will be ignored. 

Folder search terms

Note that folder search terms are always case-insensitive.

You can write your search terms directly in the search field. Select Clear if you need to start

over. Alternatively, select Open assistant to use the search assistant. The assistant helps you

create search terms that use a search operator by laying out the fields you need to fill in.

Below is an example using the FolderName search operator:
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Using the Search assistant to construct a folder search term with the FolderName

operator

Once you have finished creating your search terms, you can check that they are syntactically

correct by selecting Validate. A validation message will appear below your search terms.

Clicking on your search terms will clear this message. If your search terms are not

syntactically valid, the message will be red and will indicate errors. If your search terms are

valid, the message will be green and will indicate (using parentheses) how your search

terms will be interpreted by Aid4Mail. In this case, double-clicking the validation message

will replace your search terms with the validated version.

Native search terms
Only available in Aid4Mail Enterprise and Investigator when your source format is Gmail,

Outlook 365 or IMAP.

The native filter in Aid4Mail Enterprise and Investigator enables a complete pre-acquisition

search to be carried out server-side. This can significantly increase performance because

Aid4Mail will only download and process emails that match the search results rather than

the whole account. As the native search terms can relate not just to folders but to individual

items too, a well-crafted native filter will minimize the number of individual items that

Aid4Mail has to process and maximize performance. 

Note, however, that Aid4Mail's item filter can search deeper than the native filter of most

mail servers and so can find data that they may miss. For example, words in documents that

are nested inside ZIP archive attachments. In such cases, using both a native filter and an

item filter is the optimal approach.

In the Native search terms box, specify the search terms to be sent to the mail server as a

native filter. Aid4Mail will then process the mail that results from this search. The search

terms must use the service provider's syntax which can be different from one system to

another. For an overview of the most common server syntaxes, Gmail, Office 365 and IMAP,

please refer to the Native filter syntax topic.
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Item filter

Only available in Aid4Mail Enterprise and Investigator.

The item filter is executed after the Folder or native filter, while the source mail is being

read and before exporting to the target format. This filter is for individual email messages

or non-email items (calendars, contacts, etc) whose content matches the search terms you

specify. Select between the following options:

· Process all items

· Skip items

· Item search terms

You can also adjust Attachment options in this section.

Process all items
No item filter. All items will be processed.

Skip items
Use this section if the only item filtering you require is to skip duplicates and/or unpurged

mail. Select one or both or neither of the two options:

· Skip duplicates

· Skip unpurged mail

Note that if you select either of these options and then try to add Item search terms, these

skip options will be lost. The solution in this scenario is to use item search terms and

incorporate NOT Type:Duplicate and/or NOT Type:Unpurged as appropriate. See the

Deduplication and Searching unpurged mail topics for details.

Item search terms
Specify search terms to tell Aid4Mail which email items (messages) or non-email items

(calendars, contacts, etc) to include or exclude.

Case sensitivity depends on whether Smart case detection for item search terms, on the

Filter section of the Options screen, is turned on or off. By default this option is off and item

searches are case-insensitive.

You can write your search terms directly in the search field. Select Clear if you need to start

over. Alternatively, select Open assistant to use the search assistant. The assistant helps you
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create search terms that use a search operator by laying out the fields you need to fill in.

Below is an example using the NewerThan search operator:

Using the Search assistant to construct an item search term with the NewerThan

operator

Once you have finished creating your search terms, you can check that they are syntactically

correct by selecting Validate. A validation message will appear below your search terms.

Clicking on your search terms will clear this message. If your search terms are not

syntactically valid, the message will be red and will indicate errors. If your search terms are

valid, the message will be green and will indicate (using parentheses) how your search

terms will be interpreted by Aid4Mail. In this case, double-clicking the validation message

will replace your search terms with the validated version.

Attachment options
By default, Aid4Mail searches the message header and body of each email when looking

for Item search terms. This scope can be extended to include attachments, files contained

within attachments and file metadata, depending on the settings in this section. Most

common file types are supported.

Attachment options

· Search text in attachments and image Exif/IPTC/XMP metadata 

When on, Aid4Mail will search attachments but not necessarily the files contained within

them (see Include files contained in attachments). It will also search EXIF, IPTC and XMP

metadata stored in attached or embedded JPEG, TIFF and PSD images. This option is on

by default. Turn it off for faster processing if you don’t need this functionality.
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· Include files contained in attachments

Only available if Search text in attachments and image Exif/IPTC/XMP metadata has been

selected. When this option is on, Aid4Mail will not only search attachments but also any

files contained within attachments. For example, with this option activated, Aid4Mail will

be able to find a word located in a PDF file that is contained within a ZIP archive, which is

attached to an email that is also an attachment to an email. This option is on by default.

Turn it off for faster processing if you don’t need your search to run so deep.

· Include metadata for file types lacking searchable text (slower)

Only available if Search text in attachments and image Exif/IPTC/XMP metadata has been

selected. When this option is on, metadata will be extracted from a wide range of image,

audio and video file formats. The metadata is then searched by Aid4Mail. This option is

off by default as it is processor intensive. Turning it on may significantly increase

processing time.

Python script

Only available in Aid4Mail Enterprise and Investigator.

Use a Python script to determine whether the email currently being processed should be

kept or discarded. You can select a script from the drop-down list and use Open if you need

to view or edit it. You can also Add a script to the library to make it available in the list. For

detailed information, please refer to the Python filter scripts topic.
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13.4.2 Progress

Progress statistics for the currently selected session.

Progress screen

Total Progress

Progress bar
Visually shows Aid4Mail’s total progress for this session. Information includes:

· Amount of data processed in Bytes, KB, GB or TB (whichever is most relevant).

· Number of items processed.

· Progress percentage.

· Time remaining.

Note: If you process a live email account that continues to receive mail while Aid4Mail is

processing, the progress percentage may exceed 100%. This is because Aid4Mail calculates

the number of emails to be processed at the start. If new emails arrive later, Aid4Mail will

process them too but the final count will be greater than the number calculated at the start.
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For example, if your account has 100 emails in it, and 10 new emails arrive while Aid4Mail

is processing, the progress percentage at the end will be 110%. A similar situation can arise

if you use the same email account or mailbox as both source and target, causing circular

processing.

Status
The session’s current status. One of the following will be displayed:

· Not ready

One or more of the required settings have not been completed.

· Ready

Aid4Mail’s settings are complete but the session has not yet been run.

· Waiting

Run has been selected but the session is still waiting its turn. This is because other

sessions are already running and the maximum number of sessions running concurrently

has been reached. As the other sessions finish, one by one, this session will move forward

in the queue and will automatically start when its turn arrives.

· Indexing files

The session is now running and is indexing the source mail files prior to processing them.

· Processing

Emails (or non-email items) are currently being processed. 

· Paused

The session has been paused. If you select Run when a session is paused then Aid4Mail

will pick up where it left off. 

· Stopped

The session has been stopped. If you select Run when a session is stopped then Aid4Mail

will restart the session from the beginning.

· Successful

The session has ended and successfully processed all mail and non-email items.

· Completed

The session has completed but issues were encountered with some of the emails.
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· Failed At Start

The session failed to start. This is usually due to Aid4Mail being unable to find the Source

or Target location.

· Failed Midway

The session failed while processing. This can be due to a variety of reasons including the

loss of a network connection.

Overview
These statistics show how many emails (or non-email items) were:

· Completed

Aid4Mail was able to open the item and process it.

· Skipped

Aid4Mail ignored the item and skipped it, usually due to your filter settings. Details of

skipped items are shown under the Skipped heading.

· Errors

Indicates the number of items that produced errors during processing. Error details are

shown under the Error heading.

· Unprocessed

The number of items that were not processed and not accounted for in the other

statistics. This is calculated once processing finishes.

Time/Speed
Time-related statistics include:

· Processing time

The time elapsed so far for this session.

· Bytes per second

The amount of data processed per second.

· Items per second

The number of items processed per second.

Skipped
Details for the Skipped statistic under Overview. It shows how many skipped items were:
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· Filtered

By any filter set using Aid4Mail’s search & filter feature.

· Incremental

Items that were already processed during a previous run of the same session with

incremental processing turned on.

· Invalid

Items that don’t have any data, or don’t conform to the file format, are automatically

skipped.

Error
Details for the Error statistic under Overview. It shows how many errors were:

· Source errors

The number of source emails that produced errors while being read.

· Target errors

The number of target emails that produced errors while being saved.

· Other errors

Errors that occurred but not while reading the source email or saving the target email.

For example, emails in Eudora mailboxes contain links to attachments rather than the

attachments themselves. If an attachment has been moved from the location the link

points to, Aid4Mail will not be able to find it or include it in the target email, generating

an error. However the target email is still successfully saved (without the attachment).

This kind of error would fall into the other errors category.

Current Folder

Progress bar
Visually shows how far Aid4Mail has progressed through the current folder. Information

includes:

· Amount of data processed in Bytes, KB, GB or TB (whichever is most relevant).

· Number of Items processed.

· Progress percentage.

Details underneath include:
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· Mail store

The name of the mail store currently being processed.

· Folder

The name of the folder currently being processed.

· Current item

The name of the email, or non-email item, currently being processed. For emails, this

name is taken from the subject line.



170

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

User interface

13.4.3 Progress log

The location and contents of the session’s progress log file. The file is only created once a

session has started processing. If the progress log file has not yet been created then this

screen is not available.

Progress log screen

Progress log file
The full path and filename of the progress log file for this session. Clicking on the path will

open the file in whatever local application is associated with .log files (e.g. Notepad).

Note that a secondary progress log file is created in the same location, with the same

filename but a .tsv extension instead of .log. It contains additional data fields and is in the

TSV (Tab Separated Values) format so will open in most spreadsheet applications.

Content pane
Displays the content of the .log progress log file, line by line. If this screen is accessed while

the session is running, the current content of the progress log file will be displayed.
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However, it will not automatically be updated until the session has finished. Select Refresh

to update the content of the file at any time while the session is running.
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13.4.4 Error log

The location and contents of the session’s error log file. The file is only created if one or

more errors were encountered. If there is no error log file then this screen is not available.

Error log screen

Error log file
The full path and filename of the error log file for this session. Clicking on the path will

open the file in whatever local application is associated with .log files (e.g. Notepad).

Note that a secondary error log file is created in the same location, with the same filename

but a .tsv extension instead of .log. It contains additional data fields and is in the TSV (Tab

Separated Values) format so will open in most spreadsheet applications.

Content pane
Displays the content of the error log file, line by line. If this screen is accessed while the

session is running, the current content of the error log file will be displayed. However, it will
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not automatically be updated until the session has finished. Select Refresh to update the

content of the file at any time while the session is running.
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13.5 Task bar

The task bar displays important information relative to the task being performed. It also

contains the Show/Hide session list button and the Zoom feature.

Task bar

Show/Hide multiple sessions
Same functionality as Show/Hide session list command under the View menu.

Zoom
Zoom the user interface between 100% and 150%. This is the equivalent of using Zoom in

or Zoom out under the View menu.
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13.6 Project settings

Settings that concern the whole project rather than individual sessions. 

The Project settings screen is divided into four sections, each with its own tab. Select a tab

to view that section:

· Project

· Case

· Bates

· PDF

Progress settings screen
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13.6.1 Project settings: Project

The Project section of the Project settings screen.

App section of the Options screen.

Information

Name (required)
Name of the current project. This is also used to name the project folder and its settings

file and so must not contain any illegal characters.

Location
Full path of the folder on disk where the current project is stored. It is also a hyperlink so,

when selected, will open the project folder location in the Windows File Explorer app.

Description
An optional description of the current project.

Keywords
An optional list of keywords associated with the current project.
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13.6.2 Project settings: Case

The Case section of the Project settings screen.

App section of the Options screen.

Information

The following optional case information fields are available. The information entered in

these fields determines the values of the Case template tokens.
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· Case name

· Case ID

· Evidence ID

· Date

· Location

· Description

Investigator

The following optional investigator/lab information fields are available. The information

entered in these fields determines the values of the Case template tokens.

· Investigator name

· Lab ID

· Contact

Additional information

The following optional field is available:

· Notes
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13.6.3 Project settings: Bates

The Bates section of the Project settings screen. 

This section is only available in Aid4Mail Enterprise and Investigator. In Aid4Mail Converter,

default values are used: The start number is automatically set to 1,  the number of digits to

8, and there is no prefix or suffix.

App section of the Options screen.

Bates number

Start number
The starting value for the Bates number, for each new session or project, when the Bates

numbering scope is set to Session or Project.
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Bates stamp

Number of digits
The number of digits used for the formatted Bates number in the Bates stamp. For example

if the Bates number is currently 12 and the number of digits is set to 8, then the numerical

part of the Bates stamp will be:

00000012

Prefix
The prefix to the formatted Bates number in the Bates stamp. It can be text, a template

token or a combination of both. 

For example, when running a session named JohnDoe-Gmail, if the Bates number is

currently 135, the number of digits is 6 and the prefix is {SessionName}- (the {SessionName}

token followed by a hyphen), then the Bates stamp will be:

JohnDoe-Gmail-000135.

Suffix
The suffix following the formatted Bates number in the Bates stamp. It can be text, a

template token or a combination of both. 

For example, when running a session named JohnDoe-Gmail, if the Bates number is

currently 270, the number of digits is 8, the prefix is FS- and the suffix is -{SessionName} (a

hyphen followed by the {SessionName} token), then the Bates stamp will be: 

FS-00000270-JohnDoe-Gmail
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13.6.4 Project settings: PDF

The PDF section of the Project settings screen.

App section of the Options screen.
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Document information

The information in these optional fields is included in the PDF document's metadata. You

can view it in Adobe Reader, for example, by right-clicking a document and selecting

Document properties.

You can use text, template tokens or a combination of both in these fields. Template

tokens can be typed manually or inserted by selecting a token from the drop-down Insert

list, located above the field on the right.

For example, if you enter {InvestigatorName} in the Author field, the value of that token

will be used. The content for the token is taken from the investigator Name field in the

Case section of the project settings. So, entering Anne Appleby as the investigator's name,

and {InvestigatorName} as the PDF Author, will result in Anne Appleby being the author

of the PDF. 

Author
The author of the PDF document.

Title
The title of the PDF document.

Subject
The subject of the PDF document.

Kewords
A list of keywords that describe the PDF document.

Page header

The page header appears at the top of every page of the PDF document. You can specify

any text to be displayed on the left or right side (or both) of the header. 

You can use text, template tokens or a combination of both in these fields. Template

tokens can be typed manually or inserted by selecting a token from the drop-down Insert

list, located above the field on the right.

For example, entering {CaseID}, {CaseDate} in the Left side field will insert the case ID

and date, separated by a comma, into the left side of the page header. The content for
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these particular tokens is taken from the Case section of the project settings. Entering

{BatesStamp} in the Right side field will insert a unique Bates stamp into the right side of

the header.

Note that header text is limited to one line. If the text on the left or right side is too long,

they may overlap. For this reason, we recommend that you keep both the left and right

sides of the header shorter than half of the width of the page.

Left side
The text to be displayed on the left side of the page header.

Right side
The text to be displayed on the right side of the page header.

Page footer

The page footer appears at the bottom of every page of the PDF document. You can

specify any text to be displayed on the left or right side (or both) of the footer. 

You can use text, template tokens or a combination of both in these fields. Template

tokens can be typed manually or inserted by selecting a token from the drop-down Insert

list, located above the field on the right.

For example, entering  Lab ID: {LabID} in the Left side field will insert the lab ID into the

left side of the page footer. The content for this particular token is taken from the Case

section of the project settings. Entering Page {PageNumber} of {PageCount} in the Right

side field will insert page numbering into the right side of the footer.

Note that footer text is limited to one line. If the text on the left or right side is too long,

they may overlap. For this reason, we recommend that you keep both the left and right

sides of the footer shorter than half of the width of the page.

Left side
The text to be displayed on the left side of the page footer.

Right side
The text to be displayed on the right side of the page footer.
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Remote content

Download and render (slow)
When On, remote content linked to by emails will be downloaded and rendered in the PDF

document. This can significantly increase processing time, especially if your internet

connection is slow. When Off, remote content will be absent from the PDF document. 

Security features

By default, PDF documents created by Aid4Mail are printable and editable, and their

content can be copied. You can turn off any, or all, of these capabilities by deselecting

Allow printing, Allow copying or Allow editing. However, a Permissions password or a

Document open password (or both) is required for these changes to take effect.

Allow printing
When On, the PDF document's printing capabilities are enabled. When Off, and one of the

passwords is set, printing is disabled.

Allow copying
When On, copying of the PDF document's content is enabled. When Off, and one of the

passwords is set, copying is disabled.

Allow editing
When On, the PDF document's editing capabilities are enabled. When Off, and one of the

passwords is set, editing is disabled.

Permissions password
This password only controls the print/copy/edit capabilities of a PDF document.

Document open password
Protects a PDF document with a password that's required to open the document. This

password will also control print/copy/edit capabilities if the Permissions password is

absent. When both passwords are present, the Permissions password controls the

print/copy/edit capabilities and the Document open password is required to open the

document. For maximum security, ensure the two passwords are different.
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13.7 Options

Options that apply to the app as a whole or to all sessions and projects. 

The Options screen is divided into six sections, each with its own tab. Select a tab to view

that section:

1. App

2. Projects

3. Sessions

4. Filters

5. PDF

6. Advanced

Progress settings screen
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13.7.1 Options: App

The App section of the Options screen.

App section of the Options screen.

Startup

Automatically check for software updates
When on, Aid4Mail will check for updates each time it is opened. This option is on by

default. We recommend you always use the latest version of Aid4Mail.

Bates numbering scope

Only available in Aid4Mail Enterprise and Investigator. 

Set the Bates numbering scope to one of three options:

· Global

The Bates number increments across all sessions in all projects. When this option is

selected, only consecutive processing is available.

· Project

The Bates number will be set to 1 at the start of each new project but will increment



187

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

User interface

across all sessions in the project. When this option is selected, only consecutive

processing is available.

· Session

The Bates number will be set to 1 for each new session. This allows for either consecutive

or concurrent processing.

In Aid4Mail Converter, the scope is automatically set to Session.
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13.7.2 Options: Projects

The Projects section of the Options screen. Note that modifications in this section will only

apply to new projects. They won't apply to existing projects including the current one.

Projects section of the Options screen.

Location

Projects folder
The location where new projects are created. It will not have any effect on existing projects.

Default project name

Template
A template that defines the default name for each new project. It will not have any effect

on existing projects or the current one. Note that after a project has been created, its name

can be changed in the project settings.

This field is a template that accepts a combination of text and the following tokens:
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* The project name index, formatted to display 3 digits.

: The current date (without the time) in the International date format, YYYY-MM-DD.

Examples (assuming the next value for the project name index is set to 1):

Project-*

Produces the following project names:

Project-001

Project-002

Project-003

: Project-*

Produces the following project names (assuming the current date is January 25, 2020):

2020-01-25 Project-001

2020-01-25 Project-002

2020-01-25 Project-003

Note that the project name is also used to name the project folder and settings file and so

must not contain any illegal characters.

Project name index

Next value
The next value for the index that's used in the default project name. The index is

incremented by 1 every time you create a new project.

When you first install Aid4Mail, the index is zero and Next value is 1. This means that the

next project you create will be the first. Similarly, if you're working on the 10th project then

Next value will be 11 (unless it has been modified). 

You can change Next value. This will not have any effect on the current project but will

affect subsequent projects. For example, if your first three projects were used for testing

Aid4Mail and now you want a fresh start, you can set Next value to 1.
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13.7.3 Options: Sessions

The Sessions section of the Options screen.

Sessions section of the Options screen.

Default session name

Template
Only available in Aid4Mail Enterprise and Investigator. 

A template that defines the default name for each new session. Note that after a session

has been created, its name can be changed in the session settings.
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This field is a template that accepts a combination of text and the following tokens:

* The session name index, formatted to display 3 digits.

: The current date (without the time) in the International date format, YYYY-MM-DD.

? The project name.

Examples (assuming the starting value of the session name index is set to 1):

Session-*

Produces the following session names:

Session-001 

Session-002 

Session-003

Session : #*

Produces the following session names (assuming the current date is January 25, 2020):

Session 2020-01-25 #001

Session 2020-01-25 #002

Session 2020-01-25 #003

?-S*

Produces the following session names (assuming the project name is Project5):

Project5-S001

Project5-S002

Project5-S003

Note that the session name is also used to name the settings file and log files for this

session and so must not contain any illegal characters.

Session name index

Starting value
Only available in Aid4Mail Enterprise and Investigator, and only editable when Reset to 1

for each new project is off.

The starting value for the index used in the default session name. The index is incremented

by 1 every time you create a new session. However, if sessions are deleted, those numbers

will be reused again.

Reset to 1 for each new project
Only available in Aid4Mail Enterprise and Investigator.



192

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

User interface

If on, the session name index is automatically set to 1 when a new project is created and

the starting value field is not available. This option is on by default.

Multiple sessions

Maximum sessions running concurrently
Only available in Aid4Mail Enterprise and Investigator.

The number of Aid4Mail sessions that can be run at the same time. It does not limit the

number of sessions you can set up, only the number that will run concurrently. 

The default value should work well for the average computer. With higher values, more

sessions will be processed at the same time and, if your computer has the available

resources, the faster your project will run. However, if your computer is older or lower-end,

a smaller value will perform better. If you're undertaking a large-scale migration, we

recommend you test a variety of values to find the optimal number for your hardware,

available internet bandwidth and mail account set up.

Note that if your source or target format is an Outlook profile then the maximum number

of sessions running concurrently is limited to 8.

For more information on running multiple sessions, please refer to the Multiple sessions

topic.

File naming & duplicate detection

Generate hash value from
Hash values are used in Aid4Mail for some filenames and in the detection of duplicates.

This field allows you to select the data that the hash function uses. Select from:

· Message-ID header field

This is a unique ID field in the email header. Many emails contain this field but not all do.

It is notably missing in outbound emails. In cases where the Message-ID is blank or

missing, Aid4Mail uses a combination of the From, Date and Subject header fields

instead.

· Original SMTP header

The whole email header with all its fields (To, From, Subject, etc.).
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Folder mapping

Apply to top-level target folders
Only available in Aid4Mail Enterprise.

Unfortunately, email clients are not consistent in their naming of folders. For example,

Inbox in one application may be called In in another. The Sent folder might be Sent Mail or

Sent Items. Spam may be called Junk. Language settings can also affect folder names. In

French, Outlook's Inbox becomes Boite de réception.

When this option is on, Aid4Mail maps between folders that have different names for the

same concept, in order to place your target mail in the intended location. This process is

only necessary in the top-level of the folder structure.

For example, when converting from Gmail to PST with this option turned on, emails from

Gmail's Sent folder will be placed in the PST file's Sent Items folder. If this option is off, the

target emails will be placed in a newly created Sent folder in the PST, resulting in two

separate folders for sent mail: Sent (the newly created folder) and Sent Items (that all PST

files have by default).

This option is off by default.

The complete list of folder names recognized by Aid4Mail, for each folder category, is

stored in file FolderNames.dat, in your Data folder. You can add to this list if you have an

email client that uses folder names that are not listed.

The file FolderMapping.dat enables you to override Aid4Mail's default mapping by

specifying a target folder name to use for each folder category. By default, this file has no

effect because each line in it starts with a semicolon character (;), indicating that it's a

comment and will not be read by Aid4Mail. Removing the semicolon causes Aid4Mail to

use the mapping specified in that line. You can also edit the folder name (after the equal

sign in each line) if necessary.

Error handling

Stop processing if an item can't be opened or saved
When on, Aid4Mail will stop processing the session if an email or non-email item is unable

to be read or saved. When off, Aid4Mail will continue processing after the error, moving on

to the next item. This option is off by default.
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Create a local backup when saving an email fails
For certain target formats, Aid4Mail is dependent on a third-party to save an email. For

example, if your target format is an Outlook profile, PST file or MSG file, Aid4Mail uses

Outlook's MAPI to save each email. If your target format is a cloud-based format like Gmail

or Outlook 365, or an IMAP account, then Aid4Mail is dependent on the mail server for this

task. In turn, the mail server is dependent on the bandwidth available and your internet

connection.

Occasionally these third-parties are not be able to save a target email. For example, if an

email's size, number of recipients or number of attachments exceeds the server's limit, it

may fail. When this happens, and you have this option turned on, Aid4Mail will save a

backup copy of the email. It will be saved with an MD5 filename, and its folder structure

intact, in the Backup subfolder of your project folder. The email will be saved in the EML

format unless your source format was an Outlook profile, PST file or MSG file in which case

the email will be saved as an MSG file.

This option is on by default.

https://www.aid4mail.com/redir/mapi-def
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13.7.4 Options: Filters

The Filters section of the Options screen.

Filters section of the Options screen.

Case sensitivity

Smart case detection for item search terms
Only available in Aid4Mail Enterprise and Investigator.

When on, item searches for search terms that contain one or more uppercase characters

will be case-sensitive, and searches for terms that contain only lowercase characters will be

case-insensitive. When this option is off, all item searches will be case-insensitive. It is off by

default.
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Inclusion

Include non-email Outlook items (calendars, contacts, notes, tasks)
Outlook mail stores (Outlook profile, PST files and MSG files) may contain items that are not

email messages like calendars, contacts, notes or tasks. When this option is turned on,

Aid4Mail will include non-email items in its processing. When off, these items will be

skipped. This option is on by default. 

Note that:

· Non-email items cannot be filtered.

· If your target format is not an Outlook mail store then a non-email item will be treated

as if it were an email message. This will not generate an error but it will not convert to an

equivalent calendar/contact/note/task in a non-Outlook format. So using this option only

makes sense if both your source format and target format are Outlook mail stores, for

example converting from an Outlook profile to a PST file, in which case non-email items

will remain intact. 

Include empty folders
When turned on, Aid4Mail will process empty folders and include them in your target mail.

When off, empty folders will be ignored and will not appear in your target mail. This option

is on by default.

Duplicates

Detection scope
Only available in Aid4Mail Enterprise and Investigator.

Aid4Mail detects duplicates so they can be used in filters or scripts. Here you can choose

the scope of what is considered a duplicate:

· Across all folders

Any email that is identical to another email in any folder will be flagged as a duplicate.

· In same folder only

An email that’s identical to another email will only be flagged as a duplicate if both are

located in the same folder.
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You can read more about how Aid4Mail handles duplicates in the Deduplication topic.

Search limits

Limit attachment and file searches to
Only available in Aid4Mail Enterprise and Investigator.

Determines how far Aid4Mail will search through large attachments and files contained

within attachments. The smaller the value, the faster the search but the greater the chance

of missing a search term. For example, if the value set is 32 MB then Aid4Mail will only

search the first 32 MB of a file before moving on to the next one. 

Only search metadata in images larger than
Only available in Aid4Mail Enterprise and Investigator.

Emails can contain small images for display purposes that offer no useful metadata to

search. Aid4Mail can skip these images to improve performance. Use this option to set the

threshold.
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13.7.5 Options: PDF

The PDF section of the Options screen.

Advanced section of the Options screen.

Presentation

Orientation
The orientation of each page in a PDF document. Choose between:

· Portrait

The document height is greater than its width.

· Landscape

The document width is greater than its height.
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Paper size
The size of paper used to in the PDF document. Select one of the following:

· A4

· Folio

· Legal

· Letter

Page margins
The amount of space between the edge of the page and its content. Choose between:

· None

Left, right, top and bottom margins are all set to zero. 

· Normal

Left, right, top and bottom margins are all set to 1 inch (2.54 cm).

· Narrow

Left, right, top and bottom margins are all set to 0.5 inches (1.27 cm).

· Moderate

Left and right margins are set to 0.75 inches (1.905 cm). Top and bottom margins are set

to 1 inch (2.54 cm).

· Wide

Left and right margins are set to 2 inches (5.08 cm). Top and bottom margins are set to 1

inch (2.54 cm).

When margins are set to None, any page headers and footers are placed directly above

and below the page content. When margins are set to any other value, headers and footers

are placed in the space occupied by the margins.

Display mode
Configures the PDF reader that's displaying the document. Well-known PDF readers like

Adobe Reader will respond to these settings. However, others may not if their developers

have not implemented this feature.

Select one of the following:

· Default

Use the default settings of the PDF reader that's displaying the document.
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· Outlines

Instruct the PDF reader to display the outline feature when opening the document.

· Thumbnails

Instruct the PDF reader to display thumbnails of the document when it's opened.

· Full screen

Instruct the PDF reader to display the document full-screen.

File size

Embed fonts
When On, any fonts used in the document will be embedded into the PDF file. This ensures

the document will always appear as intended in any PDF reader. However, if the document

uses a lot of fonts, it can significantly increase the file size. 

When this option is Off, fonts are not embedded into the file. This ensures the file size is as

small as possible. However, fonts not found on the computer that's displaying the PDF

document will be replaced with alternatives and the document may not appear as

intended.

Compression
The amount of compression applied to the document. Generally, higher amounts of

compression lead to smaller file sizes and reduced document quality. The options are:

· None

No compression is applied to the document. This will result in the largest file size and

maintains 100% document quality.

· Maximum

Maximum compression is applied to the document. This will result in the smallest file size

but with the greatest impact to document quality.

· Normal

This default setting is a good balance between the extremes, applying some

compression without too much loss of quality.
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Header and footer text

Font
Select which font is used in the header and footer text:

· Arial

· Calibri

· Courier New

· Georgia

· Tahoma

· Times New Roman

· Trebuchet

· Verdana (default)

Font size
Select the size of the font used in the header and footer text. The default value is 9 points

but any value between 6 and 20 is acceptable.
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13.7.6 Options: Advanced

The Advanced section of the Options screen.

Advanced section of the Options screen.
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Source PST files

Protect from changes by Outlook during processing
Only available in Aid4Mail Enterprise and Investigator.

When a PST file is accessed by Outlook, Aid4Mail or any other program, the PST file is

slightly modified internally. This is unacceptable in forensic examinations and also makes

detecting duplicates almost impossible. When this option is on, Aid4Mail will create a

temporary copy of a source PST file which it then connects to MAPI before processing. This

avoids the original PST file being accessed and subsequently modified. However, it also

has a small impact on performance. When this option is off, Aid4Mail will access a source

PST file directly, thereby modifying it.

This option is on by default. Aid4Mail editions that do not have this option will access PST

files directly (as if the option is off). 

Target mbox files

Extension
Mbox files are valid with or without a file extension. Common mbox file extensions are

mbox or mbx, for example MyMailbox.mbox or  MyMailbox.mbx. By default Aid4Mail uses

mbox as an extension. You can change this by entering the file extension of you choice in

this field (without the preceding period character, i.e. write mbox and not .mbox) or by

leaving it blank for no extension at all.

Alternative storage folders

Provide alternative folder locations for file cache and temp files. We recommend you store

these on a fast SSD or RAM drive for optimal performance.

Cache
Enter an alternative folder location for file cache.

By default, cache files are stored in the following folder:

C:\Users\<User>\AppData\Local\Aid4Mail5\Cache

If Aid4Mail is running from a USB thumb drive then cache files are stored in the

AppData\Cache directory under the program folder.
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Temp files
Enter an alternative folder location for temporary files. 

By default, temporary files are stored in the following folder:

C:\Users\<User>\AppData\Local\Temp\Aid4Mail5

If Aid4Mail is running from a USB thumb drive then temp files are stored in the

AppData\Temp directory under the program folder.

Optimization

Only available if your operating system is 64-bit.

Aid4Mail includes both 32-bit and 64-bit processing engines and automatically selects the

appropriate one. For example, if you need to process a PST file and have a 64-bit version

of Outlook, Aid4Mail will automatically use its 64-bit processing engine. However, in cases

where either version of the processing engine could be used, this option allows you to

specify which one based on your priorities.

Prioritize processing speed (32-bit engine)
In general, 32-bit software is faster than 64-bit software. If processing speed is your

priority, select this option. Aid4Mail will use the 32-bit engine in all cases except for those

that specifically require 64-bit processing.

Prioritize memory access (64-bit engine)
64-bit software can potentially access four billion times more physical memory than 32-bit

applications! If your system has more than 4 GB of RAM, and you need to process emails

that are large (usually due to large attachments), Aid4Mail may perform more efficiently

using the 64-bit engine. When you select this option, Aid4Mail will use the 64-bit engine in

all cases except for those that specifically require 32-bit processing.

Python installation folders

Only available if your operating system is 64-bit.

As explained under Optimization, Aid4Mail includes both 32-bit and 64-bit processing

engines and automatically selects the appropriate one. Unfortunately, Python does not. It

only installs one version. This means that if your Python installation is 32-bit and Aid4Mail

needs to use its 64-bit engine, your Python script will generate an error. Likewise if your

Python installation is 64-bit and Aid4Mail is required to use its 32-bit engine. 
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This problem is accentuated if you have a project with multiple sessions that all use Python

scripts and some require 32-bit processing while others require 64-bit. Aid4Mail will adapt

to this scenario but Python will not. Fortunately there is a work-around: It is possible to

install both 32-bit and 64-bit versions of Python manually in different locations. Then you

can use these fields to tell Aid4Mail where to look to find the correct Python version. 

Note that if both fields are blank, Aid4Mail will attempt to locate your default Python

installation (if there is one), when required, but it will not be able to determine in advance

whether it's 32 or 64-bit.

32-bit
Enter the location of your 32-bit Python installation.

64-bit
Enter the location of your 64-bit Python installation.

Google API credentials

Aid4Mail uses Google's secure APIs to access Google accounts, authenticating login details

using Aid4Mail Authenticator and the secure OAuth 2.0 protocol without any knowledge of

usernames or passwords. This method of access and authentication provides maximum

security and privacy. However, it also requires you to set up set up Google API credentials if

you don't already have them. Once set up, enter your Google API credentials in this section

before starting the authentication process.

Client ID
Enter the Client ID obtained from setting up Google API credentials.

Client secret
Enter the Client secret obtained from setting up Google API credentials.
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13.8 Activate license

The Activate license screen looks slightly different depending on whether you opened it

from the Start screen or from the File > Activate license menu command. However they

both contain the same input fields:

Activate license screen when opened from the Start screen
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Activate license screen when opened from the File menu

Activation code
When you purchase Aid4Mail, in most cases you will be sent an activation code by email.

Enter it into this field.

Password
Enter a password of your choosing. You can click and hold the eye icon to make the

password visible. If you are re-activating Aid4Mail, note that the password you create must

be different to all the passwords you have previously used with this activation code. 

Activate
Once you have filled in all the fields on this screen, select Activate to activate Aid4Mail.
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13.9 Aid4Mail Authenticator

Aid4Mail Authenticator enables you to authorize temporary access to a cloud-based email

service or IMAP account without having to share your login credentials with Aid4Mail.

Example services include Gmail, Office 365, Outlook.com, and Hotmail.

It uses the secure OAuth 2.0 protocol, creating an authentication token that Aid4Mail can

read but that does NOT contain your username or password. You can invalidate the token

at any time, revoking Aid4Mail's access to the account. This method of access and

authentication provides you with maximum security and privacy.

For Gmail accounts only: 
Aid4Mail uses Google APIs during authentication and mail processing and requires you to

have API credentials. You can set them up in a few minutes by following the instructions in

the Setting up Google API credentials topic. 

When you have created your credentials, enter them in the Google API credentials field on

Aid4Mail's Options screen before following the authentication instructions below. 

Authentication instructions

1. Launch Aid4Mail Authenticator automatically by selecting Add above either of these

fields:

·  Source Email address

·  Target Email address

Or when using the OAuth2 connection security option in the IMAP configuration editor.
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2. Enter the address of the email account you want to access and then select Authenticate:

Enter an email account in Aid4Mail Authenticator and press the Authenticate button

3. Aid4Mail Authenticator will automatically open your web browser so that you can select

your mail account and log into it. Note that Aid4Mail Authenticator has no access to

your browser and does not see your login credentials at any time. It will only see the

authentication token that's produced at the end of the process.

You will be presented with one or more of the following pages, depending on your mail

service and whether you are already logged in or not:

a. A login page that requires you to:

· Select your account if you have multiple accounts with this mail service .

· Log in with your username and password (unless you are already logged in).

If you only have one account with this mail service and are already logged in, you

may not see this page at all.

b. Only when accessing Google accounts outside of your own domain: A message

warning that the app has not yet been verified by Google. This message will not

appear if you are accessing an account in your own domain.

At the bottom of the warning message, select Advanced and then Go to Aid4Mail
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(unsafe) as shown below. Then continue with the authentication process.

Warning message: "This app hasn't been verified by Google yet".

Select "Advanced" and then "Go to Aid4Mail (unsafe)".

c. A page requesting permission for Aid4Mail to access the account. Depending on

your mail service, you may not see this screen. If you do, you need to allow access for

Aid4Mail to continue.

d. A success page. You will only see this if the previous steps were completed

successfully. Otherwise the mail service will indicate any errors (for example an

incorrect password).
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"Authentication successful" message in browser

4. Close the browser window and return to Aid4Mail. The authentication token will

automatically be saved in the correct location.

Note that you can revoke Aid4Mail's access to your mail account at any time. Please refer

to your mail account's settings for details. For Gmail, you can revoke access on the

permissions page of the Google website.

https://www.aid4mail.com/redir/google-permissions
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13.9.1 Setting up Google API credentials

Instructions: 

1. Log into the Google developers website using your Google account details. It will look

something like this:

2. Select CREATE PROJECT at the top-right of the page.

https://www.aid4mail.com/redir/google-dev
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3. Enter a project name (for example Aid4Mail), leave Location set to No organization and

select the CREATE button. It may take a few seconds for the project to be created.
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4. Select ENABLE APIS AND SERVICES at the top of the next page.

5. Enter Gmail into the search bar. 

6. Select the Gmail API.
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7. Once the Gmail API loads, select ENABLE.
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8. Select CREATE CREDENTIALS at the top of the next page.

9. Under Which API are you using?, select Gmail API. 

Under Where will you be calling the API from?, select Other UI (e.g. WIndows, CLI tool). 

Under What data will you be accessing?, select User data.
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Finally, select the What credentials do I need? button.
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10.Select SET UP CONSENT SCREEN at the bottom-right of the overlay that appears.

11.A new browser window will open, presenting two UserType options: Internal or External.

If your organization has a Google Workspace subscription, and you will only be using

Aid4Mail to process accounts within your organization's domain, then select Internal. If

you have a regular Gmail account or plan to process accounts outside of your

organization's domain, select External. Once you've chosen, select the CREATE button.



219

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

User interface

12.On the OAuth consent screen, enter Aid4Mail as your Application name and select your

email address under Support email. Then select the Save button at the bottom of the

page.
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13.Select Credentials from the menu on the left of the page.
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14.Select CREATE CREDENTIALS at the top of the page.
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15.Select OAuth client ID from the popup menu.

16.Under Application type, select Desktop app. In the Name field, enter Aid4Mail and select

the CREATE button.
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17.The overlay shows your Google API credentials. Before selecting OK, copy Your client ID

and, in Aid4Mail, paste it into the Client ID field under Google API credentials (in the

Advanced section of Aid4Mail's Options screen). Likewise, copy Your Client secret to the

Client secret field.

That's it! You can now follow the Authentication instructions to add any Gmail accounts you

would like to process with Aid4Mail.
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13.10 Aid4Mail Remote Authenticator

Aid4Mail Remote Authenticator is a stand-alone version of Aid4Mail Authenticator that does

not require installation or an Aid4Mail license. It can be downloaded by any third party

under investigation, or whose mail account you are processing on their behalf. It enables

the account owner to grant Aid4Mail secure, temporary access to a cloud-based email

service or IMAP account without providing their full login credentials and without having a

copy of Aid4Mail.

The Aid4Mail Remote Authenticator User Guide (pdf) includes complete instructions for an

account owner to download and use Aid4Mail Remote Authenticator.

How does it work?

Aid4Mail Remote Authenticator creates an authentication token that Aid4Mail can read but

that protects the account owner's information. With IMAP accounts, the password field is

encrypted and an expiry date can be set for the token. For Google and Microsoft accounts,

the secure OAuth 2.0 protocol is used whenever possible. This creates an authentication

token that provides account access without containing the username or password at all.

The account owner can invalidate the token at any time, revoking Aid4Mail's access.

Using an authentication token

Once an authentication token has been created, the account owner simply sends you the

file. You can import it into Aid4Mail by selecting Import above one of the following fields:

·  Source Email address

·  Source IMAP account

·  Target Email address

·  Target IMAP account

The authentication token's filename indicates which option to use: It consists of the email

address of the account owner followed by a two-part extension reflecting the protocol

used to create it. For example, the token with filename test@aid4mail.com.Google.auth was

created using the email address test@aid4mail.com and authenticated through Google

APIs using the OAuth 2.0 protocol. 

The following explains each two-part extension and how to use the authentication token in

Aid4Mail:

https://www.aid4mail.com/doc/Aid4Mail_Remote_Authenticator-User_Guide.pdf


225

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

User interface

· Google.auth

Authenticated through Google APIs using the OAuth 2.0 protocol. To use the token in

Aid4Mail, select Gmail as the source or target Format and use the Import button above

the Email address field to import it..

· Microsoft.auth

Authenticated through the Microsoft Graph API using the OAuth 2.0 protocol. Currently,

only Outlook 365 accounts are authenticated this way and they can only be used as

source formats. To use the token in Aid4Mail, select Outlook 365 as the source Format

and use the Import button above the Email address field to import it.

· IMAP.auth

Authenticated through IMAP using the OAuth 2.0 protocol. To use the token in Aid4Mail,

select IMAP as the source or target Format and use the Import button above the IMAP

account field to import it.

· IMAP.ini

Authenticated using regular IMAP credentials with an encrypted password. To use the

token in Aid4Mail, select IMAP as the source or target Format and use the Import button

above the IMAP account field to import it.

Note that each cloud-based email service or IMAP account that you process will require its

own authentication token. 

For Google accounts only
Aid4Mail uses Google APIs during authentication and mail processing and requires you to

have API credentials. You can set them up in a few minutes by following the instructions in

the Setting up Google API credentials topic. 

When you have created your credentials, enter them in the Google API credentials field on

Aid4Mail's Options screen and then access one of your own Google accounts by following

the instructions on the Aid4Mail Authenticator page. This will create a file called Auth-

Google.ini in your application data folder. You will need to send this file to your

customer/suspect along with the link for Aid4Mail Remote Authenticator. Don't worry, this

file does not contain the login credentials for your account—only your Google API

credentials—and is encrypted.
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13.11 IMAP Configuration Editor

The IMAP Configuration Editor opens when you select Add or Edit above the source IMAP

account or target IMAP account list. It allows you to enter the details of an IMAP account

manually or by using autocomplete. 

For manual configuration, please consult your IMAP account service provider's

documentation for the necessary details. Alternatively, refer to our list of common IMAP

configurations. 

For automatic configuration, fill in the Email address field and then select Autocomplete.

Aid4Mail will automatically configure the Username, Server name/IP address and Port

fields, leaving only the Password to be entered manually.

IMAP Configuration Editor
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Fields

Email address
The email address of your IMAP account.

Username
The username of your IMAP account. This is often (but not always) the same as the email

address.

Password
The IMAP account password.

Server name/IP address
The name or IP address of the server hosting the account. A server's name is in a more

readable format, for example imap.gmail.com, whereas the IP address is a less-readable

sequence of numbers, 74.125.21.108. Both refer to the same server location so you can use

either.

Port
Ports allow network resources to be shared by different applications on the same computer

at the same time. They are similar in concept to a telephone extension that allows a phone

number to be shared by multiple people. 

Aid4Mail will pre-fill this field with 993 which is the most commonly used port for IMAP

connections. If you select Autocomplete, Aid4Mail may update this with a port number

that's appropriate for your email address domain name.

Connection security
Choose one of the following options:

· None

No security protocol is used to access the IMAP account.

· Auto

The most appropriate security setting will automatically be used. This is the default

option.
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· StartTLS

Aid4Mail will determine if a plain text connection needs to be upgraded to a secure one

based on the server response.

· SSL/TLS

The SSL/TLS security protocol will be used to access the IMAP account.

· OAuth2

Aid4Mail will connect to the IMAP account using the OAuth 2.0 protocol. This is the most

secure option. 

If you select this option, Aid4Mail will ignore your password and, after you select OK, will

launch Aid4Mail Authenticator to establish a connection to your IMAP account. Please

follow the instructions in the Aid4Mail Authenticator topic.

Log IMAP communications
When on, Aid4Mail will log all communication with the IMAP server, storing the details in

.log files in your project folder. There may be multiple log files corresponding to the

various stages of the conversion process. These logs can help identify connection issues or

problems encountered while downloading or uploading emails. They will sometimes be

requested by our technical support team if you contact us with IMAP related issues. This

option is off by default to maximize performance. 

Autocomplete
Only available once the email address field has been completed with a valid address.

Autocomplete will configure the Username, Server name/IP address and Port fields based

on the email address domain name, leaving only the Password field to be completed

manually.

OK
Close the IMAP Configuration Editor, either adding a newly created account to the source

IMAP account or target IMAP account list, or updating an existing account in one of these

lists. 

Cancel
Close the IMAP Configuration Editor without adding to, or updating, the source IMAP

account or target IMAP account list.
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13.11.1 Common IMAP configurations

If you choose to configure your IMAP account manually, you should find the necessary

details in your IMAP account service provider's documentation. For your convenience, some

of the most common IMAP configurations are listed below (in alphabetical order).

Service provider Server name Port Connection

security

Amazon WorkMail imap.mail.us-west-2.awsapps.com

or

imap.mail.us-east-1.awsapps.com

or

imap.mail.eu-west-1.awsapps.com

Contact your system administrator for

guidance on which of the three regional

server names to use.

993 SSL/TLS

AOL Mail (AIM.Mail) imap.aol.com 993 SSL/TLS

FastMail imap.messagingengine.com 993 SSL/TLS

Gmail imap.gmail.com 993 SSL/TLS

GMX Mail imap.gmx.com 993 SSL/TLS

Lotus Domino imap.host.name 993 SSL/TLS

Outlook.com imap-mail.outlook.com 993 SSL/TLS

Office 365
and
Office 365 Education 
(formerly Live@edu)

outlook.office365.com 993 SSL/TLS

Yahoo! Mail imap.mail.yahoo.com 993 SSL/TLS

Zoho Mail imap.zoho.com 993 SSL/TLS
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13.12 Keyboard shortcuts

The following keyboard shortcuts are available in Aid4Mail.
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General keyboard shortcuts

Shortcut Description

F1 Context-sensitive help.

Ctrl+X Cut (only in a text field).

Ctrl+C Copy (only in a text field).

Ctrl+V Paste (only in a text field).

File menu shortcuts

Shortcut Description

Ctrl+N Shortcut for the File > New menu item.

Ctrl+O Shortcut for the File > Open menu item.

Alt+F4 Shortcut for the File > Exit menu item.

View menu shortcuts

Shortcut Description

Ctrl+L Shortcut for the View > Show/Hide list menu item.

F11 Shortcut for the View > Navigate backward menu item.

F12 Shortcut for the View > Navigate forward menu item.

Ctrl+F11 Shortcut for the View > Zoom out menu item.

Ctrl+F12 Shortcut for the View > Zoom in menu item.

Session menu shortcuts

Shortcut Description

Ctrl+Del Shortcut for either the Session > Delete or Session > Reset menu item:

If there's more than one session then delete the selected session. If

there's only one session then reset it.
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Shortcut Description

Ctrl+R Shortcut for the Session > Run menu item.

F7 Shortcut for the Session > Select > Previous menu item.

Up arrow Shortcut for the Session > Select > Previous menu item when the

Session list has focus.

F8 Shortcut for the Session > Select > Next menu item.

Down arrow Shortcut for the Session > Select > Next menu item when the Session

list has focus.

Ctrl+G Shortcut for the Session > Select > By index menu item.

Alt+Up arrow Shortcut for the Session > Move > Up menu item.

Alt+Down arrow Shortcut for the Session > Move > Down menu item.

Alt+Home Shortcut for the Session > Move > To top menu item.

Alt+End Shortcut for the Session > Move > To bottom menu item.
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13.13 Session settings file

When you run an Aid4Mail session, or close the application, the session's settings are saved

to a file in the project folder. The filename is composed of the session name followed by

.settings.ini. For example, the session named JohnDoe will have its settings saved in file

JohnDoe.settings.ini.

Every session setting in Aid4Mail has a corresponding entry in the file (although unused

settings may not be listed). They  are grouped under headings: [Source], [Target], [Filter]

and others that generally reflect the various sections of the settings screen in Aid4Mail.

Settings in the file are composed of the setting name followed by an equal sign (=) and a

value. Generally, setting names in the file correspond to those in Aid4Mail although there

are some exceptions.

For example, when converting EML files, the [Source] section of the file might look like this:

[Source]
Format=EML
RootLocation=D:\Email\Source\EML\

You can edit the session settings file directly although care must be taken to use the correct

syntax and valid values. We suggest you experiment by changing settings in Aid4Mail and

observing how they are stored in the file. Once you are familiar with them, you can edit the

file directly. This can prove useful if you are running Aid4Mail Enterprise using its

command-line interface.
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14 Command-line interface (CLI)

Aid4Mail Enterprise includes a command-line interface (CLI) that enables further

automation. It allows the software to be run from the Windows Command Prompt, batch

files or directly from third-party applications. Aid4Mail Investigator and Converter do not

have access to the command-line interface.

Aid4Mail CLI executables

Aid4Mail contains two CLI executables. One is 32-bit and the other 64-bit:

· a4m-32.exe

· a4m-64.exe

In general, 32-bit software is faster than 64-bit software. If processing speed is your

priority, use the 32-bit executable. However, 64-bit software can potentially access four

billion times more physical memory than 32-bit applications! If your system has more than

4 GB of RAM, and you need to process emails that are large (usually due to large

attachments), Aid4Mail may perform more efficiently if you use the 64-bit executable. 

If your source or target mail format is an Outlook profile, or PST/MSG file(s) that you want

to access through Outlook, and you have 64-bit Outlook installed on your system, then you

will need to use the 64-bit Aid4Mail executable.

Constructing a command line

To run Aid4Mail from the command line, specify an executable followed by either the

Settings switch or the CLI switch. Additional switches can be used to specify individual

settings (that override their counterparts in the settings file).

Settings switch
The -settings switch specifies the location of the session settings file to be used. 

For example, the following command line will run the 32-bit Aid4Mail executable using the

JohnDoe session settings file:

a4m-32.exe -settings:C:\Users\FookesSoftware\Projects\ArchiveEmployeeMail\JohnDoe.settings.ini

Note that if the file location contains one or more spaces then it needs to be enclosed in

quotes, as follows:

a4m-32.exe -settings:"C:\Users\Fookes Software\Projects\Archive Employee Mail\JohnDoe.settings.ini"
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Any optional switches used to specify individual settings will override the corresponding

settings in the settings file. This can prove useful in certain scenarios.

CLI switch
The -cli switch tells Aid4Mail not to use a settings file and, instead, use internal default

values. The intention is that all settings will be individually specified. This means that, at a

minimum, you must specify the source and target format, and the location of the source

and target files or accounts.

Specifying individual settings

Any setting that can be used in the session settings file has a corresponding, optional

command-line switch that takes precedence. In other words, a setting specified in the

command line overrides the corresponding setting in the session settings file if both are

present. 

The command-line switch for an individual setting is composed of a hyphen (-), followed

by the heading under which the setting would appear in the settings file, a period, and

finally the setting name: 

-Heading.SettingName

For example, in the session settings file, the source format is located under the Source

heading and the setting is called Format. The command-line switch for this setting is:

-Source.Format

Likewise, the command-line switch for the RootLocation setting, under the Source heading,

is:

-Source.RootLocation

These command-line switches require a value (as do their corresponding settings in the

file). Specify the value after a colon following the switch as follows:

-Source.Format:EML
-Source.RootLocation:D:\Email\Source\EML\

The full command line, using the JohnDoe session settings file, and overriding the source

format and root location, would look like this:

a4m-32.exe -settings:C:\Users\FookesSoftware\Projects\ArchiveEmployeeMail\JohnDoe.settings.ini 
-Source.Format:EML -Source.RootLocation:D:\Email\Source\EML\
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As before, make sure that any values containing spaces are placed in quotes.

When should you override a session settings file?

The ability to specify individual settings is particularly useful in multi-session scenarios,

where sessions mostly share the same settings but have a small number that are different.

An example of this type of scenario would be a large-scale archival project where 1,000

employee accounts, currently in the EML format, need to be archived in separate PST files.

In this example, most settings would be identical for each Aid4Mail session with only the

source and target file locations changing from one session to another. To accomplish this,

common settings scan be stored in a shared settings file and the source and target file

locations can be specified directly for each session. The command line (for the first three

sessions) would look something like this:

a4m-32.exe -settings:Common.settings.ini -Source.RootLocation:Leroy\ -Target.FileStore:Leroy.pst
a4m-32.exe -settings:Common.settings.ini -Source.RootLocation:Ava\ -Target.FileStore:Ava.pst
a4m-32.exe -settings:Common.settings.ini -Source.RootLocation:Janelle\ -Target.FileStore:Janelle.pst
etc…

Common command-line switches

Note that command-line switches and their values are case-insensitive.

Command-line switch Description

-Settings Location of the session settings file to be used. Settings in this

file can be overridden by specifying individual settings.

Note that every command-line must contain either the -

Settings switch or the -CLI switch.

-CLI Indicates that there is no session settings file and internal

defaults will be used, overridden by specifying individual

settings.

Note that every command-line must contain either the -

Settings switch or the -CLI switch.

-Source.Format Same as the Format field in the Source settings.

-Target.Format Same as the Format field in the Target settings.

-Source.RootLocation Same as the Location field in the Source settings.
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Command-line switch Description

-Target.RootLocation Same as the Location field in the Target settings.

-Source.FileStore Same as the PstFile field in the Source settings.

-Target.FileStore Same as the PstFile field in the Target settings.

-Source.MapiProfile Same as the Profile field in the Source settings.

-Target.MapiProfile Same as the Profile field in the Target settings.

-Source.MapiStore Same as the Store field in the Source settings.

-Target.MapiStore Same as the Store field in the Target settings.

-Source.AuthTokenFile File location of the authentication token that provides access to

the account whose Email address is in the Source settings.

-Target.AuthTokenFile File location of the authentication token that provides access to

the account whose Email address is in the Target settings.

-Source.ImapConfig Location of the configuration file that represents the IMAP

account in the Source settings.

-Target.ImapConfig Location of the configuration file that represents the IMAP

account in the Target settings.
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15 Adding header metadata

Aid4Mail faithfully preserves all available metadata in the email header during conversion

from one mail format to another. However, some source mail formats include proprietary

header fields that don't exist in the target. In addition, some target folder structure options

do not reflect their source counterparts. In such cases, Aid4Mail provides additional

metadata fields that can be added to the header of a target email by selecting Add extra

metadata to email headers in the Target settings.

Why add additional metadata?

There are two main reasons for adding additional metadata to an email message header:

1. To preserve the original content of header fields after conversion to a target format that

does not support those header fields, or that changes them. 

An example of this would be converting from Thunderbird to EML. Thunderbird

mailboxes use From delimiters to separate one email from the next. This is in addition

to the regular From header fields which can contain different information. EML does not

use From delimiters so they will be lost after conversion. However, Aid4Mail can

preserve them by adding proprietary X-From header fields to contain them. This means

that the original From delimiters are always available for forensic analysis. It also means

that if the EML files are subsequently converted back to Thunderbird, even after

conversion to other formats in the meantime, the original From delimiters can be

recreated instead of creating new ones. This will be done automatically if the X-From

field is detected.

2. To preserve the email’s original folder hierarchy after conversions that change the folder

structure.

For example, if a session’s target folder structure is set to Flat (everything in the same

folder), the original folder structure will be lost. However Aid4Mail can preserve a copy

of the source folder hierarchy in an X-Folder header field. This makes it available for

forensic analysis. It also means that the original folder structure can be subsequently

recreated, even after multiple conversions, by selecting Use X-Folder metadata as the

target folder structure option.
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List of additional header fields

Aid4Mail can add the following header fields to target emails when Add extra metadata to

email headers is selected in the Target settings. The exact combination of header fields

added depends on the source mail format and the content of the source email header.

All source formats
· X-From

Proprietary header field containing the From delimiter for this email. It is only added if

the source format uses From delimiters to separate one email from the next (for example

Thunderbird or mbox).

· X-Folder

Proprietary header field containing the email’s source folder hierarchy.

· Status and X-Status

Standard MIME headers that contain one or more status flags (described below). These

headers are rarely used, having been replaced by proprietary fields added by email

clients. However, when the proprietary fields are not present and this option is on,

Aid4Mail will add status information gleaned from index files or folder locations to these

two fields.

Flag options for the Status header: 

o R = Read

o O = Old

o U = Unread

o No value = New

Flag options for the X-Status header:

o A = Replied

o D = Deleted

o F = Flagged

o W = Forwarded

o No value = None of the above

Example: The following header flags signify an email that has been read, is old and has

been replied to and deleted.
Status: RO
X-Status: AD
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Outlook/Exchange as source format
· X-MAPI-Categories

Represents the proprietary MAPI field PidNameKeywords and contains any

Outlook/Exchange categories assigned to the email. For example:
X-MAPI-Categories: Transferred to SharePoint; Important Mail; Teams Mail;
For Later; Not Important

· X-PR-CREATION-TIME

Represents the proprietary MAPI field PR_CREATION_TIME

· X-PR-ENTRYID

Represents the proprietary MAPI field PR_ENTRYID

· X-PR-ICON-INDEX

Represents the proprietary MAPI field PR_ICON_INDEX

· X-PR-LAST-MODIFICATION-TIME

Represents the proprietary MAPI field PR_LAST_MODIFICATION_TIME

· X-PR-MESSAGE-CLASS

Represents the proprietary MAPI field PR_MESSAGE_CLASS

· X-PR-STORE-ENTRYID

Represents the proprietary MAPI field PR_STORE_ENTRYID

IMAP as source format
· X-Email-UID

A unique ID that combines two proprietary IMAP fields: The email UID and the folder

UID, separated by a period.

· X-IMAP-Flags

Represents the proprietary IMAP FLAGS field which consists of both standard IMAP flags

and any proprietary flags specific to the IMAP server. Standard flags are prefixed with a

backslash character (\) and proprietary flags with a dollar symbol ($). All flags are

separated by a space. For example: 
\Answered \Flagged \Seen $Forwarded $Junk

· X-Date-Stored

Represents the proprietary IMAP field INTERNALDATE.
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16 Processing archival formats

Aid4Mail Enterprise supports three major archive export formats:

1. Google Vault (zipped mbox files)

2. Mimecast (zipped EML SJF files)

3. Proofpoint (password-protected zipped EML files)

At the time of writing, Aid4Mail Enterprise is the only tool on the market that can search

and convert these archives in their native form. With Google Vault archives, Aid4Mail not

only preserves email status information (unread, read, replied, sent, etc.) but can also

restore the original folder structure. With Proofpoint and downloaded Mimecast exports,

Aid4Mail has the unique ability to reorganize exports by email account, saving hours (if not

days) of manual work!

For information on how to process these formats, please refer to the following How to

tutorials on our website:

· How to process Google Vault exports

· How to process Mimecast exports

· How to process Proofpoint exports

https://help.fookes.com/support/solutions/articles/9000197755-how-to-process-google-vault-exports-aid4mail-5-enterprise-license-
https://help.fookes.com/support/solutions/articles/9000197104-how-to-process-mimecast-exports-aid4mail-5-enterprise-license-
https://help.fookes.com/support/solutions/articles/9000197664-how-to-process-proofpoint-exports-aid4mail-5-enterprise-license-


243

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Multiple sessions

17 Multiple sessions

What is a session?

A session can be thought of as an independent instance of the Aid4Mail processing engine.

Aid4Mail allows you to work with one session at a time or with multiple sessions, enabling

you to set up a whole project of related email processing tasks.

Setting up multiple sessions

To set up multiple sessions, first open the session list by selecting View > Show/Hide

session list from the menu or Show/Hide session list in the task bar. Once the session list is

open, you will notice additional items on the button bar and in the session menu. These

allow you to add a new session, duplicate an existing one, delete or reset it and move

sessions around. 

The following screenshot shows a project with three sessions. It is an implementation of

Example 1 in the example scenarios below:
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Project with three sessions to implement Example 1

Running multiple sessions

All Aid4Mail editions allow you to set up multiple sessions and to run, pause and stop the

currently selected session. 

Aid4Mail Converter can only run one session at a time. You can still set up multiple sessions

but the next session can only be run once the current one has finished processing. If you

have multiple sessions set up, you will need to continually return to the computer to

manage them one at a time.
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Aid4Mail Enterprise and Investigator can run single sessions like Aid4Mail Converter. In

addition, they can run all the sessions in the list, either consecutively or concurrently, and

pause all and stop all. Any sessions not yet running will be placed in a queue and

automatically run when it's their turn. There's no need to return to the computer to manage

each session. Aid4Mail does it for you, unattended, whether it takes hours, days or weeks to

complete.

Why run multiple sessions?

There are two major time-saving benefits from running multiple sessions:

1. Set up your whole project in advance and then let it run in your absence while you're

doing something else. Whether you're a forensics professional processing multiple mail

sources belonging to the same suspect, or an IT technician migrating thousands of

employee accounts to a new mail system, this can be a huge time saver.

2. Mail is processed significantly faster when multiple engines can work on it at the same

time. Each session runs independently, on a separate thread, maximizing your

computer's resources. This is optimized even further when Aid4Mail is running on a

multi-core or multi-processor system. 

Processing order

When running multiple sessions, they are processed in the order they appear in the session

list. The list can be rearranged as required before you select Run all.

Consecutive vs Concurrent processing

In Aid4Mail Enterprise and Investigator, you can set the maximum number of sessions that

can be run concurrently. When set to 1, the sessions will be processed consecutively.  When

set to a value greater than 1, then up to that number of sessions will be processed

simultaneously at any given time.

Consecutive processing
Consecutive processing is useful if you want to use the target mail of one session as the

source of another. It's also necessary when your Bates numbering scope is set to Project or

Global. 

With consecutive processing, the first session is run and the others are placed in a queue.

Once a session finishes processing, the next one will automatically be run. This continues,
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one session after the other, until there are no sessions left in the queue. The whole process

is automated and there is no need to intervene, even for large projects.

Concurrent processing
Concurrent processing is useful in larger projects where having multiple Aid4Mail engines

working together can significantly reduce the project's duration.

With concurrent processing, multiple sessions run simultaneously. Each runs in its own

thread, making optimal use of the computer's resources. Remaining sessions are placed in

a queue. When a session finishes processing, the next one will automatically be run by the

available thread until all sessions are complete. Again, no need for user intervention.

For example, say you have set the maximum number of sessions running concurrently to 5

and have set up 10 sessions. When you select Run all, the first 5 sessions in the list will start

processing at the same time. When one of them finishes, session 6 will start automatically.

When the next one finishes, session 7 will launch. This will continue, with 5 sessions

processing simultaneously at any given moment, until all 10 sessions have been

completed. 

How many sessions can be processed concurrently?
In theory, as many as you want. However, in reality, it depends on the capabilities of the

computer running Aid4Mail. Generally, the default value for the maximum number of

sessions running concurrently works well for most modern computers. If you have an older

system, you can reduce the number. If you have a powerful one with multiple cores, you

could consider increasing it. Note that this does not limit how many sessions you can set

up, just how many will run at the same time.

Sharing source and target mail across multiple sessions

Source mail files or accounts can be shared by any number of sessions because they are not

altered or locked by Aid4Mail. 

In many cases, target files can also be shared by multiple sessions although it depends on

the format:

· Target PST files, IMAP and Gmail accounts can be shared by multiple sessions.

· Target EML and MSG folders can be shared as long as the files being created in these

folders are not shared.

· Target Mbox, Thunderbird, EML and MSG files cannot be shared across sessions.
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Example multi-session scenarios

Example 1
A forensic examiner may use multiple sessions to process different mail sources belonging

to a suspect and compile the results in a single PST file. The first session might use the

suspect's online Gmail account as source, the second may be mail from their Thunderbird

application that does not exist on the server, and the third session source might be an

mbox file containing archived mail found on the suspect's computer. All three sessions

would use the same target PST file to compile the results together.

Example 2
An IT technician may want to use multiple sessions to migrate all of the company

employees from one live mail system to another. The first session may have John's Gmail

account as source and his new Office 365 account as target. The second session would do

the same for Sally's mail accounts, the third session for Leroy's, and so on for all employees.

Example 3
An archiving project may involve separating one huge file, containing all company mail

and obtained by exporting from an old archival system, into multiple individual archives,

one for each employee. All sessions would have the same source mbox file but use a

specific filter and target PST file for each employee. The filter would ensure that only mail

sent to or from that employee ends up in their archive. UPDATE: This can now be done

even more simply using the {EmailAccount} token in a filename template.

Example 4
An eDiscovery analyst may use multiple sessions to categorize an individual's mail. The

same mail source would be used by all sessions. The target format may be a single PST file,

also shared by all sessions, with each session using a unique filter to separate mail into

different folders inside the PST file.
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18 Duplicating sessions

Creating a single duplicate session

When multiple sessions are enabled, you can use the Session > Duplicate menu command

or the Duplicate button to create a duplicate of the currently selected session. The new

session will be created directly below the session it's duplicating in the session list and will

become the selected session. 

With the exception of the session name, both sessions will contain identical settings

including any that are blank. You can subsequently edit their settings independently as the

two sessions are not linked in any way. However, any source or target mail specified before

duplication will be shared by both sessions unless subsequently edited. The exception to

this is when wildcards are used, as explained next.

Creating multiple duplicate sessions

Certain projects require multiple sessions to be set up with almost identical settings. For

example, an archival project that saves multiple employee accounts to separate PST files.

Its sessions may all have the same settings except for the source and target file locations. 

This can be accomplished in more than one way. For very large-scale projects, with

hundreds or thousands of sessions, using Aid4Mail Enterprise's command-line interface

may be appropriate. For smaller projects, Aid4Mail allows you to create multiple duplicate

sessions using wildcards.

Duplicating sessions using wildcards
With certain source formats, you can use the asterisk (*) or question mark (?) wildcards in a

filename or folder name when duplicating a session. The asterisk matches one or more

characters and the question mark matches a single character (just like in Windows file

dialogs).

Aid4Mail knows whether it's a filename or a folder name based on the presence or absence

of a period (.) character. For example, *.pst and Export-*.pst are both interpreted as

filenames whereas Export-* will be seen as a folder name.

When you duplicate a session that uses wildcards in this manner, Aid4Mail will replace the

file/folder name in this session with the full name of the first file/folder that matches the

pattern. It will then create new, duplicate sessions for every remaining file/folder that

matches the pattern. This is demonstrated in the examples below.
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Wildcards in a source filename
Wildcards can be used in a source filename when duplicating a session with one of the

following source formats:

· Google Vault

· Mimecast

· Proofpoint

· PST

Wildcards in a source folder name
Wildcards can be used in a source folder name when duplicating a session with one of the

following source formats:

· EML

· Google Takeout

· Maildir

· mbox

· Mimecast

· Msg

· Proofpoint

· SeaMonkey 

· Thunderbird 

Asterisk wildcard in a target file/folder name
When a wildcard is used in a source file/folder name, an asterisk wildcard can also be

placed in the target file/folder name. This acts as a placeholder for the corresponding

source name. After duplication, the newly created sessions will each have a target

file/folder name that match its source (but usually with a different file extension, if any).

The three examples, below, clarify this process.

Asterisk wildcard in a session name
Similarly, an asterisk wildcard can be placed in the session name, acting as a placeholder

for the corresponding source file/folder name. Example 1 and Example 3, below,

demonstrate this.

Examples
The following three examples demonstrate the use of wildcards when duplicating sessions:

· Example 1

· Example 2
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· Example 3
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18.1 Duplicating sessions: Example 1

In this example, four employee's PST files need to be converted to EML. This requires four

sessions because Aid4Mail can only process one PST file at a time. 

The following folder contains the four PST files:

C:\Employee PST\

The files inside are:

Leroy.pst

Sally.pst

Mike.pst

Judy.pst

Select PST as your source format and enter the following location in the source PST file

field:

C:\Employee PST\*.pst

Select EML as your target format and enter the following in the target Location field:

C:\Employee EML\*

Aid4Mail knows this is a folder name and not a file name because of the absence of a

period (.) in the name.

Enter the following in the Session name field:

Session-*

Next, configure any other settings that need to be identical across all four sessions. 

Finally, select the Session > Duplicate menu command or the Duplicate button. Aid4Mail

will replace the filename pattern in this session with the name of the first PST file. It will

then create three new, duplicate sessions: one for each of the remaining three PST files that

match the pattern. 

The source PST file fields for the four sessions will be:

C:\Employee PST\Leroy.pst
C:\Employee PST\Sally.pst
C:\Employee PST\Mike.pst
C:\Employee PST\Judy.pst
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The target Location fields for the four sessions will contain folder names that match the

source PST filenames:

C:\Employee EML\Leroy
C:\Employee EML\Sally
C:\Employee EML\Mike
C:\Employee EML\Judy

The Session name fields for the four sessions will also contain the text that matches the

wildcard:

Session-Leroy
Session-Sally
Session-Mike
Session-Judy

You can then run all the sessions if you have Aid4Mail Enterprise or Investigator, or run

them one by one if you have Aid4Mail Converter.
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18.2 Duplicating sessions: Example 2

In this example, Mimecast has delivered four archives on an external hard drive. They are

already organized by account and have been copied over to the computer running

Aid4Mail. Each account needs to be converted to PST which requires four Aid4Mail

sessions. Note that Mimecast is only available as a source format when you're running

Aid4Mail Enterprise.

The following folder contains the four Mimecast archives:

C:\Mimecast archives\

The files inside are:

leroy@aid4mail.com_20121201_20121231_US334-13.000001.zip

sally@aid4mail.com_20121201_20121231_US334-13.000001.zip

mike@aid4mail.com_20121201_20121231_US334-13.000001.zip

judy@aid4mail.com_20121201_20121231_US334-13.000001.zip

Select Mimecast as your source format and enter the following in the source Location field:

C:\Mimecast archives\*.zip

Select PST as your target format and enter the following in the target PST file field:

C:\PST archives\*.pst

Next, configure any other settings that need to be identical across all four sessions. 

Finally, select the Session > Duplicate menu command or the Duplicate button. Aid4Mail

will replace the filename pattern in this session with the name of the first Mimecast archive.

It will then create three new, duplicate sessions: one for each of the remaining three

archives that match the pattern. 

The source Location fields for the four sessions will be:

C:\Mimecast archives\leroy@aid4mail.com_20121201_20121231_US334-13.000001.zip
C:\Mimecast archives\sally@aid4mail.com_20121201_20121231_US334-13.000001.zip
C:\Mimecast archives\mike@aid4mail.com_20121201_20121231_US334-13.000001.zip
C:\Mimecast archives\judy@aid4mail.com_20121201_20121231_US334-13.000001.zip

The target PST file fields for the four sessions will contain PST filenames that match the

Mimecast source names:

C:\PST archives\leroy@aid4mail.com_20121201_20121231_US334-13.000001.pst
C:\PST archives\sally@aid4mail.com_20121201_20121231_US334-13.000001.pst
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C:\PST archives\mike@aid4mail.com_20121201_20121231_US334-13.000001.pst
C:\PST archives\judy@aid4mail.com_20121201_20121231_US334-13.000001.pst

You can then run all the sessions.



255

Aid4Mail™ 5 User Guide 
 
                                                                                                                                                                                                  Copyright © 2005-2021 FOOKES® Holding Ltd

Duplicating sessions

18.3 Duplicating sessions: Example 3

In this example, four employee's EML folders need to be converted to Mbox archives. This

could be done simply using a single session because Aid4Mail can create a separate Mbox

file for each EML folder it encounters. However, using multiple sessions that are running

concurrently can significantly speed things up. 

The following folder contains the four EML folders:

C:\Employee EML\

The folders inside are:

leroy@aid4mail.com

sally@aid4mail.com

mike@aid4mail.com

judy@aid4mail.com

Select EML as your source format and enter the following location in the source Location

field:

C:\Employee EML\*

Aid4Mail knows this is a folder name and not a file name because of the absence of a

period (.) in the name.

Select mbox as your target format and enter the following in the target Location field:

C:\Employee Mbox\*.mbox

In the Session name field, simply enter an asterisk (*).

Next, configure any other settings that need to be identical across all four sessions. 

Finally, select the Session > Duplicate menu command or the Duplicate button. Aid4Mail

will replace the folder name pattern in this session with the name of the first EML folder. It

will then create three new, duplicate sessions: one for each of the remaining three EML

folders that match the pattern. 

The source Location fields for the four sessions will be:

C:\Employee EML\leroy@aid4mail.com
C:\Employee EML\sally@aid4mail.com
C:\Employee EML\mike@aid4mail.com
C:\Employee EML\judy@aid4mail.com
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The target Location fields for the four sessions will contain Mbox filenames that match the

EML source folders:

C:\Employee Mbox\leroy@aid4mail.com.mbox
C:\Employee Mbox\sally@aid4mail.com.mbox
C:\Employee Mbox\mike@aid4mail.com.mbox
C:\Employee Mbox\judy@aid4mail.com.mbox

The Session name fields for the four sessions will also reflect the folder names:

leroy@aid4mail.com
sally@aid4mail.com
mike@aid4mail.com
judy@aid4mail.com

You can then run all the sessions if you have Aid4Mail Enterprise or Investigator, or run

them one by one if you have Aid4Mail Converter.
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19 Bates numbering

Definition

Bates numbering is a system of unique identification used for documents in the forensic,

legal, business and medical fields. Although there is no standard for Bates numbering, it

usually consists of a combination of text and sequential numbering, sometimes with the

addition of a time stamp, to create a unique ID for each item.

Aid4Mail implements Bates numbering by providing a Bates number and a formatted

Bates stamp.

Bates number

Aid4Mail's Bates number is a sequential counter that is automatically incremented by 1 for

every item processed. In Aid4Mail Enterprise and Investigator, you can set the Bates

number's start value in the Bates section of the project settings and its scope in the App

section of the Options screen. In Aid4Mail Converter, default values are used.

When the scope is Global, the Bates number increments across all sessions and projects.

With a Project scope, it will be set to 1 at the start of each new project but will increment

across all sessions in the project. Using a Session scope, the Bates number will be set to 1

for each new session which allows for concurrent processing.

The Bates number can be accessed through the {BatesNumber} token for use in templates.

It can be combined with text and/or other template tokens that represent properties of the

email message being processed, the current session and project, the case it's part of, and

the computer system running Aid4Mail. The unique ID created can then be used in file or

folder names or inserted directly into an email. 

The Bates number can also be accessed through the flt_BatesNumber and

mod_BatesNumber variables for use in Python scripts. In addition, the mod_BatesNumber

variable allows for modifications to its value.

Bates stamp

The Bates stamp is a formatted version of the Bates number with a fixed number of digits

and an optional prefix and/or suffix. This allows for standardization as the stamp is always

the same length. The prefix and suffix can contain text, other template tokens or both,

providing lots of flexibility.
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In Aid4Mail Enterprise and Investigator, you can configure the Bates stamp in the Bates

section of the project settings. In Aid4Mail Converter, default values are used.

The Bates stamp can be accessed through the {BatesStamp} token for use in templates and

can be further combined with text and/or other template tokens if necessary. As with the

Bates number, it can be used in file or folder names or inserted directly into an email. 

The Bates stamp can also be accessed through the flt_BatesStamp and mod_BatesStamp

variables for use in Python scripts. In addition, the mod_BatesStamp variable allows for

modifications to its value.

Example 1

A simple Bates stamp, with project-level scope and JohnDoe- as a prefix, would produce

the following naming scheme:

JohnDoe-00000001.eml

JohnDoe-00000002.eml

JohnDoe-00000003.eml

JohnDoe-00000004.eml

etc.

Example 2

John Doe's mail is spread across a Gmail account, an Outlook PST file, and several mbox

archives. You set up three sessions to convert it all to EML and name them JohnDoe-Gmail,

JohnDoe-PST and JohnDoe-Mbox.  Using a Bates stamp with session-level scope, and

{SessionName}- as a prefix (the {SessionName} token followed by a hyphen), the following

files would be created:

JohnDoe-Gmail-00000001.eml

JohnDoe-Gmail-00000002.eml

JohnDoe-Gmail-00000003.eml

etc.

JohnDoe-PST-00000001.eml

JohnDoe-PST-00000002.eml

JohnDoe-PST-00000003.eml

etc.

JohnDoe-Mbox-00000001.eml
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JohnDoe-Mbox-00000002.eml

JohnDoe-Mbox-00000003.eml

etc.
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20 Templates

Templates can be used in Aid4Mail in different 3 ways:

1. To specify the folder structure of your target mail. This is useful for merging or splitting

folders, or for grouping emails based on specific characteristics like the email account,

date or status . 

2. To customize filenames when your chosen target mail format uses individual files for

each email message (MSG, EML, Plain text, HTML, PDF or XML).

3. To define the content of the HTML index file created when your target mail is HTML and

the Create HTML index file option is turned on.

When a template is used, it is applied to every email processed in a session.

Templates are easy to create using a simple syntax that combines text with tokens that

represent properties of the email being processed and the Aid4Mail session and project

that’s processing it. Text can also be used inside tokens to provide increased control of the

output or, in some cases, to refine or format it.

In this section:

· Folder structure templates

· Filename templates

· Combining templates

· Template tokens

· Text inside template tokens

o Refining the {EmailAccount} token

o Formatting date tokens
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20.1 Folder structure templates

You can customize the folder structure of your target mail using a template. Aid4Mail will

place each target email into the appropriate folder within the structure.

Setting up a folder structure template

Enter your template in the Folder structure template field, located under Target on

Aid4Mail’s Settings screen. This field is only available once you’ve selected Use a template

in the Folder structure field. 

You can use the Insert button above the Folder structure template field to insert template

tokens.

Understanding folder structure templates

A folder structure template consists of the names of each level of the folder structure,

separated by backslash characters (\). 

Example 1
The following, very basic, folder structure template illustrates the concept:

ConvertedMail\FirstTest

It tells Aid4Mail to create a simple target folder structure with the top level named

ConvertedMail and the next level named FirstTest:
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Using tokens
Usually you will want at least part of the folder structure to be dependent on some

property of the email, or of the session or project. Template tokens enable you to do this.

Example 2
In the following template, the second level of the folder structure is the email address of

the message sender. It uses the {SenderAddress} token to do this:

 ConvertedMail\{SenderAddress}

The resulting folder structure would still have ConvertedMail as the top level but there are

multiple second level folders, one for each sender address. Aid4Mail will ensure that emails

from each address are placed in the correct folder.

Example 3
Some tokens represent properties that are independent of the email being processed. For

example, {CurrentDate} represents the current system date. It might be used like this:

 ConvertedMail-{CurrentDate:yyyy-mm-dd}\{SenderAddress}

This template will name the top level folder ConvertedMail- followed by the current date,

formatted to show only the year, month and day (see Formatting date tokens for details of

how to do this). It doesn't include the time because that would be different for every email.

The second level of the folder structure will be named after each different sender address

as before:
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See the Template tokens topic for a full list of tokens that can be used in Aid4Mail

templates. Note that certain characters are illegal in operating systems and should be

avoided in folder and filename templates.
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20.2 File name templates

If your selected target target format consists of individual files (MSG, EML, Plain text, HTML,

PDF or XML), you can customize the target filenames using a template. 

How to set up a filename template

Enter your template in the File name template field, located under Target on Aid4Mail’s

Settings screen. This field is only available once you’ve selected Use a template in the File

name field:

You can use the Insert button above the File name template field to insert template tokens.

Understanding filename templates

A filename template usually consists of some text and a token.

Example 1
This simple example uses the {BatesNumber} token:

Email-{BatesNumber}

It would create the filenames Email-1, Email-2, Email-3, etc. as the counter is incremented

for each email processed. You don’t have to specify a file extension as it will be added

automatically based on your chosen target format, as shown below.
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This concept is explored further in the Bates numbering topic.

Example 2
The following template uses the {SenderName} and {LocalMessageDate} tokens to create

filenames based on the name of the message sender along with the message date in local

time. The date is formatted to display the year, month and day (see Formatting date tokens

for details of how to do this):

{SenderName} {LocalMessageDate:yyyy-mm-dd}

It would produce filenames such as these:

The Template tokens topic contains a full list of tokens that can be used in Aid4Mail

templates. Note that certain characters are illegal in operating systems and should be

avoided in folder and filename templates.
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20.3 Combining templates

Using templates for both your folder structure and filenames can help organize your

converted mail. For example:

Folder structure template: ConvertedMail\{SenderName}

Filename template: {BatesCounter} - {SenderName} -
{LocalMessageDate:yyyy-mm-dd}

These would produce the following folder structure and filenames:

See the Template tokens topic for a full list of tokens that can be used in Aid4Mail

templates. Note that certain characters are illegal in operating systems and should be

avoided in folder and filename templates.
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20.4 Template tokens

What are template tokens?

Template tokens are placeholders for variable content that's used in Aid4Mail templates.

They can represent properties of the email message being processed, the current session

and project, the case it's part of and the computer system running Aid4Mail. Tokens also

provide access to the Bates number and Bates stamp.

All the tokens available for use in Aid4Mail templates are listed below.

Using template tokens

Tokens can be combined with text to create templates as shown in the examples in the

Folder structure templates, Filename templates and Combining templates topics. 

Text can also be placed inside tokens. The advantage of this approach is that, when the

token is empty, the additional text is not displayed. See the Texts inside template tokens

topic for details.

Text inside the {EmailAccount} token, and in most date tokens, is treated differently. In the

{EmailAccount} token, it allows you to limit the list of account email addresses. In date

tokens, except {RawMessageDate}, it allows you to format the date. Please refer to the

Refining the {EmailAccount} token and Formatting date tokens topics for details.

List of template tokens

All the tokens available for use in Aid4Mail templates are listed below, grouped in the

following categories. 

· Bates tokens

· Case tokens

· Date tokens

· Email tokens

· File tokens

· Flag tokens

· Folder tokens

· Hash tokens

· Page tokens

· Project tokens

· Session tokens
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Bates tokens

Token Value

{BatesNumber} A whole number starting at 1 and incremented for each email

message (or non-email item) processed. Please refer to the Bates

numbering topic for more information.

{BatesStamp} A Bates stamp comprising the {BatesNumber}, formatted to a specific

number of digits, along with an optional prefix and suffix.

Case tokens

Token Value

{CaseDate} Case date as specified in the project settings.

{CaseID} Case ID as specified in the project settings.

{CaseLocation} Case location as specified in the project settings.

{CaseName} Case name as specified in the project settings.

{EvidenceID} Evidence ID as specified in the project settings.

{InvestigatorName}Investigator name as specified in the project settings.

{LabID} Lab ID as specified in the project settings.

Date tokens
With the exception of {RawMessageDate}, date tokens are formatted to the International

Date Format by default. However, colon characters (:) that separate the hours, minutes and

seconds are replaced with hyphens (-). This is because colons are illegal characters in

Windows folder and filenames. You can customize formatted dates. Please refer to the

Formatting date tokens topic for details.

Token Value

{RawMessageDate} Message Date field from the header of the email message currently

being processed. It is not formatted and appears exactly as in the

email header. Its layout depends on the source mail format being

processed but typically looks something like this: Thu, 27 Jun 2013

21:08:12 +0300. 
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Token Value

This raw date cannot be formatted like other date tokens. However,

you can still add text inside the token. It's primary use is in the

items.html template that defines the index created when HTML is the

target format and the Create HTML index file option is turned on.

{LocalMessageDate}The date in {RawMessageDate} converted to the local time zone of

the host computer and formatted.

{UtcMessageDate} The {RawMessageDate} converted to Coordinated Universal Time

(UTC) and formatted.

{CurrentDate} Current system date of the computer running Aid4Mail, formatted.

{SessionRunDate} System date of the computer running Aid4Mail at the time the

session was run, formatted.

Email tokens

Token Value

{EmailAccount} Only available in Aid4Mail Enterprise and Investigator.

Any email address found in the From, To, Cc or Bcc fields of the email

header. Please refer to the Refining the {EmailAccount} token topic

for details of how to customize this token. 

{MessageId} Message-ID field from the email message header.

{SenderAddress} Email address used to send the message.

{SenderName} Name of the person who sent the email message.

{Subject} Subject line of the email message.

{Thread} Value of the Thread-Index or In-Reply-To field from the email

message header.

File tokens

Token Value

{Filename} The filename of the source email or mailbox being processed, or

blank if there is no filename (for example when processing cloud-

based accounts).
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Flag tokens

Token Value

{HasAttachment} Attachments if the email message contains one or more attachments,

otherwise empty.

{IsDuplicate} Duplicates if the email message contains one or more duplicates,

otherwise empty. Note that the Duplicates detection scope option

affects how this token works.

{IsForwarded} Forwarded if the email message has been forwarded, otherwise

empty.

{IsRead} Read if the email message has been read, otherwise empty.

{IsReplied} Replied if the email message has been replied to, otherwise empty.

{IsStarred} Starred if the email message has been starred, otherwise empty.

{IsUnpurged} Unpurged if the email message is unpurged, otherwise empty.

{IsUnread} Unread if the email message has been not been read, otherwise

empty.

{Origin} Either Inbound or Outbound, depending on the nature of the message,

or empty if this cannot be determined from the folder type or email

header flags.

{PrimaryStatus} Status of the message taken from the email header. If multiple

statuses are defined, it is the most important one.

Folder tokens

Token Value

{FolderId} ID of the folder that contains the email message.

{FolderName} Name of the folder that contains the email message, i.e. the bottom-

most folder in {FolderPath}. For example, if {FolderPath} is

Customers\2018\04 then {FolderName} is 04. If {FolderPath} is

empty then so is {FolderName}.

{FolderPath} Full path of the folder that contains the email message, relative to the

source location. For example, Customers\2018\04. If the email is

directly in the source location folder rather than one of its subfolders

then {FolderPath} is empty.
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Token Value

{FolderType} The type of folder that contains the email. If this can be identified

then it will be one of the following values:

inbox
sent
drafts
outbox
spam
trash

starred
important
archive
calendar
contacts

journal
notes
tasks
chats
rssfeeds

If the folder type can’t be identified then the token value is blank.

{TopFolderName} Name of the top-most folder in {FolderPath}. For example, if

{FolderPath} is Customers\2018\04 then {FolderTop} is Customers.

If {FolderPath} is empty then so is {FolderTop}.

Hash tokens

Token Value

{Fnv1a} 64-bit FNV-1a hash code based on the email Message-ID field (or on

a combination of other header fields if Message-ID is missing).

{MD5} MD5 hash code based on the email Message-ID field (or on a

combination of other header fields if Message-ID is missing).

{Sha1} SHA-1 hash code based on the email Message-ID field (or on a

combination of other header fields if Message-ID is missing).

{Sha256} SHA-256 hash code based on the email Message-ID field (or on a

combination of other header fields if Message-ID is missing).

{Sha512} SHA-512 hash code based on the email Message-ID field (or on a

combination of other header fields if Message-ID is missing).

Page tokens

Token Value

{PageCount} The total number of pages in a target document.

{PageNumber} The current page number in a target document.
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Project tokens

Token Value

{ProjectName} Project name as specified in the project settings.

Session tokens

Token Value

{SessionId} Unique ID that's automatically generated for the session.

{SessionName} Session name as specified on the Settings screen.
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20.5 Text inside template tokens

The benefit of text inside tokens

Tokens can be combined with text as shown in the examples in the Folder structure

templates and Filename templates topics. However, text can also be placed within tokens. 

The advantage of this approach is that, when the token is empty, the additional text is not

displayed.

For example, the {Origin} token has three possible values. The first is Inbound, the second is

Outbound and the third value is nothing at all (the token is empty). The latter happens when

an email cannot be identified as either inbound or outbound. A draft email may fall into

this category. However this can be problematic if you’re combining the {Origin} token

with text. For example:

{Origin}-Mail

If the value of {Origin} is Inbound, then the above template will produce Inbound-Mail.

Likewise, if the token’s value is Outbound then the template will produce Outbound-Mail.

But if the email is a draft, and {Origin} is empty, then the template will produce -Mail

which is less useful. Placing the additional text inside the token solves this problem:

{Origin:-Mail}

Text is added inside a token by following the token name with a : (colon) and then with the

text you want to add. If the token’s value is empty then the additional text inside is not

added. In our example, the template will now produce either Inbound-Mail, Outbound-Mail

or it will be blank. 

Placeholders

By default, text inside the token will be appended to the token value. However you can

specify the token’s position within the text using the ^* placeholder, like this:

{Origin:Jack-^*-Mail}

The token value will replace the ^* placeholder unless it is empty, in which case none of the

text will be displayed. So the three possible outcomes of this template would now be: Jack-

Inbound-Mail, Jack-Outbound-Mail or blank.
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Truncating text inside tokens

If you know that a token’s value may produce text that’s too long, you can truncate it using

^[n] where n is the maximum number of characters allowed. The final character will be an

ellipsis (…). This means that ^[10] will use the first 9 characters of the token’s value with the

tenth character being an ellipsis. This option is useful when using the {Subject} token

because email subject lines can often be fairly long. Truncating them makes them shorter,

and all the same length, which is useful in filenames.

For example:

{Subject:^[30]}

If the email subject line was: Hi from the Jones family on vacation in Greece enjoying sunset

at the beach

The token’s value would be: Hi from the Jones family on v…

The truncated token value can be placed at any position in additional text, like this:

{Subject:Subject - ^[30]}

The template would now produce: Subject - Hi from the Jones family on v…

Refining the {EmailAccount} token and formatting date tokens

Text inside the {EmailAccount} token, and in most date tokens, is treated differently. In the

{EmailAccount} token, it allows you to limit the list of account email addresses. In date

tokens, except {RawMessageDate}, it allows you to format the date. Please refer to the

following sub-topics for details:

· Refining the {EmailAccount} token

· Formatting date tokens
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20.5.1 Refining the {EmailAccount} token

Limiting the email addresses

By default, the {EmailAccount} token matches any email address found in the From, To, Cc

or Bcc fields of the email header. You can limit the addresses that will result in a match by

listing them inside the token, after a colon (:). For example, the following token will only

match the email address alice@aid4mail.com:

{EmailAccount:alice@aid4mail.com}  

Multiple addresses can be separated by the vertical bar (|) OR operator. For example, this

token will match both alice@aid4mail.com and trevon@aid4mail.com: 

{EmailAccount:alice@aid4mail.com|trevon@aid4mail.com}

Wildcards

The * and ? wildcards can also be used in an email address although they will operate

slightly differently in this context. They will not be limited to a single word as they are with

search terms. This means they will match periods, parentheses or any other characters that

would normally delimit a word. The use of these two wildcards in this context is the same

as in the Windows Common File dialog and MS-DOS:

? matches a single character.

* matches zero or more characters (including word delimiters).

For example, the following token will match any email address in the aid4mail.com

domain, including those containing word-delimiter characters like

intern.helen@aid4mail.com:

{EmailAccount:*@aid4mail.com}

Folder structure example

A whole folder structure token using this technique might be:

EmployeeAccounts\{EmailAccount:*@aid4mail.com|*@admin.aid4mail.com} 

https://devblogs.microsoft.com/oldnewthing/20101124-00/?p=12213
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The  {EmailAccount} token in this example would match any email address in the

@aid4mail.com or @admin.aid4mail.com domains and would produce the following folder

structure (obviously depending on the actual accounts encountered):

Notice that:

· Each email address that matches the token has its own folder containing the relevant

emails.

· Emails with addresses that don't match the token are placed in the OTHER folder.

Adding additional text

You can still add additional text inside the {EmailAccount} token by placing your list of

email addresses inside the ^[] placeholder. For example:

EmployeeAccounts\{EmailAccount:Employee-^[*@aid4mail.com|
*@admin.aid4mail.com]}

This would produce the following folder structure (again, depending on the actual

accounts encountered):
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20.5.2 Formatting date tokens

In general, date tokens work differently to other tokens. The text inside them is primarily

used to format the date. This is the case for the following date tokens:

· {LocalMessageDate}

· {UtcMessageDate}

· {CurrentDate}

· {SessionRunDate}

The exception is {RawMessageDate}. Its content cannot be formatted and so text inside the

token is treated the same as with regular tokens (see the Text inside template tokens topic

for details). 

Default date values

The default, and only, value of {RawMessageDate} is the content of the message Date

field, exactly as it appears in the email message header and without any additional

formatting. Its layout depends on the source mail format being processed but typically

looks something like this: Thu, 27 Jun 2013 21:08:12 +0300. This raw date cannot be

formatted like other date tokens although text can be added inside the token to present

additional information.

All other date tokens are formatted by default to the International Date Format (extended

format). This includes both the date and the time, ordered from the largest to smallest unit

(YYYY-MM-DD hh:mm:ss). However, in this case, colon characters (:) that separate the hours,

minutes and seconds are replaced with hyphens (-). This is because colons are illegal

characters in Windows folder and filenames. 

Formatted dates therefore look like this by default: 2013-06-27 21-08-12. The year is

specified first followed by the month and day, separated by hyphens. A space separates

this block from the hours, minutes and seconds that are also separated by hyphens. This

layout is useful for folder and filenames as they will all have the same length and be in

chronological order when listed alphabetically. 

Custom formatting

You can customize formatted dates tokens by specifying a date pattern inside the token.

The table below describes the pattern symbols and shows the results they produce on the

following 2 dates:

Date 1: January 5, 2019 at 2 seconds after 9:08 am
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Date 2: December 25, 2019 at 56 seconds after 4:34 pm

Symbol Represents Result for date 1 Result for date 2

yy 2-digit year 19 19

yyyy 4-digit year 2019 2019

m 1 or 2-digit month 1 12

mm 2-digit month 01 12

mmm First 3 characters of the month Jan Dec

mmmm All characters of the month January December

d 1 or 2-digit day 5 25

dd 2-digit day 05 25

h 1 or 2-digit hour 

(uses 24-hour clock / military time)

9 16

hh 2-digit hour

(uses 24-hour clock / military time)

09 16

n 1 or 2-digit minute 8 34

nn 2-digit minute 08 34

s 1 or 2-digit second 3 56

ss 2-digit second 03 56

Note that:

· Pattern symbols are case-insensitive so using yyyymmdd-hhnnss gives the same result as

YYYYMMDD-HHNNSS.

· Hour symbols use the 24-hour clock (military time) so 2pm is presented as 14.

Example date patterns

Below are some example patterns using the {LocalMessageDate} token operating on an

email with the following message date in local time: January 5, 2019 at 2 seconds after 9:08

am.

{LocalMessageDate} produces 2019-01-05 09-08-02
{LocalMessageDate:yyyy-mm-dd hh-nn-ss} produces 2019-01-05 09-08-02
{LocalMessageDate:yyyymmdd-hhnnss} produces 20190105-090802
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{LocalMessageDate:yyyy-mm-dd} produces 2019-01-05
{LocalMessageDate:m-d-yy} produces 1-5-19
{LocalMessageDate:dd.mm.yy} produces 05.01.19
{LocalMessageDate:mmm yyyy} produces Jan 2019
{LocalMessageDate:mmmm d, yyyy} produces January 5, 2019
{LocalMessageDate:mmmm d, yyyy @ h.nn} produces January 5, 2019 @ 9.08

Adding additional text

You can still add additional text inside date tokens by placing your formatting pattern in

the ^[] placeholder. For example, the following produces the text Email date is January 5,

2019:

{LocalMessageDate:Email date is ^[mmmm dd, yyyy]}
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21 Python scripts

Python is an interpreted, high-level programming language and is the language of choice

for many forensic professionals. This is partly due to its use as a scripting language,

embedded in software products like Aid4Mail, to enable user-created functionality beyond

what's built in.

Aid4Mail Enterprise and Investigator support the use of Python scripts to add new features

to Aid4Mail. These include specialized filtering, data extraction, the modification of email

content and the customization of file and folder names. You can even use Python scripts to

create your own target mail formats and custom output.

Python installation

To use Python scripts in Aid4Mail, you will need to install Python on your computer.

Aid4Mail supports Python 3 and later versions. You can download installers from the

Python website. 

Note that Aid4Mail includes both 32-bit and 64-bit processing engines and automatically

selects the appropriate one depending on your Optimization settings (located in the

Advanced section of the Options screen). If you are running a session that includes a Python

script, and it's using Aid4Mail's 32-bit processing engine, you will need 32-bit Python

installed. Likewise if the session uses Aid4Mail's 64-bit processing engine then you will

need 64-bit Python installed in order to process the script. 

Unfortunately, Python does not install both 32 and 64-bit versions like Aid4Mail. It only

installs one at a time. Aid4Mail can usually find the default Python installation but does not

know if it's 32 or 64-bit. Running a Python script with the wrong bit version of Python will

generate an error.

For Windows users, the safest way of dealing with this is to install both 32 and 64-bit

versions of Python into separate folders. They can be downloaded from the Windows

downloads page on the Python website. The 32-bit version is referred to as the Windows

x86 executable installer. The 64-bit version is the Windows x86-64 executable installer. Once

installed, tell Aid4Mail where to find them by specifying their folder locations under

Options > Advanced > Python installation folders.

For Mac users, recent versions of Python are 64-bit only. The installer is referred to as the

macOS 64-bit installer and can be downloaded from the Mac downloads page of the

Python website. Once installed, tell Aid4Mail where to find it by entering the installation

folder location in the 64-bit field under Options > Advanced > Python installation folders.

https://www.aid4mail.com/redir/python
https://www.aid4mail.com/redir/python-downloads
https://www.aid4mail.com/redir/python-downloads-windows
https://www.aid4mail.com/redir/python-downloads-windows
https://www.aid4mail.com/redir/python-downloads-macos
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You will also need to select Prioritize memory access (64-bit engine) under Options >

Advanced > Optimization to tell Aid4Mail to prioritize its 64-bit engine.

Creating and modifying Python scripts

You can create Python scripts in any text editor or specialized code editor. Details of the

Python language are not covered in this guide. For this information, please consult the

Python website that contains a beginner's guide, tutorial, FAQ and documentation.

Python scripts contain your Python code and are stored in .py files in the Scripts folder,

usually under your application data folder.

If you save a script directly to this location, it will automatically become available in either

the Python modifier script or Python filter script drop-down list the next time you run

Aid4Mail. Alternatively, you can load an existing script from any location by using Add

above either of those drop-down lists. This effectively copies your script to the Scripts

folder (without deleting the original) and makes it available in the list.

You can view or modify an existing Python script by selecting Open above the Python

modifier script or Python filter script drop-down list. This will open the script in whatever

application you have associated with .py files. 

Aid4Mail includes a number of scripts bundled with the software. These are stored in your

Aid4Mail program folder and are automatically loaded in the aforementioned drop-down

lists when you first run Aid4Mail. You can customize these scripts too. Simply open a script

by selecting Open (above the drop-down list), make the necessary changes and save the

file. The modified file will automatically be saved in the Scripts folder, leaving the original

unchanged in the program folder.

Python scripts in Aid4Mail are grouped into two categories:

· Python filter scripts

· Python modifier scripts

https://www.aid4mail.com/redir/python
https://www.aid4mail.com/redir/python-beginners-guide
https://www.aid4mail.com/redir/python-tutorial
https://www.aid4mail.com/redir/python-faq
https://www.aid4mail.com/redir/python-docs
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21.1 Python filter scripts

Aid4Mail Enterprise and Investigator allow you to create your own custom filters using

Python scripts. Python filter scripts use the .flt.py file extension and are for use in the Python

filter script field in the filter settings.

A filter script is executed while a source email is being read and so is the first of the Python

scripts to be run. A filter script contains code that determines whether or not the email

currently being processed should be kept or discarded. This should result in a True or False

value that is then assigned to variable flt_Continue to tell Aid4Mail whether or not to

continue processing the email.

Example:
# Filter script that only continues processing the current email if it contains the word "aid4mail"
flt_Continue.Value = "aid4mail" in flt_ItemMime.Value

Note that the first line in the example above is a comment and so is ignored by the Python

interpreter. Comments start with a hash (#) character and extend to the end of the line.

They are useful to explain what the script does, as in this example.

Filter variables

Data in Aid4Mail is made available to your Python scripts through variables. Filter variables

are prefixed with flt_ and are only for use in filter scripts.

Aid4Mail's Python variables need to be appended with .Value whenever they're used. This is

a syntax requirement that enables the Python variables to interact with the Delphi

programming language used by Aid4Mail. For example:
flt_Continue.Value = "aid4mail" in flt_ItemMime.Value

The following Python filter variables are available in Aid4Mail. Note that they are case-

sensitive.

Variable name

flt_AppSettings Contains the filename of the settings used to configure the

current session. The file is stored in the standard INI format.

flt_BatesNumber Access the Bates number.

flt_BatesStamp Access the Bates stamp.

flt_Continue Use this variable to return your script’s filter result to

Aid4Mail. A Boolean result of True or False is expected. The

email is skipped when set to False. Alternatively, you can
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Variable name

assign the skip keyword to flt_ScriptStatus, which has the

same effect as flt_Continue = False.

flt_ItemFiles Provides a list of filenames of extracted attachments so they

can be analyzed by Python scripts and modules. Each

filename is stored in a separate line.

flt_ItemHeader Contains an unwrapped and decoded version of the email

header.

flt_ItemImages Provides a list of filenames of extracted image attachments

so they can be analyzed by Python scripts and modules. Each

filename is stored in a separate line.

flt_ItemMetadata Contains a list of metadata values in plain JSON format:

{

"Attachments"="",

"Bcc"="",

"Category"="none,social,promotions,updates,forums,blue,green

,orange,purple,red,yellow",

"Cc"="",

"Contents"="archive,attachment,audio,document,email,excel,i

mage,pdf,powerpoint,presentation,spreadsheet,video,word",

"DisplayDate"="",

"Flags"="calendar,chat,contact,deleted,draft,duplicate,encrypte

d,forwarded,important,journal,journaled,list,news,note,notificati

on,notify,offline,partial,read,received,redirected,replied,sent,spa

m,starred,task,unpurged,unread,unsent",

"MD5"="",

"MessageId"="",

"Received"="",

"Sender"="",

"Sent"="",

"Subject"="",

"To"="",

"UID"=

}

flt_ItemMime Contains the current email in MIME format.
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Variable name

flt_ScriptError Use this variable if an error occurred while processing the

data in your script. If this variable is empty after the script

has executed, Aid4Mail will assume the email was

successfully processed. Otherwise it will display the error

message.

flt_ScriptStatus Use this variable to report an error and/or to issue a skip

or abort command. Use a comma as a separator between

several values. Assign error to report an error. Add the skip

keyword if the email shouldn’t be processed further (the

equivalent of setting flt_Continue to False). Use abort to

terminate all further processing. The following example will

skip the current email and increment the Skip count:
flt_ScriptStatus = skip

flt_SourceFolder Provides the source folder name of the current email being

processed.

flt_SourceFolderMetadata Contains a list of metadata values in plain JSON format:

{

"DisplayName"="",

"Flag"="All

Mail,Archive,Calendar,Chats,Contacts,Drafts,Important,Inbox,Jo

urnal,News,Notes,Outbox,RSS,Sent,Spam,Starred,Tasks,Trash",

"Folder"="",

"ItemsCount"=,

"RootLocation"="",

"SizeInBytes"=

}

Note that, although filter variables can be modified, this will only affect the filter feature

and will not modify target emails. For example, if one source email contains Peter in the

header then it will be found with the following script:

flt_Continue.Value = "Peter" in flt_ItemHeader.Value

The header can be modified before the filter condition is tested. Here, Peter is changed to

Sally before the filter condition and no emails will be found:

flt_ItemHeader.Value = flt_ItemHeader.Value.replace("Peter", "Sally")
flt_Continue.Value = "Peter" in flt_ItemHeader.Value
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If the condition is then updated so that the script is both changing Peter to Sally, and then

searching for Sally, then the email will be found again:

flt_ItemHeader.Value = flt_ItemHeader.Value.replace("Peter", "Sally")
flt_Continue.Value = "Sally" in flt_ItemHeader.Value

However the saved target email will not have been modified and will have Peter in the

header, not Sally. This is because filter variables only modify the filter. To modify the saved

target email you would need to use a modifier script (that uses modifier variables).
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21.2 Python modifier scripts

Aid4Mail Enterprise and Investigator allow you to extract data, customize file and folder

names, modify email content and even create your own target mail formats using Python

scripts. Python modifier scripts use the .mod.py file extension and are for use in the Python

modifier script field in the Target settings. 

A modifier script is run after a source email has been read and passed through the filter but

before it is saved in its target format. The modifier script allows you to make changes to

the content of the email, its file or folder name, or to extract data from it.

Example 1
# Modifer script that prepends “Aid4Mail\” to the target folder name
mod_TargetFolder.Value = "Aid4Mail\\" + mod_TargetFolder.Value
mod_UpdateVars.Value = "TargetFolder"

Example 2
# Modifer script that replaces the password “abc123” with six 'X' characters
mod_ItemMime.Value = mod_ItemMime.Value.replace("abc123", "XXXXXX")
mod_UpdateVars.Value = "MIME"

Note that the first line in each of the examples above is a comment and so is ignored by

the Python interpreter. Comments start with a hash (#) character and extend to the end of

the line. They are useful to explain what the script does, as in these examples.

Modifier variables

Data in Aid4Mail is made available to your Python scripts through variables. Modifier

variables are prefixed with mod_ and are only for use in modifier scripts.

Aid4Mail's Python variables need to be appended with .Value whenever they're used. This is

a syntax requirement that enables the Python variables to interact with the Delphi

programming language used by Aid4Mail. For example:
mod_TargetFolder.Value = "Aid4Mail\\" + mod_TargetFolder.Value

The following Python modifier variables are available in Aid4Mail. Note that they are case-

sensitive.

Variable name

mod_AppSettings Contains the filename of the settings used to configure

the current session. The file is stored in the standard INI

format.
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Variable name

mod_BatesNumber Access or modify the Bates number.

mod_BatesStamp Access or modify the Bates stamp.

mod_ItemMetadata The data in this variable is in the same format as

flt_ItemMetadata.

mod_ItemMime Contains the current email in MIME format. If you set

mod_UpdateVars equal to “MIME”, any modifications you

make to the contents of this variable will be returned to

Aid4Mail.

mod_ScriptError Use this variable if an error occurred while processing the

data in your script. If this variable is empty after the script

has executed, Aid4Mail will assume the email was

successfully processed. Otherwise it will display the error

message.

mod_ScriptStatus Use this variable to report an error and/or to issue a skip

or abort command. Use a comma as a separator between

several values. Assign “error” to report an error and stop

processing the item. Use “abort” to terminate all further

processing. The following example will increment the

error count and abort email processing:

mod_ScriptStatus = error,abort

mod_SourceFolder Provides the source folder name of the current email

being processed.

mod_SourceFolderMetadata The data in this variable is in the same format as

flt_SourceFolderMetadata.

mod_TargetFile Provides the target filename. It will be empty (and

ignored) for target formats that are not file-based like

MAPI and IMAP.

mod_TargetFolder Provides the target folder name. If you set

mod_UpdateVars to “TargetFolder”, any changes to its

value will be reflected in the target folder used by

Aid4Mail.

mod_UpdateVars Use this variable to tell Aid4Mail whether to update the

data based on the contents of the mod_ItemMime and

mod_TargetFolder variables. Recognized values include
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Variable name

either MIME or TargetFolder, or any combination

(separate with a comma if you use more than one).
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22 Customizing Aid4Mail

Aid4Mail allows you to customize some of its core functionality by making its data files

available for editing, and through its support for Python scripts. These files are stored in the

Data and Scripts folders, respectively.

Data folder

The Data folder contains files that you can edit to customize Aid4Mail's behavior. They

contain information on time zones, file extensions, IMAP server names, MIME fields and

how they are used, etc.

Scripts folder

The Scripts folder contains Python scripts. There are a number of scripts shipped with

Aid4Mail and they are all editable. You can also create your own scripts, or add third-party

ones, by placing them in the Scripts folder. Aid4Mail will automatically find them the next

time you run it.

Folder locations

The Data and Scripts folders are subfolders of the program folder. However, you should not

edit a file, or add a new one, directly in this location because it will be overwritten

whenever you reinstall or update Aid4Mail. Instead, copy the file to the corresponding Data

or Scripts subfolder of your AppData folder and edit it there. This location will not be

affected by reinstallation or software updates. 

Alternatively you can copy the file to the Data or Scripts subfolder of your Public folder.

This makes it available to all users.

If you have installed Aid4Mail on a USB drive, you can instead copy the file to the Data or

Scripts subfolder of your USB program folder. However, that this location may also be

overwritten if you reinstall or update Aid4Mail.

Note that, in each case, you may have to create the Data or Scripts subfolder if it doesn't

exist yet in that location.
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Folder location priority

When Aid4Mail uses a file from the Data or Scripts folders, it checks the aforementioned

locations in the following order:

1. USB program folder

2. AppData folder

3. Public folder

4. Program folder

If a file exists in multiple locations, Aid4Mail will use the first one it finds. This means that

files in the USB program folder are given priority over those in the AppData folder, which

in turn has priority the public folder and finally the program folder. This makes it easy to

revert back to the original version of a file that you've edited: Simply delete it and

Aid4Mail will automatically use the original version in the program folder.
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23 Glossary

Application data (AppData) folder
The folder in which your Aid4Mail application data and settings are stored on your

computer.

The data and settings stored in this folder are those related to the app itself or those made

available to all projects and sessions (data and settings related to specific projects or

sessions are stored in your project folder). For example, the following are stored in the

application data folder (some in subfolders):

· Configuration file containing the Options screen's settings,

· Authentication tokens created by Aid4Mail Authenticator or imported from another

location (stored in the OAuthTokens subfolder),

· IMAP account files set up through the IMAP Configuration Editor (stored in the IMAP

subfolder),

· User-edited data files (stored in the Data subfolder).

· Python scripts you have created or modified (stored in the Scripts subfolder).

Each Aid4Mail user will have their own application data folder, located under their

Windows profile. The specific location depends on your system's configuration and your

Windows username but is usually the following (where <User> represents your Windows

username):

C:\Users\<User>\AppData\Roaming\Aid4Mail5

If you are not able to browse to this location in File Explorer, turn on View > Hidden items.

Application programming interface (API)
A method of communication between two pieces of software. Using a mail service's API to

access data usually offers benefits over using more general protocols like IMAP. For

example, access to additional metadata, native filtering and reduced bandwith limitations.

Email-related APIs used by Aid4Mail include MAPI, Microsoft Graph API and Google APIs.

Archive
A mailbox or file that is no longer connected (or never was) to an email service and cannot

receive or send emails. An archive can be considered to be the opposite of a live email

account.
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Bates numbering
A system of unique identification used for documents in the forensic, legal, business and

medical fields. Although there is no standard for Bates numbering, it usually consists of a

combination of text and sequential numbering, sometimes with the addition of a time

stamp, to create a unique ID for each item. 

Aid4Mail implements Bates numbering by providing a Bates number and a formatted

Bates stamp. For information, please refer to the Bates numbering topic.

Boolean operator
In Aid4Mail, Boolean operators (also known as logical operators) allow you to negate

search terms or combine them to build sophisticated filters. For details, see the Boolean

operators topic.

Character
Any character that is represented in a Unicode or extended ANSI character set.

Circular processing
A potentially problematic situation that can occur when you use the same email account or

mailbox as both source and target. Mail added to the account can be processed again and

again in a never-ending loop. This problem can be mitigated by using a filter to exclude

duplicate emails although it may still produce ambiguous progress information and cause

the progress bar to exceed 100%. A cleaner solution is for target mail to be placed in a

folder that has been excluded from processing by a folder filter. This provides an internal

separation between the source and target mail within the same account or mailbox and

will result in accurate progress information.

Comparison operator
Comparison operators are used to compare one value with another. Aid4Mail uses them in

certain search operators. Please refer to the Comparison operators section for details.

Coordinated Universal Time (UTC)
A 24-hour time standard created in 1884 and used to synchronize all world clocks. UTC is

not a time zone itself but is a standard that all time zones in the world are based upon. It

does not adjust for daylight savings.

Time zones across the world are specified as positive or negative offsets from UTC. For

example:

· GMT (Greenwich Mean Time) is UTC +0:00, 
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· EST (Eastern Standard Time) is UTC -5:00

· EDT (Eastern Daylight Time) is UTC -4:00

· PST (Pacific Standard Time) is UTC -8:00

· SGT (Singapore Time) is UTC +8:00

You can obtain the current time in UTC at the WorldTimeServer.com website.

Data folder
The Data folder contains files that you can edit to customize Aid4Mail's behavior. They

contain information on time zones, file extensions, IMAP server names, MIME fields and

how they are used, etc.

The Data folder can be present in multiple locations. Original data files shipped with

Aid4Mail are in the Data subfolder of your program folder. However these should not be

edited directly as this location is overwritten whenever you reinstall or update Aid4Mail.

Files you edit should be placed in the Data subfolder of your application data folder (or

alternatively your public folder or USB program folder, depending on how you're using

Aid4Mail). Please refer to Customizing Aid4Mail for further information.

Deduplication
Deduplication is the process of eliminating duplicate emails, ensuring there is only one of

each in your target mail. Aid4Mail makes deduplication very easy through a simple search

term, NOT Type:Duplicate. Please refer to the Deduplication topic for more information.

Duplicate email
An email that is identical to another as determined by certain rules, explained in the

Deduplication topic.

Encrypted email
An email whose content has been scrambled so that only those with the key can read it.

There are various protocols for doing this but S/MIME is the most widely supported.

Aid4Mail will consider an email to be encrypted (Type:Encrypted) if its header contains the

field Content-Type: multipart/encrypted.

Folder
A container for emails (or non-email items). A single email can only exist in one folder

although identical copies of it can be placed in other folders, resulting in duplicates. 

https://www.aid4mail.com/redir/utc
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For example, an email in the Sent folder can be moved to the Work folder but then will no

longer exist in the Sent folder. Alternatively, a copy of the email can be placed in the Work

folder resulting in two duplicate emails, one in each folder.

HTML Entity
A symbolic representation of certain individual characters in HTML. 

In HTML, some characters cannot be specified directly because they are reserved for other

purposes. For example, the less than and greater than characters, < and >, form part of an

HTML tag like <p> or <h1> and so cannot be used directly in text. Instead they are

represented by HTML entities, in this case &lt; and &gt; respectively. 

HTML entities are comprised of a series of letters or numbers that start with an ampersand

(&) and finish with a semicolon (;). Other examples are &quot; that represents a double

quotation mark (") and &euro; which is the euro currency symbol (€). You can read more

about HTML entities at the W3Schools website.

In Aid4Mail, you will only encounter HTML entities when filtering raw email text using the

Raw search operator.

Illegal filename characters
Operating systems define certain characters that are illegal to use in folder and filenames.

In Windows these characters are: 

< (less than)

> (greater than)

: (colon)

" (double quote)

/ (forward slash)

\ (backslash)

| (vertical bar or pipe)

? (question mark)

* (asterisk)

Internet Message Access Protocol (IMAP)
An Internet Standard protocol (RFC 3501), supported by most email applications, that

enables direct access to mail on a remote server. IMAP allows multiple apps to access the

same mail account, even from different devices. This feature is the main reason IMAP is

generally preferred over POP, an older protocol that requires mail to be downloaded to

the device.

https://www.aid4mail.com/redir/html-entities
https://www.aid4mail.com/redir/rfc3501
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International date format
An international standard (ISO 8601) of presenting dates numerically that avoids the

ambiguity of country-based representations. It also ensures that alphabetically listed dates

are ordered chronologically. 

Notably, the year is specified first followed by the month and then the day: YYYY-MM-DD

(extended format) or YYMMDD (basic format). Dates can include time values which follow

the same logic of being ordered from the largest to smallest unit: YYYY-MM-DD hh:mm:ss

(extended format) or YYMMDD hhmmss (basic format). Hours hh must always be specified

using the 24-hour clock.

Dates in Aid4Mail use the following subset of the international date standard's extended

format:

YYYY
YYYY-MM
YYYY-MM-DD
YYYY-MM-DD hh
YYYY-MM-DD hh:mm
YYYY-MM-DD hh:mm:ss

Journaling
The process of retaining information related to electronic messages including emails,

instant messages, text messages, faxes, audio messages, etc.

A journaled email typically includes the actual email message along with related metadata.

This consists of time/date information, sender, receiver(s) and transport information, and

can also include data relating to the computer involved and its physical location.

Aid4Mail will consider an email to be Type:Journaled if its header contains either of the

following:

· X-MS-Journal-Report

· Content-Identifier: ExJournalReport

Aid4Mail will consider an email to be Type:Journal if it's from the Journal folder in a PST

file, Exchange or any Outlook message store.

Label
A descriptive tag assigned to an email in a system that organizes mail using labels instead

of folders.

https://www.aid4mail.com/redir/iso8601
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Traditionally, mail is organized in folders. A single email can only exist in one folder

although identical copies of it can be placed in other folders, resulting in duplicates. 

Gmail, and other service providers, organize mail using labels instead. With this system, the

mail resides in a central location and individual emails can be assigned one or more labels.

The advantage of this approach is that there is only one copy of each email, even if it has

multiple labels. This also facilitates searching as emails with multiple labels can easily be

targeted. 

Note that most mail clients organize by folders. This means that, when the mail client

downloads from Gmail, emails with multiple labels are duplicated to multiple folders. For

example, an email labelled Sent and Work will be duplicated and placed in both the Sent

folder and the Work folder after downloading.

Live email account
An email account (or mailbox connected to an email account) that is in active use to

receive or send emails. A live email account can be considered to be the opposite of an

archive.

MAPI
An API for accessing Microsoft Outlook and Exchange. Aid4Mail uses MAPI to read and

write to Outlook profiles, and PST/MSG files when the Process using Outlook option is

turned on.

New line
Any character that represents a new line. This includes Line Feed (LF), Vertical Tab (VT),

Form Feed (FF), Carriage Return (CR), Next Line (NEL), Line Separator (LS), Paragraph

Separator (PS), etc.

OAuth 2.0
OAuth 2.0 is a secure protocol that enables internet users to grant limited temporary access

to their data, to third-party websites or applications, without giving up their username or

password. It uses an authentication token, requested from the service hosting the user's

data by the third-party application. The token is only created once the user has logged in

to their account and granted permission, and it can be invalidated by the user at any time.

The file does not contain the user's credentials but, instead, contains unique access codes

that are only valid for that account and specific application. This method of access and

authentication provides users with the maximum security and privacy.

For more information, see the OAuth 2.0 Authorization Framework specification.

https://www.aid4mail.com/redir/oauth2
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Offline email
An email whose environment has been disconnected from the internet. Many email clients

and services allow you to work offline. However Aid4Mail only considers an email to be

offline (Type:Offline) if its header contains an Outlook offline flag.

Paragraph
A sequence of one or more words or sentences followed by one or more new lines.

Partial email
An email containing only a part of the full message. Aid4Mail considers an email to be

partial (Type:Partial) if its header contains the field Content-Type: message/partial.

Personal email
Aid4Mail classifies an email as personal if it meets all three of the following conditions:

1. It is sent from an individual person,

2. It shows no evidence of being part of a campaign, message list or mailing list,

3. It shows no evidence of being a bulk email, advertisement, notification or journaled

email.

Aid4Mail Enterprise and Investigator allow you to include or exclude personal mail using

the Type:Personal operator. For further details, see Searching personal mail.

Program folder
The folder in which Aid4Mail is installed on your computer. It's location depends on your

system's configuration but is typically:

C:\Program Files (x86)\Aid4Mail5

or

C:\Program Files (x86)\Fookes Software\Aid4Mail5

Project
An Aid4Mail project contains one or more sessions that are usually related in some way

(although this is not a requirement). For example a Forensic examiner may have a different

project for every individual under investigation. Each project may contain multiple sessions,

one for each of the individual's various mail sources (as in Example 1 in the Multiple

sessions topic). An IT technician may have a different project for each department in the

company, with each project containing a session for every employee whose mail is to be

migrated (as in Example 2 in the Multiple sessions topic).
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Project folder
The folder on disk where the project is stored. 

The Location field on the Project settings screen displays the full path of the project folder.

It is also a hyperlink so, when selected, will open the project folder location in the Windows

File Explorer app. 

You can set the default project folder location for all future projects on the Options screen,

under the Projects section.

Proximity search
A proximity search finds words or characters that are located close to one another.

Proximity searches can be very powerful, using context to enable precise searching and

filtering.

Most proximity search engines are limited to finding words within a specified distance of

one another, where distance is the number of intermediate words. Aid4Mail can do this too

but goes further, beyond traditional proximity searching. It enables you to search within the

grammatical structures that naturally exist in most text—sentences and paragraphs—

regardless of the number of intermediary words.

For more details, please refer to the Proximity searching topic.

Public folder
The folder in which Aid4Mail settings or data can be publicly shared with other people on

same computer or network. It's location depends on your system's configuration but is

typically:

C:\Users\Public\Aid4Mail5

This folder does not exist by default so, if necessary, you need to create it under C:

\Users\Public. Most content from the application data folder can be placed in the this

folder to make it publicly accessible, as long as you maintain the same folder structure.

Punctuation
In Aid4Mail's search and filter feature, quotes, parentheses, brackets and braces have

special meaning. See the Punctuation topic for details.

Python
An interpreted, high-level programming language and the language of choice for many

forensic professionals. This is partly due to its use as a scripting language, embedded in
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software products like Aid4Mail, to enable user-created functionality beyond what's built

in.

For more information about Python, please refer to the Python website. For help using

Python in Aid4Mail, please refer to the Python scripts topic.

Python script
Script written in the Python programming language to add new features to Aid4Mail

Enterprise and Investigator. Scripts can add specialized filtering, data extraction, the

modification of email content and the customization of file and folder names. You can

even use Python scripts to create your own target mail formats and custom output. Please

refer to the Python scripts topic for details.

Regular expression
Also known as regex. An extremely powerful search pattern (with a cryptic syntax) that

enables searches that would not otherwise be possible. Aid4Mail’s supports Perl

Compatible Regular Expressions (PCRE) as search terms. Please refer to the Regular

expressions topic for details.

Scripts folder
The Scripts folder contains Python scripts. There are a number of scripts shipped with

Aid4Mail and they are all editable. You can also create your own scripts, or add third-party

ones, by placing them in the Scripts folder. Aid4Mail will automatically find them the next

time you run it.

The Scripts folder can be present in multiple locations. Original scripts shipped with

Aid4Mail are in the Scripts subfolder of your program folder. However these should not be

edited directly as this location is overwritten whenever you reinstall or update Aid4Mail.

Scripts you edit, new scripts you create, or any third-party scripts you want to add should

be placed in the Scripts subfolder of your application data folder (or alternatively your

public folder or USB program folder, depending on how you're using Aid4Mail). Please

refer to Customizing Aid4Mail for further information.

Sentence
A sequence of one or more words ending with a period (full stop) or tab.

https://www.aid4mail.com/redir/python
https://www.aid4mail.com/redir/pcre
https://www.aid4mail.com/redir/pcre
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Session
A session can be thought of as an independent instance of the Aid4Mail processing engine.

Aid4Mail allows you to work with one session at a time or with multiple sessions, enabling

you to set up a whole project of related email processing tasks.

All Aid4Mail editions allow you to set up multiple sessions and to run, pause and stop the

currently selected session. Whereas Aid4Mail Converter can only run one session at a time,

Aid4Mail Enterprise and Investigator can run all the sessions in the list, either consecutively

or concurrently. Any sessions not yet running will be placed in a queue and automatically

run when it's their turn. Please refer to the Multiple sessions topic for further information.

Session settings file
When you run an Aid4Mail session, or close the application, the session's settings are saved

to a file in the project folder. Every session setting in Aid4Mail has a corresponding entry in

the session settings file (although unused settings may not be listed). For further details,

please refer to the Session settings file topic.

Search operator
Search operators allow you to narrow down a search by specifying exactly which items

should be included in the target mailbox. Aid4Mail supports most Gmail, Google Vault and

Microsoft Office search operators and many more. Please refer to the Search operators

topic for details.

Search term
A word or phrase to be searched for in folders, email messages and non-email items

(contacts, calendars, etc). Search terms can be refined by punctuation, wildcards and

regular expressions, and targeted with search operators. They can also be combined using

Boolean operators. 

Aid4Mail filters consist of one or more search terms. During processing, items that match

your search terms will be included in your target mail. Those that don’t will be excluded.

Please refer to the Search terms topic for more information.

Source mail
The mail that Aid4Mail will be processing or converting. Conversions are from your source

mail to your target mail.
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Target mail
The mail that Aid4Mail will be creating. Conversions are from your source mail to your

target mail.

Template
Templates are an optional feature in Aid4Mail that can be used in different 3 ways:

1. To specify the folder structure of your target mail. This is useful for merging or splitting

folders, or for grouping emails based on  specific characteristics like the email account,

date or status . 

2. To customize filenames when your chosen target mail format uses individual files for

each email message (MSG, EML, Plain text, HTML, PDF or XML).

3. To define the content of the HTML index file created when your target mail is HTML and

the Create HTML index file option is turned on.

For further information, please refer to the Templates topic.

Template token
A placeholder for variable content that's used in Aid4Mail templates. A token can represent

properties of:

· The email being processed.

· The session processing the email.

· The project processing the email. 

Please refer to the Template tokens topic for details.

Trial mode
A special mode that allows you to test Aid4Mail before you purchase. It is fully featured

but modifies target mail during the conversion process, notably adding watermarks. It does

not affect your source mail in any way. For details see the Trial mode topic.

Unpurged mail
Hidden copies of emails that have been deleted or moved to another location. An

unpurged email contains a DELETED flag in its header. For a more detailed explanation, see

What is unpurged mail? in the Searching unpurged mail topic.
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USB program folder
The folder in which Aid4Mail is installed if you're running it from a USB drive. It's location

depends on your system's configuration but is typically:

U:\Aid4Mail5\

U: represents the root folder of the USB drive.

Wildcard
A special token that stands in for one or more characters, HTML entities or whole words.

Some wildcards operate within a single word while others span a sentence or paragraph.

There's even a wildcard that offers proximity searching by standing in for a given number

of words across the whole text. Please refer to the Wildcards topic for details.

Word
A sequence of characters and/or HTML entities followed by one or more spaces.
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24 Known issues

This page lists issues related to Aid4Mail that we are already aware of. Most are caused by

third-party products or services that interact with Aid4Mail, and not by Aid4Mail itself.

However, as they affect our customers, we are dedicated to finding solutions or

workarounds wherever possible. In the meantime they are listed here for your information. 

Anti-virus warnings (false positives)

Anti-virus products, and especially those using proactive protection, occasionally generate

false positives. This happens when they incorrectly determine that a file contains a virus, or

other malware, when there is none at all. We have received reports of this happening to

Aid4Mail's installation file. This is not an issue with Aid4Mail but with the anti-virus product

that's generating the false positive. 

All our products are uploaded to the Internet virus-free. Aid4Mail was scanned by over 60

different anti-virus products. With the exception of one or two obscure apps that

sometimes show false positives, all the major anti-virus products show Aid4Mail to be

100% clean. If you have downloaded Aid4Mail from our website or online store, or a

reputable software repository, then you can be confident that it does not contain a virus.

Unless you have a virus on your computer that affects Aid4Mail after installation, any

warning you may get from your anti-virus product is most likely a false positive.

This is a frustrating situation for us because, other than contacting the manufacturer of the

offending anti-virus product, there is little we can do to rectify it. However you may be able

to help as these companies are more likely to listen to their own customers. If you

encounter a false positive concerning Aid4Mail, please inform the manufacturer so they can

fix the issue in their next update. In the meantime, you should be able to white-list

Aid4Mail in your anti-virus product, or turn off proactive protection, to prevent any further

false positives.

Outlook installation

Microsoft Outlook can be installed on your computer in several different ways. The

following two installation types can prevent Aid4Mail from converting between Outlook

formats (Outlook profiles, PST and MSG files) and MIME formats (EML and mbox):

1. Outlook installed as part of the Microsoft Office Desktop Apps package.

The recommended solution in this case is to uninstall Office 365 and reinstall the regular

edition from your Office 365 account on Microsoft’s website. In an upcoming Aid4Mail
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update we plan to provide a workaround that will enable mail conversion when this

type of installation is encountered. However, these conversions may not be as accurate

as those handled by Outlook’s internal converter.

2. Outlook installed as a Microsoft Office Click-to-Run app and the Windows Registry has

not been updated to support IConverterSession.

If you have this type of setup and are unable to convert Outlook mail, please use the Fix

Registry for MAPI command under Aid4Mail's Tools menu.

Accessing cloud-based Microsoft accounts through IMAP with

OAuth 2.0

Aid4Mail supports IMAP access to cloud-based email accounts using several different

security protocols. The most secure is OAuth 2.0. Unfortunately, Microsoft has not yet

implemented OAuth 2.0 support for IMAP access to Office 365 accounts. Attempts to

access Office 365 in this way will result in an error. However, Aid4Mail can still access Office

365 accounts through IMAP using one of the other connection security protocols.

OAuth 2.0 IMAP access is supported by Outlook.com and Hotmail.com accounts although

our tests indicate it may not be reliable. This has been confirmed by third-party reports on

public forums. 

Aid4Mail remains ready for OAuth 2.0 IMAP access to all these accounts once Microsoft has

resolved their issues.

Microsoft Graph API limitations

Aid4Mail offers direct access to Office 365 accounts using the Microsoft Graph API along

with the secure OAuth 2.0 protocol. This is the most efficient way of accessing these

accounts. The Microsoft Graph API is recommended by Microsoft and is a replacement for

their older Exchange Web Services (EWS). Unfortunately, the Microsoft Graph API is

currently limited to downloading messages. It cannot upload them. For this reason, Office

365 is only available directly as a source format and not as a target format in Aid4Mail.

However, you can still convert to Office 365 using either IMAP or an Outlook profile as your

target format.
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25 Technical support

If you have a question that is not answered in this guide, please consult our online

knowledge base for a solution.

If you can't find an answer in the knowledge base, or have pre-sales questions, we're here

to help. You can contact our support team by submitting a support ticket.

Submitting a support ticket

Aid4Mail’s technical support uses an email ticketing system. When contacting technical

support, please provide all the information below as this will improve our ability to

diagnose and address your issue:

· Version / build of Aid4Mail being used (found in the main menu under Help > About

Aid4Mail).

· Version of Windows (or other operating system) being used.

· Aid4Mail activation code / license key.

· Progress log for the Aid4Mail session that encountered the issue. You’ll find the location

of this file on the Progress log screen.

· Error log (if one was created) for the Aid4Mail session that encountered the issue. You’ll

find the location of this file on the Error log screen. The error log is only created if errors

were produced.

Once you have this information, please submit a support ticket.

Business hours

We provide customer support on business days from Monday to Friday. We usually reply

within 24 hours (priority support) but it may take up to 2 business days for users of

Aid4Mail Converter.

If you don’t hear back from us, please check if our reply got caught by your spam

protection tool, or was automatically moved to your Junk folder.

https://www.aid4mail.com/redir/support
https://www.aid4mail.com/redir/support
https://www.aid4mail.com/redir/new-ticket
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26 Company information

Fookes Software has been developing software since 1990. In 1996 the company was

formally registered at the Trade Register in Geneva, Switzerland. Now a Limited (Ltd)

company based in Charmey, in the Swiss Prealps, it is fully owned by its parent Fookes

Holding Ltd.

For almost 30 years Fookes Software has been developing award-winning tools and

productivity software. Clients include government and law enforcement agencies, Fortune

500 corporations, top universities and other educational institutions, international

organizations, as well as individuals and home users in over 100 countries around the

world.

Fookes Software respects each individual’s right to personal privacy. We collect

information through our website, including registration forms and inquiry forms, and use it

only in the ways disclosed in our privacy policy.

Policies

1. We are perfectionists and strive to develop reliable and efficient software solutions.

2. We listen to our users and try to implement feature suggestions that benefit them.

3. We are committed to providing excellent customer support.

4. We are upfront about our services and products (no “small print”) so that you can make

an informed buying decision.

Websites

www.aid4mail.com

www.fookes.com

Address

Fookes Software Ltd

La Petite Fin 27

1637 Charmey (en Gruyère)

Switzerland

https://www.aid4mail.com/privacy-policy
https://www.aid4mail.com/redir/aid4mail-v5
https://www.fookes.com/
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Email: helpdesk@fookes.net

If you have a technical support question, please refer to the Technical support topic.

Business Details

Fookes Software Ltd is registered in Switzerland and owned by its parent company Fookes

Holding Ltd:

· Reference Number: 2420/2008

· Federal Number: CH-217-3540396-6

Trade Register details:

Service du registre du commerce du Canton de Fribourg, Switzerland

Website: www.fr.ch/rc/

IRS Employer Identification Number (EIN): 98-0604274

mailto:helpdesk@fookes.net
https://www.aid4mail.com/redir/extrait-registre
https://www.aid4mail.com/redir/registre-commerce
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27 EULA

You can download the latest version of the End User License Agreement (EULA) from the

Aid4Mail website. A local PDF copy is also available in your Aid4Mail program folder.

https://www.aid4mail.com/redir/eula
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